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ACAUTION US Federal law restricts this device to sale by or on the order of a
physician.

ACAUTION Use the QRS-Card™ system under the direction of a physician. All users
should read and thoroughly understand the manual before use.[B1]

Pulse Biomedical, Inc. assumes no responsibility for any injury to anyone, or for any
illegal or improper use of the product, that may result from failure to use this product in
accordance with the instructions, cautions, warnings, or statement of intended use
published in this manual.

QRS-Card™ Cardiology Suite™, QRS-Card™ and QRS-Blue™™ are trademarks of
Pulse Biomedical, Inc..

Software is Copyright 2007, Pulse Biomedical, Inc. All rights are reserved. The software
is protected by United States of America copyright laws and international treaty
provisions applicable worldwide. Under such laws, the licensee is entitled to use the copy
of the software provided on the original distribution medium. The software may not be
copied, decompiled, reverse-engineered, disassembled or otherwise reduced to human-
perceivable form.

This is not a sale of the software or any copy of the software; all right, title and
ownership of the software remains with Pulse Biomedical, Inc.

For information about any Pulse Biomedical, Inc. product, call your nearest PBI office:
USA +1 610 666-5510
Europe + 49 7434 31603

[ix]
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1. Safety

Chapter Contents:

1. Safety Conventions
2. User Responsibility
3. Warnings and Cautions

This chapter contains important safety and use information. Users should read and thoroughly
understand all notes, warnings and cautions before

[9]
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1.1 Safety Conventions
The symbols shown below identify potential hazard categories:

Warning statements describe conditions or actions that can result in personal injury or loss of life.

ACAUTION

Caution statements describe conditions or actions that can result in damage to product or property.

NOTICE

Notices contain additional information about usage.

[10]
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1.2 User Responsibility

ACAUTION Ty intended use of this system is for Patients undergoing ECG Testing, and/or
ECG Stress, Blood Pressure, and Breathing analysis. The intended locations for use are in a
physician’s office, hospital, exercise rehabilitation facilities, or similar areas. The intended user is
a trained medical professional and should have basic PC operational skills.

This product is designed to perform in conformity with the description thereof contained in this manual
and accompanying labels and inserts, when assembled, operated, maintained and repaired in accordance
with the instructions provided. A defective product should not be used.

Parts that are broken, plainly worn, missing or incomplete, distorted or contaminated should be replaced
immediately. Should any repair or replacement become necessary, we recommend that service be
performed at the nearest approved service center. The user of the product shall have the sole
responsibility for any malfunction, which results from improper use, faulty maintenance, improper
repair, damage or alteration by anyone other than Pulse Biomedical, Inc. or their authorized service
personnel.

Use of accessories other than those purchased from Pulse Biomedical or an authorized dealer or
distributor may compromise product performance and void Pulse Biomedical warranty.

[11]
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1.3 Warnings and Cautions

ACAUTION

1.
2.

UL Listed PC computers must be used for noise-free recording of ECG‘s.[u2](kB3]

To acquire good quality ECGs, only use AAMI EC-12 approved electrodes. Please check the
expiration date of disposable electrodes. Do not use if past their expiration or if you cannot
read the expiration.[u4]

To clean the QRS-Card™ first fully disconnect from computer. Use warm soap and water
and surface disinfectant only. Do not immerse the QRS-Card™ in the cleaning solution as
permanent damage to the QRS-Card™ may occur. [u5]

The QRS-Card™ devices are an integral part of a personal computer based diagnostic system. The user
shall adhere to all warnings in order to ensure safe and reliable performance of the system.

1.

Only qualified service personnel should perform any service. Never use extension AC power
cords with the PC computer, chassis leakage current may increase.[u6]

Routinely inspect cables/leads assemblies for cracks, holes, tears, cuts, etc. that could present
problems to the system. [u7]

In case of ECG leadwire or cable replacement, use ONLY Pulse Biomedical lead wires and
cables.[u8] Use of cables other than those specified or sold by Pulse Biomedical may result
in increased emissions or decreased immunity of the QRS-Card™ Cardiology Suite
system.[B9]

If using a Treadmill with QRS-Card™, use only FDA cleared treadmills.[u10]

5. If software CD becomes unusable, software can be downloaded from PBI web site

(www.qgrscard.com).[ul1]

For Bluetooth Device: Batteries should not be kept beyond the manufacturer’s published
shelf life.[ul12]

Use only devices sold by or recommended by PBI.[u13]. Contact PBI for further assistance,
included sanctioned devices to interface with PBI system

For proper electrode placement, please see the diagram on the QRS-Card™ Device label or
in the QRS-Card™ Cardiology Suite software.[ul4]

Do not connect the patient cable to anything other than the QRS-Card™ Device. Be sure you
know how to properly connect the patient cable to the QRS-Card™.[u15]

10. PBI products should only be maintained and serviced by PBI factory personnel.[ul6]

[12]
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1.

12.
13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.
25.
26.

27.

The personal computer (non-medical electrical equipment) shall be situated outside the
patient environment (reference IEC 60601-1-1). Ensure that the computer and printer are
more than 6 feet away from the QRS-Card™ device and 6 feet away from the patient.[ul7]
Do not place a telephone near the device.

Personal Computers and peripherals are required to meet IEC 60950[ul8]

PACEMAKER PATIENTS: The QRS-Card™ Cardiology Suite hardware and software does
not provide or detect pacemaker pulses. Do not rely on the QRS-Card™ Cardiology Suite
output or the heart rate meter for Pacemaker patients during cardiac arrest. Pacemaker
patients must be closely observed.[u19]

MODEM USAGE DURING ELECTRICAL STORMS: For patient's safety during Electrical
Storms, the telephone line to the modem and the patient ECG cable should NOT be hooked
up at the same time.[u20]

QRS-Card™ ECG device must be at least 6 feet away from the computer.

LOW BATTERY: If the QRS-Card™ Cardiology Suite System is used with a battery
operated computer, the low battery indicator warning of the computer must be checked
before using the system on any patients.

PROPER ELECTRICAL GROUND: Proper electrical grounding to the AC lines is an
absolute necessity for acquiring noise-free ECG recordings.

PATIENT DATA BACKUP: It is important for users to backup their patient ECG data
regularly. In the case of accidental hard disk data loss, backup data can be restored to the
hard disk.

SCREEN SAVERs that blank the computer screen must not be used while the QRS- Card™
Cardiology Suite ECG system software is running.

Use the QRS-Card™ software as stand-alone software. Do not run other software
applications while running the QRS-Card™ software.

Do not use this device in areas where flammable, explosive, or anesthetic agents are used.
The device is not intended for use during anesthesia.

Electromagnetic Compatibility- When using the QRS-Card™, electromagnetic compatibility
with surrounding devices should be considered and evaluated. The QRS-Card™ complies
with IEC 60601-1-2 limits for EMC.

Due to the shock hazard that can exist within the PC when the cover is removed, only
qualified service personnel should perform service. Never use extension AC power cords
with the PC computer, chassis leakage current may increase.

Erratic and/or non-rhythmic heartbeats, or artifacts can result in inaccurate ECG readings.
ECG lead changes during measurements can cause artifacts that can result in inaccurate
readings.

Changing patient positions (e.g. supine, sitting, etc.) during measurements can cause artifacts
that can give inaccurate readings.

Choose an ECG lead other than V5 for patients experiencing cardiac occlusion.

[13]
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28.

29.
30.
31.

32.
33.
34.

35.

Use during fibrillation or with cardioplegic agents will result in artifacts that can result in
inaccurate readings.

For better measuring results, select the optimum signal/lead for monitoring.

Avoid nearby electrical noise sources, if possible.

If questionable readings are obtained, re-check the patient's cardiac rhythms by an alternate
means before administering any medication.

Secure the PC Monitor with the computer on the cart (if used) so that it does not tip over.
Consult the PC Monitor book for proper connection between the computer and the monitor.
Operation of the computer under low mains voltage conditions is established by the user's
computer choice. Use only UL listed computers to avoid this potential problem.

If the QRS-Card™ fails, please refer to the troubleshooting section in the user manual.

Medical Device Directive
The PBI QRS-Card™ complies with the requirements of the Medical Device Directive 93/42/EEC and
carries the CE 0366 mark accordingly.

[14]
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1.4 Symbols and Markings

B

= Consult accompanying documents

B>

.= Caution, Consult accompanying documents.

e
-

= Defibrillation proof type CF applied part

SN

= Serial Number of QRS-Blue™

= Manufacturers address and date of manufacture.

EC REP

= Name and address of European Representative

/Y = Temperature Limitation
’ ¥

Ly

j = Keep Dry

[15]
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2. Introduction & Welcome

Welcome to the Pulse Biomedical QRS-Card™ Cardiology Suite. QRS-Card™
Cardiology Suite serves as a complete cardiology diagnostic workstation. When
interfaced to a Windows® compatible personal computer or mobile phone, users can
manage resting ECG, stress ECG, Holter ECG and ABPM data in one easy to use system.
Physicians can perform tests on patients using a standard desktop computer,
laptop/notebook computer, tablet PC or a mobile phone. Results of the tests can be
viewed on the computer screen, edited and printed at any time. The results of the tests
can be saved on the computer hard disk for future referencing or report generating.

This guide walks users through QRS-Card™ Cardiology Suite software, for more
information on device hardware, please refer to the particular hardware manual.

For stress/exercise ECG testing the QRS-Card™ Cardiology Suite interfaces with
treadmills and ergometers. Input of blood pressure can be performed automatically
(screen prompts or direct interface to BP device) at predefined intervals.

QRS-Card™ Cardiology Suite can also be interfaced with EMR software, please contact
PBI for more information.

We thank you for purchasing QRS-Card™ Cardiology Suite and trust that our product
will help you more efficiently manage your cardiology data.

We value your thoughts, comments and questions. Please contact Pulse Biomedical Inc
to provide feedback:

Pulse Biomedical, Inc.
Phone: (610) 666-5510
www.QRSCard.com

Email: Info@QRSCard.com

QRS-Card™ Cardiology Suite can provide automatic computer
interpretations. A computer generated interpretation cannot replace sound medical
reasoning by a trained professional. Therefore, a physician should always review the
interpretation and final analysis should always be obtained by a Physician.

Proper administration, diagnosis and implementation of the test is the Physician’s
responsibility.

Computer Skills
This manual assumes that the users have necessary computer skills and are capable of
using Microsoft Windows based applications.

[16]
CS406-10 Rev F Pub: 2013-07-16



QRS-Card™

A PBI 4.06 Cardiology Suite Operating Instructions

3.

Installing QRS-Card™ Cardiology Suite

Software

3.1 Hardware and Software Requirements

PBI QRS-Card™ Cardiology Suite is a Windows-based software system requiring a
minimum of 80 GB of disk space.

In order to install and successfully use QRS-Card™ Cardiology Suite, your computer
must meet the following minimum requirements:

1.

2.
3.

4.

Windows based PC with Windows 7 and Windows 8 with a minimum of 4GB
RAM.

Windows-compatible keyboard, mouse, USB Port and CD-Rom Drive.
Color/TFT monitor with a minimum resolution of 1024 x 768.

(Optimal resolution: 1920 x 1200)

Color or Black and White Printer (optional)

DI Your QRS-Card™ Hardware products may have additional

requirements. Please refer to the applicable hardware guide for
information.

DI QRS-Card™ Cardiology Suite software uses your computer date

information to calculate the age of patients which may be vital to some
diagnostic statements. Therefore, it is important that your computer’s date
is accurate. Contact your system administrator for help with this function.

[17]
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3.2 Software Installation

All PBI QRS-Card™ Cardiology Systems come with a software installation CD (you can
also download a full software version from our web site www.QRSCard.com). Before
installing QRS-Card™ Cardiology Suite on your computer, it is important that you
understand and follow the instructions below:

3.2.1 Upgrading Softwares2i

If you are upgrading to QRS-Card™ Cardiology Suite 4.06 it is highly recommended that
you backup your data before beginning the upgrade. If you are upgrading from any
version earlier than 4.0, please contact Pulse Biomedical technical support for assistance.

Upgrading from versions 4.0 or higher will not delete patient records or reports.[B22]

To upgrade QRS-Card™ Cardiology Suite follow the instructions below (Note: these
instructions are using Windows 7™ operating system, for help with other operating
systems, contact PBI):

1. Uninstall the earlier QRS-Card™ Cardiology Suite.

- Open your Start Menu and select “Control Panel”

[18]
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Google Talk

Microsoft Word 2010
Calculator

Windows Live Messenger
Microsoft Excel 2010

EPSOM Scan

Snipping Tool
Big Calculator
Microsoft Office Word 2003

@

w

m

%

@ Microsoft Publisher 2010
%

»

All Programs

Windows 7

Documents

Pictures

Music

Games

Computer

Control Panel
Devices and Printers

Default Programs

Help and Support

| |Search programs and files

P

- Select “Add or Remove Programs.”

B Control Panel

Ele  Edb  Vew Favortes Tools  Help

Qo - @ - F| P [Ryroces | [F 3y X ) |-

A EEX
i

Adress | Cantrol Panel

Name =
&, Accesshilicy Options

2 Automatic Updates

@ Bluetooth Devices

P Date and Time

. Display

(Folder Options

[E9Fonts

#Game Controllers
[HirteiiR) Extreme Graphics 2
€ 1rkernet Options

| £f1ava

keyboard

DBua

" )Mouse

& Metwiork Connections

2 Metwork Setup Wizard

[ Phone and Modem Options
FyPower Options
©4Printers and Faxes

@) QuickTime

@ Regional and Language Options
S5 5canners and Cameras
[5cheduled Tasks

) ety Cornter

e
]

&3

- Scroll down to “QRS Card Cardiology Suite,” highlight it, and click
“Remove.” When it asks if you are sure, select “Yes.”
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® Add or Remove Programs

=
Currently installed programs: [] show updates Sork by:

Change or -
Remove CrderReminder HP Laser Jet 1020

Programs

Sie  0.50MB
|5/ pct softvaz Madem Size  D.5EMB

% | 23 pdfsam Sizg  L4.15ME
"y 1

| §8 PL-2303 UsE-to-Serial

Add New Size 2.40MB
Programs | 223 powerDvD Sipe  14.42MB
f : Presta! BizCard 5 SE (English Yersion) Size 2.50MB
| v Presto! PageManager 7.16 i #
e | geManag Ste  195.00ME
windaws (59 PrimoPDF -- by Mitro POF Software Siee  11.11MB
Companents
Z,EZl QB Connection Diagnostic Tool Size 1.96MB
@' ;:» QRS Card for Windows
ERRSUSMONN . ORS-Card Cardiology Suite
Access and
Defaults

10

kL 0

623.00MB

@ QuickBooks Pro 2007
|4 QuickBooks Fro 2010

Size

Sizg 87L.OOME —
(23 cwickBooks Product Listing Service

| @ cuickTime

Size  17.39MB

Size  77.55MB ¥

- Once uninstallation is complete, installing QRS-Card™ Cardiology Suite 4.06
software can start as normal
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3.2.2 Installing New Softwares23]

NOTICE If you are upgrading from a previous version of QRS-Card™ Cardiology

Suite, please see “Upgrading Software” instructions above.

For installation instructions, please see installation guide sent with your QRS-Card™
System, located on the QRS-Card™ Cardiology Suite CD-ROM or at Pulse Biomedical
Website (www.grscard.com)
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4. QRS-Blue™ Hardware Usage

The QRS-Card Blue hardware can be used as either a USB device or a Bluetooth wireless
device.

_ No modification of this equipment is allowed

4.1 USB Usage

If the QRS-Blue™ is used as a USB device, the device is powered through the computer
(you do not need batteries). Once your QRS-Blue™ is connected and drivers are
installed properly, the status indicator light (next to the on/off button) will display a
continuous orange light showing that the QRS-Blue™ is successfully powered.

4.2 Bluetooth Wireless Usage

If the QRS-Blue™ is used as a Bluetooth device, the device is powered through 2 AA
1.5V LR6 batteries. Minimum continuous operating time is 20 hours. To power on and
off the device, press the power button for approximately 3 seconds. Once your QRS-
Blue™ is powered on, the status indicator light (next to the on/off button) will display a
flashing green light showing that the QRS-Blue™ is successfully powered. This green
flashing light also indicates how much battery life is left. Please change batteries as
necessary for consistent operation.

Battery Life LED Light

Good Battery (Voltage above 2.7V) Flashes 4 time consistently

OK Battery (Voltage above 2.5 V) Flashes 3 times, pauses for 2 second
Low Battery (Voltage above 2.2V) Flashes 2 times, pauses for 4 seconds
Bad Battery Flashes 1 time, pauses for 6 seconds

To power off QRS-Blue™, press and hold the power button for a few seconds. The status
indicator light will flash rapidly and then power off. If the device is left unused for 20
minutes, it will automatically power off to conserve battery.

ACAUTION If you plan on storing your QRS-Blue™ for an extended period of time,
remove batteries. Leaving battery in QRS-Blue™ could cause the battery to leak.

4.3 Maintenance and Cleaning of QRS-Blue™

To clean the QRS-Card™ first fully disconnect from computer. Use warm soap and
water and surface disinfectant only. Do not immerse the QRS-Card™ in the cleaning
solution as permanent damage to the QRS-Card™ may occur. [u25]
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N
Chy state|  Zp
(
k Telephone
0:05 FILILE [121¢ ~| |5 mmm¥ +| |25 mm
;es; I;00 ar -
h A
L ﬂ( } Ft' AL ookl o
aye | Y .S
AE _,J s VSN
3 fy°d —.—«-J!,./;.,_._J}_
/ Ok l Cancel |

B 20130715 ()

PID: DEMO

¥ 453PM : DEMO : Patient, 00004 i
LA &14PM : DEMO : Patient, 00003 ‘Sex: HA
2013-07-13 (1) Referred By:
hedication:
DA Database Tool Bar

7 2013-06-19 (1)
2013-06-18 (1)
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Status & Warning Messages
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I

PID: 1CC3-0; 108

QRS Card Cardiolagy Svite £.06 /%‘ﬂ 06) (SN 071 {Registered 31000}

Title bar

QRS-Card™ Cardiology Suite.

The title bar displays the name of the program and contains three buttons
on the far right that can be used to minimize, maximize and close the

Menu bar
Cardiology Suite.

The menu bar contains additional functionality for the QRS-Card™
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Tool bar The tool bar contains buttons that give you easy access to the most
common tasks in QRS-Card™ Cardiology Suite, such as testing modules.

Test Tool The Test Tool Bar contains buttons that allow you to work easier with

Bar saved tests. You can open, print, mail or compare ECG’s and add or
delete tests.

Patients’ The Patients’” Test Database contains records for all of the tests

Test performed. In this area you can find a patient, see which tests were

Database recorded for that patient and see the kind of tests that were recorded. The
test database is sorted according to the criteria selected on the Patient
Database Toolbar (Name, ID, Date, Test)

Database You can sort the patient database by patient name, id, test date or type of

Toolbar

test. The Quick Search Area allows you to quickly search for a test by
typing a couple letters or numbers you are looking for within the selected
search criteria. [KB28]

Test Preview

The Test Preview displays a brief overview of the file selected.

Status &
Warning
Messages

The Status message contains information about what version of QRS-
Card™ Cardiology Suite you are running along with licensing
information such as serial number and PID of your software license.
Warning messages seeking user attention also appear here.

CS406-10 Rev F

[24]
Pub: 2013-07-16




QRS-Card™
4.06 Cardiology Suite Operating Instructions

1 PBI

6. Resting ECG Module

QRS-Card™ Cardiology Suite 4.06 Resting ECG Module allows users to record, store
and print ECG’s quickly and easily. The best way to obtain a good quality ECG is for the
administrator to be properly trained, to prep the patient correctly and to reduce
artifact/noise. [B29]

Once you have the patient prepped and the electrodes securely attached you can begin a

Resting ECG test.[B30]
6.1 RESTING ECG SETUP

The Setup command is used to define settings for running a Resting ECG Test. It is
recommended that before performing your first test, you define the setup.

Resting Setup can be accessed three ways:

¢ From the Master Screen select File > Resting > Setup OR

¢ Simultaneously press CTRL + F2 OR

Click on the Rest ECG ico i i (If the "Show This Window" option in the
Resting Setup has been selected, the Resting Setup screen will automatically be
displayed. )

Resting LJ-&-
Default Reparts
D | h amme -
[ Shaow electrade position diagram. . 1200 Stardard 12 Lead Cancel
I Stfart test when measurements valid 11203 Standard 3 Lead = Help
[ Prirt ECIG report,
Foe q 11208 B2 12 Lead Standard
gl e [01208 622 Page12 Lead Standard
|— Remote Server. 50[88!’18 g 1210 124112 Lead Standard = ﬁTAT ECG
ECG Filter ECG Acquisition
Electrical interference | 60 Hz - Recorder | ORS Card [Blugtooth Ty
Autifact rejection | None - Sample Rate | 240Hz Dema
Baseline Dritt Reduction | On - Length |00
Awerage Cycles |25
Interpretation | PBI - Reset
Resting Procedure Tasks
Show This Window If selected, the Resting setup box be displayed before the start of each Resting ECG
Test. If you anticipate running STAT ECG tests, keep this box selected.
Show Electrode If selected, the electrode positioning diagram will be displayed before performing each

CS406-10 Rev F
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Position Diagram resting ECG test.
Start Test When If selected, the test will automatically start once it is determined that the ECG trace

Measurements Valid measurements are valid. If not selected, the ECG will begin but the test will not start
unless the Save Strip icon is clicked on the Resting ECG toolbar.[B31]

Print ECG Report If selected, an ECG Test report will be printed automatically at the end of the test (based
on the tests selected in the ‘Default Reports‘ box of the setup screen) and will be saved
to the computer hard drive.

If unselected, no reports will print, but the test will be added to the test database.
Printing can be done anytime after the test is acquired.

View Test Record If selected, the ECG test record will be displayed automatically after the Resting ECG
Test is finished.

If unselected, after the test is finished, the software will return to the master screen.

Exit When All Tasks If selected, the program will return to the Master Screen when all the tasks selected for
Complete the Resting ECG test are completed. (NOTE: If unselected, this feature can be used to
save multiple Resting ECGs strips from the same test.)

Remote This option allows users to define a Remote Server to remotely display the ECG test in
Server[B32] real time. For more information, please contact Pulse Biomedical.
Screens Defines “Default” parameters for Screen display values during ECG
acquisition and viewing. E.G. Gain, Speed, Lead Display etc.
Configure Acquisition Screen [ 2 &J
Acquistion l View ]
Rbwthm
_ =11
Gair [gIFENY ~ __ 21d
Speed |25 mm /s * " E1d
H-121d

[ Shaow Toolbar

0K | Cancel Help

In the “Acquisition‘ tab you can set the default gain and speed to be displayed when the
ECG is being acquired. You can also define the leads you would like displayed by
formatting the leads on the right hand side.
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1 1d- defines the default lead displayed if you choose a one lead display

3 1d- defines the default leads displayed if you choose a three lead display

6 1d- defines the default leads displayed if you choose a six lead display

12 1d- defines the default leads displayed if you choose a twelve lead display
To Define the Leads:

1. Click on the #'next to the lead options.

2. This will open the leads for selection.

+-11d ~
—I-31d

W2

W5
+-EId v

3. Double click on the lead to change (II, V2, V5) and a drop-down
menu will open in which user can select a different lead.

4. 'When you are finished defining the leads, click “Apply*

Configure Acquisition Screen @I-E_hj
Acquistion  View
Page
) B-11d
Gair | Ry __ Id
Speed |25 mm /s - " Eld
B-121d

v Show Toolbar

Ribgthm

Gain |10 mmdmty, =
Speed|25mm /s -
Scale |Show HR -

[~ Show Toolbar WV Show Grid

ok | Cance | Help

In the “View* tab you can set the default view on the Page screen and the Rhythm
screen during dataview.

A

You can also define whether you would like the toolbar or grid displayed during ECG
view during dataview.

Follow directions above to change the parameters and leads.

ECG Filter
Flectljlcal If selected, allows the user to apply a 50Hz or 60Hz electrical filter to the signal. The

[27]
CS406-10 Rev F Pub: 2013-07-16




QRS-Card™

A PBI 4.06 Cardiology Suite Operating Instructions

Interference filter can be turned off by selecting “None.”

Artifact ReJeCtlon If selected by choosing “Standard,” artifacts such as those caused by muscle twitches or
noise will be filtered.

Baseline Drift If selected, drift of the baseline will be minimized.

Reduction

Default Reports: Selected reports can be printed (automatically or manually) as default reports to printer
attached to the computer.
Please see Appendix 3: Sample Resting reports.

Interpretation User can select if they want Cardiology Suite software to automatically
interpret measurements. Options are: 1) PBI algorithm, 2) HES algorithm, 3)
LEUVEN algorithm or 4) No interpretation.

M JIIY A computer generated interpretation cannot replace

sound medical reasoning by a trained professional. Therefore, a
physician should always review the interpretation and final
analysis should always be obtained by a Physician.
Proper administration, diagnosis and implementation of the test is
the Physician’s responsibility.

ECG Acquisition

Recorder Defines the device that is being used to produce the ECG signal. To confirm device
connection, click “Try”. An ECG trace should appear. Please see device hardware user
manual for more instructions on device setup and troubleshooting or or call Pulse
Biomedical technical support (610) 666-5510.

Sample Rate Defines the sampling rate, per second.

Length Defines the length of the ECG test, in seconds.

Average Cycles Defines the number of beats averaged to make a complex ECG.

Demo Allows user to run a demo Resting ECG test.
Allows users to run a test immediately, bypassing patient demographic screen,

STAT ECG .. . .
electrode position diagram, etc. Test starts automatically.

Reset Button Resets the setup to its default settings.

6.2 Recording a Resting ECG

[28]
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A Resting ECG test can be executed using one of the following methods:

¢ From the master screen, select File > Resting > Perform Test OR

o From the toolbar, click: h OR
e Use the Hot Key F2

Depending on your settings (see section 4.1 Resting ECG Setup), you may see the
electrode placement diagram or the setup screen, once you move through these screens
you will see the ‘Resting ECG Patient Information’ card. The top half contains
information about the patient, while the bottom displays traces from leads attached to the

patient.

To use an existing patient from your database, click the ‘Browse’ button and search for
the patient. To run a test on a new patient, fill out the fields on the ‘Patient’, ‘Test’ and
‘Medication’ tabs. When this form is complete, click ‘OK’.

Patient | Test | Medication |

Identification
1d[DEMO E : NT’CE .
Vool e 1 Patient Age is calculated from
the computer date.
R 2 k| Before running any tests,
Address confirm that the computer’s
Syeer|!12 1" Lare date is correct.
City[King of Prussia swe[Ps  Zp[Ts40s Date of Birth is also required
for calculation of Target Heart
el l— .
o) Sl Rate and correct automatic

— - Cancel_

The QRS-Card™ Cardiology Suite Resting ECG Acquisition Screen will be displayed
and the test will begin.
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Depending on your settings, the ECG test will do a number of things. If you are using
default settings, the test will run for 10 seconds and automatically save the 10 second
ECG strip. For more about resting test setup, see section 4.1 Resting ECG Setup.

B f ng - (9/21/2009, 4:36:39 PM)

PR: 150 P axis: 72
- Print ECG QRS: 88 R axis: 74 1
~ QT /QTc: 358 /389 T axis: 71 ;

0:06 F N-N-N [121d =] [tommmv -] [25mm;s | a2 | &

/me /MMWW%\\JM
I Y N S AR R IR 1

WARNING | De Acquilition

@ Measurements Valid, but Interpre

[KB33]

Save Strip Clicking this button will save an ECG strip for the time specified in Resting Setup (See
Section 4.1). This option allows user to save multiple ECG strips from one ECG test.
Note: If you are using default Resting Test settings, selecting this button is not
necessary as a 10 Second ECG strip is automatically saved.

Print ECG | Clicking this button will print an ECG report. This option requires a HP PCLS5 printer.
B34

;fote]: If you are using default Resting Test settings, this option is not necessary because
the 10 Seconds ECG trace is automatically saved and can later be printed.

Finish Test | Clicking this button will finish the ECG test.

Note: If you are using default Resting Test settings, this option is not necessary as the
test will automatically terminate after 10 seconds.

After the test is finished, depending on user settings, reports will automatically print or
software will return to the QRS-Card™ Cardiology Suite Master Screen with test
previewed in the Workspace. You test will be saved in the Test Database.

6.3 Reviewing a Resting ECG Test

To view (or edit) a Resting ECG test, highlight the desired test from the Cardiology Suite

Open
150]
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Master Screen test database and click
OR

Double click on the test to be reviewed.
+ 1/28/2005 | tesat, | 11Z1(1)

+ 1/28/2005 | Hz500, | 121{1)
= 1/z8(2005 | stadrer, | 121Z(1)
a e JRest ECG 10 A
+ 1/28/2005 | tesk, | 1121(1)

The test record will be displayed in the Cardiology Suite Resting Dataview screen. The
default view is a 4 x 3 lead view (see example below).

[l Resting - Michael Money (7/29/2010, 11:04:56 AM)

itk - = PR: 146 P axis: 73
%mn FIAE View Summary F‘\;;ﬂ Report H Save @ Help QRS: 88 R axis: T4
Pttt e & QT S QTc: 363 § 394 T axis: 72

: 4x3 1 2%6 1 Complexes I Rhythm}

Patfent: Mighasl Waney PI: 3H45ETE Tort Cate: T282310, 1104 A0 Losatian: Fulrs Blom sdical

Flslean's signature rate
HR 71 BP ..o ot bepel ol cenati 275 St Sariclony Bk B 605

Dterpretation

1 SRR IRER |AEE|IEEY BGRA TNAR IRES DAY SRR ENEE IRER| IR

RIS 0, e B . AT e T ST £ el

e PEL 1305 C'atfich Lans Nomietown PA 10403 610 666 5510

71

RestingProcedure

[KB35]

From this dataview screen, users can

° View/edit patient data
o View/edit test data
° Print and save reports

6.3.1 Edit Tab
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Use the Edit option to view or edit information about the patient.

Patient-
In this area users can edit patient demographics.

Test-
Contains additional patient information.

Medication-
Contains patient medication information.

Signal-
Contains information on how the ECG was obtained such as the sampling and use of
filters. In this tab, you can also change Blood Pressure Information.
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6.3.2 View

B ' Resting - Artificia

Gﬁ.g

4 x 3 ]gxa

Patient (8/26/2011, 11:14:56 AM)

3
..-"" .|__
| Summary é‘_ﬁ Report H Save @ Help

ormplexes ] Rbythirm ] 12 Lead ]

4 x 3 Screen
This view shows 12 leads organized in 4 columns, 3 rows and a rhythm strip on the
bottom. Each lead (except for the rhythm strip) shows 2.5 seconds of data.

On the top of the screen you can review patient demographics, ECG measurements, Heart
Rate, Interpretation, Blood Pressure, Test Date, Location and Physician Confirmation.

On the top right hand side of the screen, ECG measurements are shown (PR, P axis, QRS,
R axis, QT/QTc and T axis).

(G Resting - (8/4/2010, 5:20:41 PM) e
bk - - PR: 154 P axis: 76
Gﬁg&dw IR View Summary é_!,a Report H Save @ Help QRs: 92 R axis: 74
ey —— = QT /QTe: 363 1394 T axis: 71
: 4 K3| 2x6 ‘ Complexes I Rhythm I
Patient: PID: Test Date: 81412010, 5:20 PM Location: My Office
Fge: NG Sex: NA Physician C i
Height' s Wi WG HR 7T BP oos iresd Fepom tanconimads
Doctor: Retamed By
Race: NA ECG Measurements Interpretation
Aoahal: A PR: 154ms
Famlly:  NA 5. 02ms Boredtine ECG.
Smoking:  NA 0T/ OTC: 383ms 304 Simus rhythim.
Pacemaker  NA F iz 767 Eariy repatarization
Medication. ORS Axis: 747
T Awis: 71
Sokolow Lyon: 2262
Comel: 73
i e wa v :
I aWRl V I
N ) e s 7\ ] I" !
| I i { I il
¥ T
1L} avil’ V. ¥ |
| ﬁ H
[ 5 NI IPT| % W S |7 N S PR N OO N s D % (A NN SO B gl SRR T NI 1| % RN | g W
T L4 L} J U "
m \IF hed \
i ' 1 | 1 [ |
| | i I | | 2 | I f
g S Lo S WL LSS g S |l S ] s L g VIR | B U] o SR N
I ] } | | |
| I i J | i i | | I
[ 5 ALY | < g S S N | T SR Y | PN S AR BRI | Yl SRR V| g NN | RPN A SR [ S| S S
pisa B R R Brmadioal Tino A Figkes resen el T Shddn T Tedd
Pulse Biomedical Inc 1305 Catfish Lane Worristown P& 19403 610 666 5510
RestingProcedure
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Users can edit the interpretation directly from this view by clicking inside the

Interpretation box. Click EI or DK' to exit interpretation editing.

B Resting - (8/4/2010, 5:20:41 PM) = @3 B
Aok g - = PR: 154 P axis: 76
Edit | {5 View | summary éja Repart H Save @ Help QRS: 92 R axis: 74
st e 2 QT / QTe: 363 1 394 T axis: 71
4x3 I Z2%x6 ] Complexes | Rhythm }
Patient: PID: Test Date: 8/42010, 5:20 PM Location: My Office |
#ge: NG Sex: HA Physician Confirmation i
Height: NG Weight: NG HR 71 BP ... yerea report ot confimedy
Doctar: Refemed By: i
Race:  MA ECG Measurements Interpretation
HAoehol M PR: 154
F:I'uml; NA QRs: 92 mrgs
Smoking NA QT rOTC: 263ms /394 x
Pacemaier:  MA P Aois: TG ®
Medication QRS Axiz: 74°
T Ais: T1°
Sokolow Lyon: I262
Comell: 73
vl e W waa i , :
i R V i
[T W -~ h-"\_ f. - i i i e P N SR P i F/’r\_ [} -~ L/‘\_ 1
[KB37]
2 x 6 Screen

This view shows 12 leads organized in 2 columns, 6 rows.
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(87 Resting - (3//2010, 52041 PM) [E=N=R
edodeodeoke - PR: 154 P axis: 76
Edit G View | | [ | Summs 4 Repo Save Hel QRS: 92 R axis: 74
Gm ‘ MV i é;;,ﬂ pert ‘E‘ @ ’ QT i aTe: 363 7394 T::il:: T
4x%3 210 I Connplexes } Rhythrn }
atlent HiE “Test Tiate” BAFAITE, A0 PR Logation bty Tifice:
HR 71 BF o Age: HG Sex: HA PR:154ms QRS: 92 ms QT /QTC: 363 ms (394
7l i {5 Ll T T i 4§
1 1
: A A [N
I \f i ¥ f I
[} L |
I 1 i 2 2
I | I |
4 JhetA by e ey w 4 AN
| | | i |
]
| 1 !
I J N L. f L
cof o r =T = r 1
aVR 4,
o vy -y o /L \ '\
| | | |
¥ } |
avl ]
| ! |
: N a\ 1% L |
7 v ¥ =
alfF M6; | N | y '
l | 1 ! | ! | I
! LPNEN SRR 1NN e | | SN
RestingProcedure {KB38]CO

mplex Screen
This view shows each lead and its average complexes.[B39]
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B Resting - (8/4/2010, 5:20:41 PM) ==

Aecladrlode . - PR: 154 P axis: 76
Edit | bk view | Summary é:!a Report Lﬂ Save @ Help QRS: 92 R axis: 74
ol = QT / QTc: 363 1 394 T axis: 71
4x3 | 2x6 i Complexes ] Rhythm |
Patient: PID: Test Date: Bi4:2010, 5:20 PM Location: My Office
e NG Sex: NA ysic
Height: NG Wieight: NG HR 71 BP ... Dvamread Repart (ot confimmed)
Dioctor: Refered By:
Race:  NA ECG Measurements Interpretation
Heahol:  NA FR: 154ms
Family:  NA ORS: 8Zms Bordertine ECA
Smoking:  NA QT 0TC: 363 ms £ 394 Shaus rhypth.
Bacemacer  NA P iz TH® Eariy repolarization.
Medication: QRS pwis: 74"
T fuis: T1®
Sokolow Lyon: 2262
Comell: 73
WA 25 i A G i i 1 Ll Bz, Basaits
it il Vi

——

Al L d Jr

gt (20817, Pl Bamedical; e Al Tights resera 7% Standard GRS Camplas

Pulse Biomedical Inc 1305 Catfich Lane Mernstown PA 19403 610 666 5510

RestingProcedure
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Rhythm Screen

This view shows ECG rhythm data. Users can scroll through all data saved during the
test by using the navigation bar at the bottom of the screen.

.
| Resting - (8/4/2010, 5:20:41 PM) == )

kel . - PR: 154 P axis: 76
Edit | jphuieh View Summary {:ﬁ Report H Save @ Help QRS: 92 R axis: 74
e & QT / QTc: 363 1394 T axis: 71
4x3 ] 2x6 } Complexes Rh 1
Patient: PID: Test Date: 8/4:2010, 5:20 PM Location: My Office |
i Age NG Sex: MA O i i
i Height: NG ieight: NG HR 71 BP .. i Report (ot confimed)
i Dector: Refered By,
Race:  NA ECG Measurements Interpretation
Hcahol:  NA PR 154ms
Familly: NA ORS 9Ims BFﬂi:r“rm ECaO.
t Smoking:  NA QT/OTC: 363ms £304 Sius chythe.
o Pacemaker: N P fuis 76° Eaftfrepolanizaton;
hiedication: ORS Awis: 74°
T fis: 71
Sakolow Lyon: 262
Comell: 73

uc:u [10 mmym =] [25 mn =] | dflesd 75 Messune (pene [laria | QPR
|71 71|71 |71 |71 |70 [ 710 |71 |71 | 71 |

EELAREL PR PRER DRER 26| PN D NAR PR eI PeE

RestingProcedure
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6.3.3 Summary

B ' Resting - Artificial Patient

Pt ainiatu)
GmEd'rt IR Vie

P R P R e

P P RN AR P

Pressing the Summary button provides summarized data for ECG measurements and
automatic ECG Interpretation.

Table Screen

The table screen provides amplitude measurements from all 12 ECG
[a Resting -  (8/4/2010, 5:20:41 PM) SRR X

Aol - PR: 154 P axis: 7§
A , \
Gmgdn SR view Sy é;—;i Report H e @ Help QRS: 92 R axis: 74
gk h—d = QT/QTe: 3637394 Tais: 71

Table 1 General I P Wave 1 ORS Wave 1 T Wave 1 Hypertrophry I Interpretation I

Lead [aPL(u¥) | aP2(uV) |aQ(uv) |aR(uV) |aS(uv) |aRl(u) |aSL(uV) |aTlu) |aTz(uy) =~
now 0 0 1327 0 0 0 100 o

mo 6 0 0 964 0 0 0 7 o

R 59 0 -866 o 0 0 0 266 o

EL 0 0 0 73 -368 0 0 -1 0

avF 76 0 0 1122 0 0 0 339 0 =
V1 0 0 0 66 -688 0 0 83 0 1
Ve 39 0 0 290 -547 0 0 476 0

v 81 0 0 2045 0 0 0 639 0 N
VA 66 0 0 2054 0 0 0 481 0

Vs 39 0 -27 1574 0 0 0 342 0

ve 34 0 2 1164 0 0 251 0o -
‘ n v

RestingProcedure

leads
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General Screen

Provides ECG Complex measurements. Users can override the automatic ECG

measurements by moving the measurements marker. (Drag markers using left mouse
button)

.

| Resting - (8/4/2010, 5:20:41 PM) [ ==
Aol - = PR: 154 P axis: 76
piutigtnt A ;

%Ed\t TR View G/' S éﬁ Eenor H = @ Help QRS: 92 R axis: 74
G P =
R

QT / QTc: 3637 304 T axis: 71

Table Gereral WPWave } QRS Wave } T Wave I Hypertrophy } Interpretation ]

General Morphological Measwements

PR Interval [ms] |154 QRS Duration [ms] |92 HR (¢min] |71 QTc (ms)|394
P Duration [ms] (117 QT Interval [ms) | 363 ORS Axiz[7) |74 QTc Bassett [ms]| 340

[ve | [s0¢mv -] [100/s ~]

Markers (ms]

2
@
]
»

Paon| 246
Foif| 363
QRSon| 400
ORSoff[ 492

Toff| 763

Mo F wave

ooooo
W

&R&?.i"” -

RestingProcedure
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P Wave Screen

provides P wave morphological measurement markers. Users can override the automatic
ECG measurements by moving the measurements marker. (Drag markers using left
mouse button)

.
| Resting - (8/4/2010, 5:20:41 PM) == )

Aol R - = PR: 154 P axis: 76
%Ed\t Tk View G/' e {jﬁ Report H Save @ Help QRS: 92 R axis: 74
bl . = QT / QTc: 363 1 394 T axis: 71

Table ] General P Wave ] QRS Wave } T Wave I Hypertrophy } Interpretation ]

F Morphological Measurements:

GRS Onset (ms) 400 P Onset ms] |246 P1 Amplitude (ul)|34 PR Interval [ms) |154
T Offset [m3] |763 P Otffset [m3] |363 P2 amplitude [uv]{0 RR Intereal [ms) | 845

[ve | Jwoovmv -] [eB00s ~]
Markers (ms]
man.

anm [m}
P‘un’iﬂ [m}
poif[ 354 [

Display
Mo P wave
T NoPwae | e e

W »

7, I | =
< i v

RestingProcedure
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QRS Wave Screen

Provides QRS Complex measurement markers. Users can override the automatic QRS
Complex measurements by moving the measurements marker. (Drag markers using left
mouse button)

[0 Resting - (8/a/2010, 520:41 Py o[ ) [

Ay " - PR: 154 P axis: 76
Gﬁgdit AR View Summary {;ﬁ Report H Save @ Help QRS: 92 R axis: 74
P a = QT / QTc: 363 7 394 T axis: 71

Table I General } P wave QRS Wave ITWaVE } Hypertrophy I Interpretation }

GRS Morphological Measurements

QRS Orset (ms) |400 Q Amplitude () |-22 S Amplitude (U] |0 5" Amplitude (/] |0
GRS Offzet [ms] {492 R amplitude U] {1164 R* amplitude [ul] 0 QRS Duration [mz] (92
[ve =] [1o0smv ~] [0/ -]
M arkers [ms) »
man
Gon| 400 [ E
Fon| 408 [
Son| 0 [
R'on 0 =
S'on 0O
ORsaoff| 475 [

Display
No [ wave
Mo R wave
Mo S wave

Mo R' wave

Mo §' wave

i B -
? ;

RestingProcedure
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T Wave Screen

provides T wave measurement markers. Users can override the automatic T wave
measurements by moving the measurements marker. (Drag markers using left mouse
button)

=hRen X |

-
5 Resting -  [8/4/2010, 5:20:41 PM)
PR: 154 P axis: 76

Al B 1
GﬁEdit RS View Uy {;ﬁ Report H e @ Help QRs: 92 R axis: 74
ik 4 = QT OTc: 3627394 T axis: 11

Table I General } P wWave I QRS Wave T Wave ] Hypertrophy I Interpretation }

T Morphological Measuiements

GRS Offset [ms)|492 T1 Amplitude (] |251 QT Interval [ms] | 363 QTc [ms) 394
T Otfset [mz] | 763 T2 Amplitude L] |0 RR Interval [mz) | 845 OTc Bazett [mz] | 340

[ve =] [1o0smv ~] [0/ -]

M arkers [ms)
mar.
Ton| 575 [
T'on 0=
Tolt| 758 [

MNo T wave
O s o e e v ey o s o o o P i o e |

m| »

T ﬂ A
P i, b

RestingProcedure
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Hypertrophy Screen

Provides Hypertrophy scores for Sokolow Lyon, Cornell and Estes.[KB43]

B ' Resting -

(8/4/2010, 5:20:41 PM)

= | B ||

piruirim

Table ] General

P Wave

QRS wave | Twave  Hypertrophy ]Interpretamn |

Sokalaw Lyon

VB aR (W] 1574 WEaR (W] 1164 W1 a5 [uv] EBEE

Masimum: V5 R or V6 R [uy] 2262

Estes

1. Amplitude [Presence of at least one of the following) 10
Largest B or § wave in limb leads »= 2 my
Largest 5 wave inW¥1 oz »= 3 my
Largest B wave in V5 ar VB »= 3 my

2. 5T Segment Criteria 0
Any 5T segment shift with a vectaral direction ]
opposite ta mean QRS [without digitalis)

m}

Cormell
avL aR (] 73 W3as ) 0
hA AL aR + %3 a5 (W]

3 i Citerion
Left axis deviation [R asis betwesn -30° and -390

4. Duration Criteria [ 1 point for each af the follawing)
(RS Duration >= 90 ms
Intrinsicaid deflection in %3 ar VB »= 50 ms a

5. Left atrial criterion
Terminal negativity in the P wave in V1 2.7 iy ]
in depth with a duration >= 40 ms

Total Score

i - i PR: 154 P axis: 78
Edit vk View Summary é:;a Report H Save @ Help QRS: 92 R axis: 74
ks N

73

QT / QTc: 363 7 394 T axis: 71

RestingProcedure
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Interpretation Screen

- provides computer generated Automatic ECG Interpretation. [B44]Interpretation
can also be edited by typing free text or accepting statements from the Statement
Library. For the Automatic Computer Interpretation to work in the Resting test,
this option has to be selected in the Resting Setup.

- To add statements from the statement library, select the statement desired and
click on the arrow to transfer it over to the Physician's Interpretation box.

- In a view-only box at the bottom of the screen, the date and time of the computer-
generated interpretation is displayed. The name of the analyst who overread the
interpretation and the physician that confirmed it, along with the date and time,
can be entered in the applicable boxes.

[l Resting -

T =
Gmm ST iew gummw éfﬂ fge H S @ Help
p :

Table ‘ General } P Wave I QRS Wave } T Wave ‘ Hypertraphy  Interpretation ‘

(10/21/2010, 11:13:12 AM)

Physician Interpretation

PR: 183 P axis: 27
QRs: 82 R axis: 53
QT f QTc: 350 § 350 T axis: 62

Statement Library

[Abromal £CG
Sinus thythm

Computer Interpretation

\Anteroseptal mpocardial infarction, age undetemmined

h'd

\Bbmarmal ECG
Sinus thythm,

(Arnteroseptal myocardial infarction, age undetemined

RS Card Cardioloay Site (Enu 4.06]

I~ bnalyst S

<& Nomal/Abrormal o
<= Wentricular Hypertophy

«F Myocardial Infarction

<= Conduction disturbances

«F Other QRS morphology or general de
= Statements related to impulse formati
= Statements related to impulse formati
«F Sinus node dysfunction, atrial and 2
= Statements related to ectopic thythm|
<= Statements related to ectopic thythm| _
<& Statements related to [predominant] | =
<= Pacemaker types and pacemaker fu
= other thythm related statements

= Descriptive ais statements

5 5T-T desciiplive statements

«F ischemic §T-T changes compatible |
«F ST-T changes compatible with sube
«F non-specific ST-T changes altemati|
«F other 5T-T descriptive statements

5 Atrial statements

< Statements related to pediatric ECG
5 Statements related to the ECG calbr ~
« m »

[ Physician =

e

[t11322aM =

[117 gm0 ~] [114zisam =

[t/ gm0 -] [1neztsam =

60

RestingProcedure

[KB45]

QRS-Card™ Cardiology Suite can provide automatic computer
interpretations. A computer generated interpretation cannot replace sound medical
reasoning by a trained professional. Therefore, a physician should always review the
interpretation and final analysis should always be obtained by a Physician.

Proper administration, diagnosis and implementation of the test is the Physician’s

responsibility.

CS406-10 Rev F
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Updating Custom Dictionary

By clicking the E icon in the Interpretation screen, user can update the custom
dictionary. Follow ‘Edit Instructions’ at the bottom of the screen.

Update Custom Dictionary - k B Au

LCancel |

Help |

normal ECG
normal QRS
normal P wave
normal 5T-T
EC G within narmal limits for ag
nossibly normal ECG
horderline ECG
abnormal ECG
possibly abnarmal ECG
abnormal QRS
abnormal 5T-T
normal far age
naormal for build
abnormal for age
ahnatmal far build
unusual for build
H
ks

o o e B e e e e e e o e ] e B e [

Momal/abnomal

Edit Instructions

Left Click any button to edit text.
Remove all characters to hide a button.
Those buttons displayed with a red "X' will be hidden.
Press '0K" to save changes.
Press 'Cancel’ to discard changes.
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6.3.4 Report

Clicking the “Report” button allows users to select reports to be printed, PDF reports to
be created or the report to be viewed in Microsoft Word (See Appendix 3 for Sample
Resting Reports).

Select Report @ﬁ
ID [ Name | Show Detals | o |

Standard 12 Lead

Brinter ... | LCancel |

[J1203 Standard 3 Lead
11208 B2 12 Lead Standard Output
11208 B2 2 Page 12 Lead Standard
11210 1241 12 Lead Standard 7 RICOH Aficio 12
O121z Standard QRS Complex " PCLE Printer
[J13m 3 Lead Serial Companson ™ PDF Eile Viewer

& M5 Word File Views

v Usze Color

|200 DR+ 200 DRI |

Create and View POF File

Only 300 DPI resolution supported. Only
black and white colors available.

Show Details Pressing this button will either hide or show printing details.
Printer... Pressing this button with show printer details.
Output Under output you can select which printer you want to print to. Your

default printer will show as the first option (In this example, RICOH
Aficio is the default printer)

PCLS5 Printer(B46] | Selecting this option will print the report to the default printer

PDF File Viewer By selecting this option, the report will be printed to a PDF file and displayed on
the computer screen.

The Save button from Adobe Acrobat Reader will save the report in PDF format,
which can be printed or emailed by the user, if required.

Note: In order to print PDF File Viewer to computer screen, installation of
Adobe Acrobat Reader 6.0 or higher on user computer is required (also make
confirm that version of Acrobat Reader is selected under
“AUtility\Configuration\Option\PDF . To confirm, select “Detect” )[B47]
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MS Word File Selecting this option will open the report in Microsoft ™ Word. The save
Viewer button from Micrsoft work will save the report as a Word file for editing,

printing, etc.

Note: In order to view in Microsoft Word, installation of Microsoft Word
on user computer is required.

Use Color Selecting this button will allow user to print ECG reports in color
depending on printer options.

[47]
CS406-10 Rev F Pub: 2013-07-16



QRS-Card™
A PBI 4.06 Cardiology Suite Operating Instructions

7. Stress ECG Module

QRS-Card™ Cardiology Suite 4.06 software allows user to record, store and print Stress
ECG’s quickly and easily. The best way to get a good quality ECG is for the
administrator to be properly trained, to prep the patient correctly and to reduce
artifact/noise. [B4s]

Once you have the patient prepped and the electrodes securely attached you can begin a
Stress ECG test.[B49]

7.1 Stress ECG Setup

The Stress ECG Setup screen is used to define settings for running a Stress ECG Test. It
is recommended that before performing your first test, you define the setup.

Stress ECG Setup can be accessed three ways:

¢ From the Master Screen select File > Stress > Setup OR
e Simultaneously press CTRL + F3 OR

i

¢ (lick on the Stress ECG icon "Show This Window" option in the Stress
Setup has been selected, the Stress Setup screen will automatically be displayed. )

[48]
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Stress Pz|
<] Boteed | s
Protocaol | (210 Editor . ) |1 _ J -
£man age A Pratocol
Controlled Device Blood Pressure Cancel
Simulated Treadmil - Type |Auto Prompt - Firnal Help |
. ] 1o} | Narme | ~
[~ Metic [ Required
ﬂ O 1000 Stress ECG Segment [3 lead)
O 1o0m Stress ECG Seagment [12 lead)
Dizplay Options 1002 Stess ECG Result Table
W Show thiz window Save Strings [J1003  Stress ECG Summary Report
¥ Show electrode position diagram. = 1004 Stress ECG Summary Report (Classic)
v Arthythmia Screen Teminate O 1005 Stress Stage ECG Comples Surmmary
Sirings e e e e %
[w Trend Sereen

[ Wiew test recard Soreens
[~ Remote Server =

Target Heart Rate

ST Segment Display & Calcdate | [220 - agews ) ®[100
& Mormal
" Mawimum 5T e Elevation or Depreszion Lead " Agsign 180

" Maximum 5Te Elevation Lead

" Maximum 5Te Depression Lead ECE Acquisition
Diemo
ECH Filter Recorder |ARS Card [USE) - Ty -

Electrical interference |60 Hz - Sample Rate |240 I_l_l_l_
Artifact rejection | C4 Filker - Length {3600 I_’_I_’_
Bazeline Dinft Reduction | On - Awerage Cycles |25 Beszet
[KB50]
Protocol Defines the Stress Test Protocol to be used during the Stress ECG
Test.
[B51]
Protocol Editor Users can edit and customize protocols using the protocol editer.

(See Appendix 7:Stress Protocols)

Controlled Device | Defines the stress test exercise device (either treadmill or
ergometer). You can confirm device hookup by click the “Try*
button.[B52]

[49]
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Try

Tests the functionality and the connection between the computer
and the Exercise device. To test a device,

Select the Device in the Controlled Device menu.

Click “Test*. The “Configure Exercise Device* screen appears.

Test Tab:

To test a device, click on the icons under Speed to increase and
decrease the speed of the device. Click on the icons under
Treadmill to increase and decrease the elevation of the device.
The Blood Pressure can also be tested to verify the automatic
blood pressure device interfaces with the software is functioning

properly.

Configure Exercise Device

2 Test | B2 Limits |

Speed Treadmill

£ A A M

Blood Pressure

L

A

Ok Cancel ‘ Help

CS406-10 Rev F
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Limits Tab

Lists the limits of treadmill or ergometer driver.

Automatic Blood Pressure — defines if Blood Pressure
measurements will be taken automatically by a BP machine
interfaced to the QRS-Card™ Cardiology Suite Software or
whether the program will prompt the user to enter the BP
manually.

If ‘Automatic Blood Pressure’ is selected, the user will NOT be
prompted for blood pressure input unless the blood pressure tool
button is manually executed. [B53]

Configure Exercise Device @lﬁ

% Te ¥ Unss |

Load

kit |... ks |... Stepl...

Elewvation [Load)

Fir. {0.0] Pax |25.0 Step |EI.5

Speed
kir. (0.0 Max |12.0 Stepl[l.'l

[ Automatic Blood Pressure

QK | Cancel Help

Display Options
Show This Window | If selected, the Stress setup box will be displayed before the start
of each Stress ECG test.
If it is not selected, the Stress setup box will not appear at the start
of each Stress ECG test.
Show Electrode If selected, the electrode positioning diagram will be displayed
[51]
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Position Diagram before the start of each Stress ECG test.[B54]
Arrhythmia Screen | If selected, the Arrhythmia screen will be displayed during the
Stress ECG test.[B55]

Trend Screen If selected, the Trend screen will be displayed during the Stress
ECQG test.[B56]

View Test Record If selected, the ECG record will be displayed immediately after the data is collected and

the stress test is finished.

If unselected, the software will return to the master screen after the data is collected and
the stress test is finished.

Remote Serverss7) This option allows users to define a Remote Server to remotely display the ECG test in

real time. For more information, please contact Pulse Biomedical.

ST Segment Selects the display lead for the ST Trend Window.

Display

Normal Provides the display of ST for the user selected lead.
Maximum ST Automatically displays the ST values for the lead that has either
Elevation or the maximum elevation or the maximum depression.
Depression Lead

Maximum ST Displays the ST values for the lead that has the maximum ST
Elevation Lead elevation.

Maximum ST Displays the ST value for the lead that has the maximum ST
Depression Lead depression.

Save Strings Allows the user to mark and annotate abnormalities during a

Stress ECG Test.[B58]

Terminate Strings | Ends the Stress ECG Test so the user can review any annotations
that have been made.[B59]

Screens Defines “Default” parameters for Screen display (e.g. Gain,
Speed, Lead Display, etc.) for Acquisition and Dataview Screens.
[B60]

ECG Filter

Electrical This allows the user to apply a 5S0Hz or 60Hz filter to the signal.

Interference The filter can also be turned off by selecting ‘None’.[Bs61]

Artifact Rejection If selected artifacts, such as those caused by muscle twitches, will
be filtered.
Baseline Drift If selected, drift of the baseline will be minimized.

[52]
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Reduction \
Reports
Demand If desired, a printout of the ECG trace can be obtained while the

test is running. Chose the number of pages to be printed ( 1 to 6
pages or a continuous printout). Start the Stress test. Click on the
Print ECG icon and the printout will start from that point. If
Continuous is chosen, the printout will continue until the Print
ECG icon is clicked again.

Final Specifies the type(s) of final reports to be printed automatically
after the Stress test is completed.

Target Heart Rate | Defines whether the Target Heart Rate is to be calculated from the
patient‘s age or be manually assigned.

NOTICE j:¥tren age is calculated from computer date.

Before running any tests, confirm that the computer date is

correct.

ECG Acquisition

Recorder Defines the device that is being used to produce the ECG signal. To confirm device
connection, click “Try”. An ECG trace should appear. Please see device user manual
for more instructions on device setup and troubleshooting or or call Pulse Biomedical
technical support (610) 666-5510.

Sample Rate Defines the sampling rate, per second.

Length Defines the maximum length of the ECG trace, in seconds, that is
saved.

Average Cycles Defines the number of beats averaged to make a complex ECG.

Demo Allows user to run a demo Stress ECG test.

Reset Resets setting to default.
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7.2 Recording a Stress ECG

7.2.1 Phases and Stages
In general QRS-Card™ Stress ECG Test has three phases:

Pre-Test Phase
Exercise Phase
Recovery Phase

L0 2H[% 38 User Intervention is required in moving during Stages while in Pre-

Test phase. Exercise and Recovery stages are timed according to the selected
protocol (e.g. Each Exercise Stage in Bruce protocol is 3 minutes each).

Each Phase can have multiple stages:

Pre-Test Phase (User intervention is needed to complete/forward Pre-Test Stages)
Supine
Hyperventilation
Warm-up

Exercise Phase
Stage E1
Stage E2
Stage Ex

Recovery Phase
Stage R1
Stage Rx

*See Appendix 7 for more information on Stress Protocols

[54]
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7.2.2 Starting a Stress ECG Test

A Stress ECG Test can be executed using one of the following methods:

¢ From the master screen, select File > Stress > Perform Test OR

e From the toolbar, click: OR

e Use the Hot Key F3

Depending on your setup (see section 5.1 Stress ECG Setup), you may see the electrode
placement diagram or the Stress ECG setup screen, once you move through these screens
you will see the ‘Stress ECG Patient Information’ card. The top half contains
information about the patient, while the bottom displays traces from leads attached to the

patient. NOTICE

Patient] Test | Medication

Identification

1a[BEMD Patient Age is calculated from

Lest [Patient First [00005 / the computer date.
Date of Bith [1951-07-16 M

vy MM-dd Before running any tests,
Address .
T confirm that the computer’s date
. is correct.
City IKing of Prussia State W Zip |1 9406
Telophons [FTOGESHTA Date of Birth is also required for

i ———— O
myﬂw_ [ CANE I
NING-—De iti —

0K Cancel

To use an existing patient from your database, click the ‘Browse’ button and search for
the patient. To add a new patient, fill out the fields on the ‘Patient’, ‘Test” and
‘Medication’ tabs. When this form is complete, click ok.

[55]
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The Stress ECG Acquisition screen will appear and an ECG test will start.

Clicking on the blue 0 in the upper right hand corner of the window will display the
toolbar. Clicking on the crossed out i | will hide the toolbar. [B62]

7.2.3 Tasks Performed During a Stress Test:

3
ok
»Advanca Stage m Begin Recuvzr{ gﬂlood Pressure Save Strip E s ; Print ECG II Pause Protocol /ﬁﬁnish Test

Take Blood Pressure Print ECG Pause

Advance Begin Save Strip Finish
Stage  Revovery (Auto or Manual) g a1 notate Si on Demand Protocol Test
ingle Style Report

e  Use the Advance Stage
[B63][KB64]

command to advance the Stress Test to the next Stage.

e To begin Recovery, press the button.

e To enter a blood pressure measureyét, press the gé button. Blood pre'&sure
prompts will also appear agomatically eearding to setings inthe protocel e, p

e To annotate or mark a Strip to print during final reports, press the % button.
The ‘Save Strip’ window will appear, allowing the user to select an annotation to
add to the strip. [B65]

[56]
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Save Strip i

Equipment b alfunction
Moderate Chest Pain

Patient R equest

- - Cancel
Decreased Svstolic Pressure with Increased Work

Severe Chest Pain Claudication or Marked Dyspnea Help

Flef

Yertigo Marked ST Seament Elevation

Cyanoziz

Abavia or Mental Confusion tarked Hypertenzion
Frequent FC's
Supraventicular Tachycardia
Acute Onzet of Bundle Branch Block

Target Heart Rate Reached, Stress Test Completed

Three PYC's in Succession

I Wentricular Tachycardia or Fibrillation
2nd or 3rd Degree A Block
Atrial Fibrillation or Flutter
Evidence of dcute Myocardial Infarction

J
|
|
|
Marked ST Segment Deprezsion J
|
|
|
J
|

)L
e To print a real-time ECG strip, press the = button on the Stress Status Bar.

Note: Number of pages (or continuous print) to print under “Stress/Setup”
HP PCLS5 Printer is REQUIRED to perform real-time print [Be6]

¢ To pause (and manually control) the exercise stage and the protocol, press the

L button. Once you press the “Pause Protocol” button, a warning box will
appear. Click ‘Yes’ to disable the protocol and control the exercise driver
(treadmill or ergometer) manually, Click ‘No’ to ignore and go back to stress
ECQG test.

Option Request ﬁ

| WARNING!

@' This action decouples protocol.

Press [Yes] to disable automatic scheduling in current phase.

Press [Mo] to ignore selected action,

[Mote: Once decoupled, press [Advance Stage] to continue protocol at
next phase.

Four additional buttons will appear on the Stress Status bar.
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Higher

-\ ___ _________________________________]
These additional buttons are then used to manually control the Exercise Device

(Treadmill or Ergometer).

e To finish or stop the test, press the E button. This button is usually pressed
while in recovery phase, however the test can be stopped anytime during a test.
Once the Finish button has been pressed, the ‘Terminate Stress Test” window will
appear. [kB67]User can select from predefined options or free type reason for
stopping the test.

NOTICE lyryay iy stop a test in an emergency situation use TREADMILL
EMERGENCY STOP BUTTON

Terminate Stress Test i 4

| o |
e |

;|

Patient Reguest E quipment Malfunction

Cancel

Help

Diecreazed Systolic Pressure with Increased YWork, Moderate Chest Pain

Severe Chest Pain Claudication or Marked Dyzprea

‘ertigo Marked 5T Segment Elevation

Cyanosis

Atawia or Mental Confugion Marked Hopertenzsion
Frequent FYC's
Supraventricular Tachycardia
Acute Onzet of Bundle Branch Block

Target Heart Fate Reached, Stress Test Completed

Three PYC's in Succession

Wentricular Tachycardia or Fibrillation
2nd or 3rd Degree &Y Block
Atrial Fibrillation or Flutter
Evidence of Acute Myocardial Infarction

|
|
|
|
Marked 5T Segment D epression ]
|
|
|
|
|
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REPORTS:
Once the stress test has been finished, the ‘Select Reports’ screen will appear which
allows user to print, create a PDF or view reports in Microsoft Word.

Select Report Iil-‘.:_h]
I | Mame | Show Details
(M| 1000 ‘ CG Segment [3 lead) -

= : : Frinter ... Cancel
110 Strezz ECG Segment [12 lead) — g
11002 Strezz ECG Result Table Dutput
11003 Strezsz ECG Summary Fepart
1004 Stresz ECG Summary Repart " RICOH Aficia 12:
11005 Stresz Stage ECG Complex Summary " PCLA Prinker
D 1006 Strezz Stage ECG Rhuthm Surnmary " PDF File Viewer
11007 Strezz Phaze ECG Comples Sumnmary M5 wiord File Viewe
11008 Stress Phasze ECG Rhwthm Surmmary
11009 Strezz ECG Full Disclosure
oo Strezz Test Trends
11011 Stresz Stage ECG Rhythm Summary (3 1... I+ Use Calor
Ji1mz Strezz Phaze ECG Rhwthm Summary [3 1. |3EID DF| = 300 DFY J
J1m3 Stresz ECG Selected Segments
14 Review Screen
15 Strezsz ECG Summary Report [Europe) Create and View POF File
11018 Strezz Stage ECG Rhythm Summary [Cla. . Only 300 DP! resolution supparted. Only
Om? Strezs Stage ECG Rhythm Summary [Cla... black and white colors available.
1= Strezz ECG Real-Time Report

A list of reports will be on the left side. (For sample stress reports, see Appendix 4: Stress Sample

Reports.)
Show Details Pressing this button will either hide or show printing details.
Printer... Pressing this button with show printer details.
Output Under output you can select which printer you want to print to. Your default

printer will show as the first option (In this example, RICOH Aficio is the default
printer)

PCL5[B68] Printer

Selecting this option with send the selected report to the default printer

PDF File Viewer

By selecting this option, the report will be printed to a PDF file and displayed on
the computer screen.

The Save button from Adobe Acrobat Reader will save the report in PDF format,
which can be printed or emailed by the user, if required.

Note: In order to print PDF File Viewer to computer screen, installation of
Adobe Acrobat Reader 6.0 or higher on user computer is required (also make
confirm that version of Acrobat Reader is selected under
“AUtility\Configuration\Option\PDF”. To confirm, select “Detect”)[B69]

MS Word File

Selecting this option will open the report in Microsoft ™ Word. The save button

CS406-10 Rev F
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Viewer

from Micrsoft work will save the report as a Word file for editing, printing, etc.

Note: In order to view in Microsoft Word, installation of Microsoft Word on user
computer is required.

Use Color

Selecting this button will allow user to print ECG reports in color depending on
printer options.

7.3 Reviewing a Stress Test

To view or edit a stress test, go to the Master Screen and select the desired Stress ECG

Test and click the button [ 0w on the toolbar

OR

Double click on the test to be viewed.

+

+

+

1z7izons | dafa, | 1212(1)
2712005 | dddfadf, | 1212(1)
1z7izons | sdadD, [ 121(1)
,;;E Stress ECG 1)27)2005, 10:27 PM
lzrizoos |} st1(1)

Stress ECG Dataview Screen

The test record will be displayed in the QRS-Card™ Cardiology Suite Stress Dataview

screen.

This screen allows the user to:

CS406-10 Rev F

View/edit patient data
View test data
Print reports
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7.3.1 Edit
est - Artificial Patient (8/26/2011, 11:48:12 AM)

Select ‘Edit’ to view or edit information about the patient.

Patient Screen
- In this area users can edit patient demographics

Test Screen
- Contains additional patient information.

Medication Screen
- Contains patient medication information.

Signal Screen
- Contains information on how the ECG was obtained such as the sampling and use
of filters. In this tab, you can also change Blood Pressure Information.

[61]
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7.3.2 View

Stress Test - Artificial Patient (8/26/2011, 11:48:12 AM)

H Save @ Help

Report

Sumrmary

E

Strips ]

l Cornples

Page

Select ‘View’ to review (and edit) acquired Stress Test ECG data in various formats.

Page Screen

The Page screen shows a full disclosure view of the complete stress test. The example below shows the

default view. As you can see, the ‘Rhythm’ button is selected and the rhythm view is shown below the

‘Full Disclosure’ View.

[l Stress Test - John Beighley (12/11/2009, 11:02:25 AM)

View Summary é_;;j Report H Save @ Help

Page \ Complex | Strips |

putinos
i)
b
AR

P

60
186 /99

\ VAP Y0 P PRI

0:00 0:0
1.0 METs 0:0
PP PR P P PR
HT

Pre-Test
Supine

[11d

0:00

ol

| U PR PR P PN P
R0 T

Al L LA L

=] [Smmmy~] [15m <] Efrnynm [zzimend [C]repor

)

Lt i

I

|

K

i)

]
|

1e

B B A
L L

LI

i

L.
0

1 O B

80 A

AR A

0 . 0 A
LIl

SRR AN

0N P 0

) ) A O M

1 6 1 0 8 6 T

5 A T T 1
. 0 A 0 O A S

Wi

0 9 T 0 T T O

i N A

|

Vbbb L Ll L L b b bl L L L L L L L L

]

6 A B AR
[ LT

1 L A A

A 0 1 O e O P 0 A P 1 B A

0 0 0. 0 0 Y 5 0 o O 1 0 O 0 A W A

A e R e

00 8 A 0 0 0 A T A 1 A

LA 000 A 4

LU TR S TR 008 L T8 8 00 40 ) 8 i U R U T e i 8 U ik i T e i e T

= Select @Gnd L L

1
(e

Print

=

10 mmm ~| | |25 mn ~ Ng\mus 555 Measure

0:00

oA

| 83 | 62 | 63 | 83 | 62 | 62 |

B3

| 82, |

63

| 83 [ 83 | 65 | 64

63

b

StressProcedure

[KB70]
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) B =5 Trend Report
By Pressing 22" or = o IZ' P buttns, user can see Rhythm data, Trend

Data or a view of the Report in conjunction with the page/full disclosure ECG data. The
example below shows the expanded view (if Rhythm button, Trend button and Report
button are selected.)

" StressTest - (9/9/2010, 4:33:35 PM) =OAEl X

bk =
%Edﬁ Lk iewy Summary é:fa Report H Save @ Help
Pty : =

Page } Complex ] Strips I

0:00 [ -] [mmimv=] [15m -] EZrnm | R rend [E]r

1 O T O 0 O D 1 W W I N W NN

SRR RN RN RN AN RN NN RN AR RN RN RN RN IR RN RN AR AR

12:22 10 mmjm ~| | |25 mn~ AJU (8| = | sT |0 ~|||sTED
1R0 120 1o 1o 1po 21p |
1 E N 1 ENER .1 I

T

STe mm
5-3-11 28

' 0:00  9:00 18:00  27:00 36:00
olic — Diastolic — Speed

=

;;{S W
=0 @
£d i
Y] g
us 5
io £
-] = &
& 000 900 18:00  27:00 36:00 4

StressProcedure
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Complex Screen

The Complex Screen shows average complexes during different stages of the Stress Test.
The example below shows the default view. As you can see, the ‘Rhythm’ button is
selected and the rhythm view is shown below the ‘Average Complex * View.

[ Stress Test - John Beighley (12/11/2009, 11:02:25 AM)
ek A =
Gﬁ&m T View Summary é:;a Report H Save @ Help
. A
Page  Complex } strips |

0:21 | Mo mmgm =] | [25 mmps = 4

=== Trend |:|R=pur:

Pre-Test [ ] [T avR avL avF Vi V2 V3 V4 V5 ' 13
Supine ) - w1 oo 0.1 oo os os 10 o Y .1
p a3 1z 0.2 080 023 -1.08 015 063 102 051 050 s =
1.0 METs
0:08 L ‘L JLA 0
63 T\, T\,
166 7 98
Pre-Test 1 n m avR avL avF Vi1 V2 V3 w4 V5 V6
Hypervent S S S g om “ror o33 0% ose s A %
1.0 METs
o L L JL/\
166 7 98
Pre-Test 1 n 1] avR avL avF Vi V2 V3 V4 V5 '3
LAz, [N S0 A1 .1 0.1 L} 0.1 0.5 L2} 1.0 00 0.1 0.1 i
0:21 [lommim <] [25mn~]| . jZteass 7 Measure Fyprimt [lselect | EEGia Qrm| HE63
CE] 62 | 62 | 62 ‘L/\u 64 | 63 | 63 | 65 | 83 | 63 | 62 | 82 | €6 | BF | 65 | 65 | 65 |
L L AL LA L L AL A L LA L L AL LA LA L LA LA LA LA LN
V “

StressProcedure
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e hegthim

Report

== Trend
I or

buttons, user can see Rhythm data, Trend

Data or a view of the Report in conjunction with the Average Complex view. The
example below shows the expanded view (if Rhythm button, Trend button and Report
button are selected.)

) StressTest - (9/9/2010, 4:33:35 PM) [E=R >
kel by = -
Gﬁmﬂ BRI View | summary @ Report H Save @ Help
pivetviriind : = |
Page  Complex | Strips |
g T =
101 |1l] mmfm;] |25 mmy{s L] e |%Trend iReport
Pre-Test| ] ] avR avL avF w1 v ks
— 100 e e i B S B SRR
‘g Rk gl i 1.0 METs i E
B : 0:50
= 123788
= Pre-Test| I [T avR avL avF V1 V2
Hypervent o, iy o By oz by 0z o83
1.0 METs
0:05
143 7 77 i
Pra-Tast] 1l ] avR avl avE V1 B R
‘ 1:01 [1Ummm =] | [25mn=] | ) [1ommm <] [25mn~]| =] |[sT60 <]
|75 |75 |75 |
L]
Irll I'l\r JlIr ﬁr E ] I
o
1=l
wm
&
IR et At s T ' p:00 9:00 18:00 27:00 36:00
: igfgtullc — Diastolic — Speed %
1 B
Y] g
IS A P ug ;
io 8o
oo =] &
L3 & 00 gm0 18:00  27:00 36:00 2
StressProcedure A
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Strips Screen

Shows:
a. Automatically Selected Arrhythmia Strips
b. Stress Event Strip (e.g. every minute save for Bruce protocol)
c. Custom Save/Annotated Strips.

The strips shown with time stamps highlighted in yellow are the ones that are marked to
be printed. These strips can be marked and unmarked by using the tool bar buttons for
marking/unmarking. [B71]

-
B Stress Test - (9/9/2010, 4:33:35 PM) o | B

bl Sl b
Gﬁsdh T view | [ Summary éj Report H Save @ Help
b N
Lk

Page ] Complex  Strips l
L) zatly
,\J‘;\Leads ﬁl‘v‘larkml Hﬁclearml %Toggle %Showml %&Showl\«’larkad ﬂﬁshowUnmarked CE?A,.A,.J\'\dt:iStrip l=_:l,.A,.UpdaI:eStr\p Ia.A..De\eteStr\p

Event | Total | Mark... | Time | Prematurity (%) ‘ Duration |
1s

1:41 1% 15
j’-,%?_lr-ﬁ"' B7 |67 |67 |67 |67 | 67 |67 | 66 | .67 j—mlr._ e |67 | 67 |

e

S¥YT 1 1

Stress Protocol 26 26

StressProcedure
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7.3.3 Summary

B " Stress Test - Artificial Patient (8/26/2011, 11:48:12 AM)

adecedee el =
Gm;:d'rt ok View Surmmary é‘t_,a Report H Save @ Help
alalnlalal

Summmary ] Tahle Interpretation l

This selection is used to review Stress Test Summary Data. This data include Stress Summary,
Table Data for Stress Test and Summarized Stress Test Interpretation.

Summary Screen

Shows summary information of stress ECG test and the reason for the termination of the
test (user can overwrite information in the ‘Reason for termination’ box).

B Stress Test - (9/9/2010, 4:33:35 PM)

Aol —_ -

%Edi‘t Beldk View Summary é_ja Report H Save @ Help
ethott A
AR

Surnmary } Table 1 Interpretation ]

Pratacol Bruce TargetHR 180 Device  Treadmil
I Test Times Resting M axima

Pre-Test 1:38 HR 1] HR 50%: 90 @ 1:52
Exercise| 10143 BP 111478 BFP 143/77 @ 1:08
Recovery| 2228 RPP RFFP 10980 @ 13:36

Total| 3451 METs 135 @12:22

Artifact .00 Speed 42@12:22

Load 160 @ 12:22

Significant 5T change:

> 1 mm

Marimum STe 0.6 mm (2 1:01 1]
<1mm

tdinimum 5Te 0.7 mm & 1:17 [v4]

Reazon for temmination
Protocol Complete

StressProcedure
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Table Screen

Shows summary information from stress ECG test in a tabular format.

r o
W7 StressTest - (9/22/2010, 11:16:29 AM) [T

Qm‘m R View ‘ Summary H o | @ Help
forchimnd |

Summary  Table |Interuretaum |

Phase | Stage | Start | Durati... | METs | Speed [ Load | MaxHR | %THR | BP | HRBP |1 |m |m |awr_ [avt [aF (v v v v v v |
PreTest  Supine  0:00 [000] 058 10 0.0 00 73 a1 130/92 9490 05 10 04 07 00 7 18 27 15 01 04 02
PreTest  Warm-up 059 [059] 010 21 14 00 %2 51 03 00 04 0l 03 02 11 31 24 08 05 01
Beercise 1 109 [000] 300 47 17 00 104 58 00 05 04 02 02 05 06 10 11 00 02 02
Brercise 2 410 [300] 058 71 25 120 106 59 04 45 50 20 27 47 |15 |27 (32 [11 (15 |15
Recovery  Cool-Do. 008 22 15 00 110 61 03 47 50 22 21 49 26 24 25 11 14 18
Recovery  Cool-Do. 02 10 00 0 110 61 10 130 141 60 75 136 38 29 40 21 44 56
Recovery ImmPE 538 [029] 130 10 00 00 121 67 150/84 18150 01 02 01 02 00 2 03 07 08 00 02 04
Recovery  LSMPE 708 [159] 130 10 0.0 00 125 69 02 00 03 0l 02 01 06 06 02 02 04 05
Recovery ~3MPE 838 [329] 129 1u u.n uu 131 73 03 rm rm u.4 70‘1 ru.a u9 0‘9 u‘s ru‘a ru.r ru.r
Re:overy 45MPE 1008 [459] 130 0.1

lam:-m-m-m-la_——-mmm-m-m-m

11:50 | 10 mmym ~| | [25 mn - AJ.}:L:ads ?%Maasule @Prim Eﬂmm ‘ Gnd 1'HR‘ HR: 89
| 82 | a5 | 85 | a7 a5 93 | 84 [F] a2 88 89 a0 87 an a1 88 | 89 | 88 | 87 | 87 | 88 | 85 | 86 | 87 | 84 [ 85
[
ISR s A
?-‘f“,dﬂ.
(V2
V)
4 ™ b
StressProcedure Y
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Interpretation Screen

- provides computer generated Automatic ECG Interpretation. [B72]Interpretation
can also be edited by typing free text or accepting statements from the Statement
Library. For the Automatic Computer Interpretation to work in the Resting test,
this option has to be selected in the Resting Setup.

- To add statements from the statement library, select the statement desired and
click on the arrow to transfer it over to the Physician's Interpretation box.

- In a view-only box at the bottom of the screen, the date and time of the computer-
generated interpretation is displayed. The name of the analyst who overread the
interpretation and the physician that confirmed it, along with the date and time,
can be entered in the applicable boxes.

M Stress Test - Miller, Kevin (3/14/2005, 7:25:04 AM)

2 P 7 >

%Edit U iew ﬂ Summary \‘;a Repart @ Help
S

Summary } Table Interpretatiun}

Physician Interpretation Statement Library

test exercised on a Treadmill (Simulated Treadmill] for 1:43 minutes. The total exercise time
wag 0:00 minutes during which the patient acheived a maximunn heart rate of 70 BPM, which
was 39 % of the age predicted target heart rate of 180 BPM

The patient test's masimum exercice effort was 0.0mi /b, 0.0 % grade [ 1.OMETS]. The
maximum blood pressure was 178 / 67, The maximum double product was 12460,

The patient test's ECG showed 8 leads with ST elevation variation greater than 1 mm. These

The patient test's ECG showed 1 leads with ST depression vaniation less than -1 mm. These
are aF. The masimum ST depression vaniation was 1.0 mm & 0:17 [2WR]

are 1, 111, &WF, W2, %3, %4, W5, V6. The maximumn ST elevation variation was 2.4 mm @ 0:17
¢

# &= Momal#abnomal

i) &= Ventricular Hypertrophy

&= Myocardial Infarction

# {= Conduction distubances

&= Other QRS marphology o general descr
i) &= Statements related to impulse formation |
= Sinus node dysfunction, atrial and &¥-cc
) &= Statements related to ectopic thythm abr
) &= Statements related to [predominant] con
) &= Pacemaker lypes and pacemaker functi

i) &= other thythm ielated statements

) &= Desciiplive axis statements

) &= 5T-T descriptive stalements

# {= ischemic ST-T changes compatible with
# {= ST-T changes compatible with subepice
&= non-specific ST-T changes allemative
i) &= other 5T-T descriptive statements

@ + §= Atrial statements
) &= Statements related to pediatic ECG ana

+ = Statements related to the ECG calibratio
% <= Technical problems

Computer Interpretation

Kevin Miller exercised on a Treadmill (Simulated Treadmill] for 1:49 minutes. The total exercise &
tirne was 0:00 minutes during which the patient acheived a maximum heart rate of 70 BPM,
which was 33 % of the age predicted target heart rate of 180 EPM. 3

Original Aeport [not ovenead)

< >

Owenead Report [hot confimed)

|aRS Card Cardiology Suite (Enu 4.00) I Analyst -

342005 | | Basa0PM =

Canfirmed Report

I Physician -

[[3reos <] | sasaoPm =

QRS-Card™ Cardiology Suite can provide automatic computer
interpretations. A computer generated interpretation cannot replace sound medical
reasoning by a trained professional. Therefore, a physician should always review the
interpretation and final analysis should always be obtained by a Physician.

Proper administration, diagnosis and implementation of the test is the Physician’s
responsibility.

[69]
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Updating Custom Dictionary

By clicking the icon in the Interpretation screen, user can update the custom
dictionary.

i B
LCancel |

Heb |

Update Custam Dictionary

normal ECG
narmal GRS
normal P wave
normal 5T-T
ECG within normal limits far ag
possibly narmal ECG
haorderline ECG
abnormal ECG
possihly abnormal ECG
abnarmal QRS
ahnormal ST-T
normal for age
normal for build
abnarmal far age
abnaormal far build
unusual for build
®
M

) el B el e el el el =i e =i et e e el e =i =24

Mormaldabhormal

Edit Instructions

Left Click any button to edit text.
Remowve all characters to hide a button.
Those buttons displayed with a red "X" will be hidden.
Press 'OK' to save changes.
Press 'Cancel’ to discard changes.
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7.3.4 Report

QRS-Card™
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Clicking the “Report” button allows users to select reports to be printed, PDF reports to
be created or the report to be viewed in Microsoft Word (See Appendix 3 for Sample

Resting Reports).

(For sample stress reports, see appendix 4: Sample Stress Reports.)

Select Report - l_I_J‘EP . S
D | M arne | Shaow D etails
M| 1000 z ECG Segment [3 lead) :
= - : Frinter ... Cancel
110 Strezs ECG Segment (12 lead) — g
11002 Strezz ECG Result T able Output
11003 Strezz ECG Surmmary Feport
1004 Stresz ECG Surnmary Feport f* Kyocera EP C3200N
11005 Strezs Stage ECG Complex Summary (" PCLS Prinker
11008 Strezz Stage ECG Rhwthm Sunmary " PDF File Wiewer
11007 Strezs Phasze ECG Comples Summary WS word File Viewer
11002 Strezs Phasze ECG Rhythm Summary
1009 Strezz ECG Full Dizclosure
[J1ma Stressz Test Trends
1101 Strezs Stage ECG Rhwthrm Summany [31... | Use Calar
Oz Stresz Phase ECG Rhuthim Summan [3 1. |3I:IEI DF| « 300 DFI ﬂ
13 Stress ECG Selected Segments
104 Review Screen
[J1ms Strezs ECG Summary Report [Europe] Print Using Kyocera EF C3200M
[J101s Strezs Stage ECG Rhythm Summary [Cla... [ 32 PPM, 262144 KB, HPGL. ]
C1m7 Strezz Stage ECG R hwthm Summary [Cla...
HRIGE] Stress ECG Real-Time Report Frinter has color printing cabability. Printer
permitz 1 resolutions: 600 DPI « 600 DFI.
Show Details Pressing this button will either hide or show printing details.
Printer... Pressing this button with show printer details.
Output Under output you can select which printer you want to print to. Your
default printer will show as the first option (In this example, RICOH
Aficio is the default printer)
PCLS5 Printer(s73] | Selecting this option will print the reports to default printer
PDF File Viewer By selecting this option, the report will be printed to a PDF file and displayed on
the computer screen.

CS406-10 Rev F

[71]
Pub: 2013-07-16



QRS-Card™
A PBI 4.06 Cardiology Suite Operating Instructions

The Save button from Adobe Acrobat Reader will save the report in PDF format,
which can be printed or emailed by the user, if required.

Note: In order to print PDF File Viewer to computer screen, installation of
Adobe Acrobat Reader 6.0 or higher on user computer is required (also make
confirm that version of Acrobat Reader is selected under
“AUtilit)\Configuration\Option\PDF”. To confirm, select “Detect”)[B74]

MS Word File Selecting this option will open the report in Microsoft ™ Word. The save
Viewer button from Micrsoft work will save the report as a Word file for editing,
printing, etc.

Note: In order to view in Microsoft Word, installation of Microsoft Word
on user computer is required.

Use Color Selecting this button will allow user to print ECG reports in color
depending on printer options.

Save Button

Reports can be saved if modifications are made.
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8. Holter ECG Module

The QRS-Card™ Cardiology Suite offers advanced Holter ECG technology with many
standard features in one package. By using advanced analysis techniques QRS-Card™
Cardiology Suite provides accurate results that can be systematically reviewed with
minimal technician involvement. [KB75]

Standard features include:
* Accurate arrhythmia analysis
* Preset artifact detection
* Simple user interface
* Fast load and analysis
* Color coded beats and trends
* Full disclosure (24 or 48 hours)
* 3-channel ST analysis
* Split-screen superimposition
* Multiple report formats
* Multiple format page mode
* Network compatibility

Optional features include:
* HRV (Heart Rate Variability) analysis
* 12-lead ECG analysis
* Pacemaker function analysis
* QT analysis

The best way to get a good quality ECG is for the administrator to be properly trained, to
prep the patient correctly and to reduce artifact/noise. [B77]

Once you have the patient prepped and the electrodes securely attached you can begin a
Holter ECG test.[B78]

See ‘Holter Hardware’ user guide for information on how to begin the test. Once the
patient returns, remove memory card from Holter recorder and place in the card reader
attached to your computer.[B79]
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8.1 Holter ECG Setup and Download

The Holter Setup screen is used to define settings for downloading a Holter ECG Test. It
is recommended that before downloading your first test, you define the setup.

Holter ECG Setup can be accessed three ways:

¢ From the Master Screen select File > Holter > Setup OR

e Simultaneously press CTRL + F5 OR
D
. . gl
¢ (lick on the Holter ECG icon.

(If the "Show This Window" option in the Holter Setup has been selected,
the Holter Setup screen will automatically be displayed. )

r 3
Configure Holter et = ﬁ
0 [raemar DXP 1000 -
- C Brow
F‘.emrdl e:\braemar.res Browse Cancel ]
¥ show this window [v Enter patient demograhics
- After Reading Data from the Recorder
¥ Exit  Edit " Print
e | Episodes Initialize
Recorder

Default Report | ID ] MName ] -
D 13000 Huolter ECG Summary Repart
[[J13010  Holter ECG Result Summary Repart
13011  Holter ECG Result Summary Report B =
[[]13020  Holter ECG Hourly Summary Report
[[113030  Holter ECG Trend Repart
[[J13040  Holter ECG Selected Segments Report -
[J13041  Holter ECG Selected Segments Report e
[J13050  Holter ECG Full Disclosure Report
[J13070  Holter ECG Result Summary Report (pa... - Reset

J
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Device

Select the device you have recorded Holter ECG data with. Options

include:

- Braemar DXP1000 (also used for Braemar DLL800 and Braemar
DL900)B30]

- Cardioline File Importer

- Datrix DR512 VX3 (128 Hz)

- Datrix DR512 VX3 (224 Hz)

- CardioRemote Holter

- Rozin File Importer

Record

Use this option to select file you are downloading from. To select a
different file, click the ‘Browse’ button.[Bs1]

Show this
Window

If selected, the Holter Setup window will display each time you are
downloading Holter ECG tests.

Enter Patient
Demographics

If selected, the Holter ECG Patient Information dialog box will
appear during Holter ECG download.

After Reading Data from the Recorder:

Exit If selected, the QRS-Card™ Cardiology Suite master software screen
will be displayed after download.

Edit If selected, the Holter test will open for editing after it is downloaded.

Print If selected, default reports will be printed after it is downloaded.

Beats Opens the Configure Beat Detection dialog box. There are 3 tabs,
Noise, Beat Detect and Pacemaker.[Bs2)

Episodes Opens the Configure Episode Detection dialog box.(Bs3]

Default Report | Specifies the type(s) of final reports to be printed automatically after
the Holter test is completed.

Initialize Patient data can be uploaded to the recorder. (Note: Only if recorder

Recorder supports this option)

Demo Allows user to download a demo Holter ECG test.

Reset Resets setup to default positions.
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When finished defining setup, click ‘Ok’ to begin downloading Holter ECG data.

9 Read Dita from Hotter Recordee D l=|=] =8

Downloading user events from device.

® ' Read Data from Holter Recorder -_ Em

Press '"0OK' when data entry complete.

]

Patient | Test | Medication |

- |dentification
ld|DEMD Browse |
Last |£utificial Patient First
Date of Birth | MG
b Ad Ay
Address
Street
City | State | Zip
[
Telephone I r

Enter patient information by filling in the ‘Patient’, ‘Test’ and ‘Medication’ tabs. Click
‘Ok’ when complete.

Holter will download and be saved in the Test Database.
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8.2 Reviewing a Holter ECG Test

To view or edit a Holter test, go to the QRS-Card™ Cardiology Suite Master Screen and select

“"lon the toolbar

the desired Holter ECG Test and click the button
OR
Double click on the test to be viewed.

=1 | Holter ECG (3)

' ﬁ DL900 12HR : 512 sample rate, jason @ 4/21/2009, 5:02 PM
iZp "1234 : Miller, Joanne : 7/26/2005, 9:46 PM

.39 DEMO : Artificial Patient, : 4/13/2004, 8:37 AM

The test record will be displayed in the QRS-Card™ Cardiology Suite Holter ECG Dataview
screen.
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8.2.1 Edit Tab
G -

(Wednesday, August 31, 2011, 5:27:00 PM)

-
Summary i%&pert é:;_!,a Report H Save @ Help

Select ‘Edit’ to view or edit information about the patient.

Patient Screen —
- in this area you can edit patient demographics

Test Screen —
- Contains additional patient information

Diary Screen-
- Used to add or remove strips to the patient diary

Medication Screen —
- Contains patient medication information

Signal Screen -
- Contains information on how the ECG was obtained such as the sampling and
use of filters. In this tab, you can also change Blood Pressure Information.
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8.2.2 View

® ' Holter ECG - esday, August 31, 2011, 5:27:00 PM)

Select ‘View’ to review (and edit) the Holter Test ECG data in various formats.

The View Holter ECG module has been divided into different categories (Beats,
Episodes, Page and Strips) to allow for easy navigation and reclassification of the Holter
ECG data.
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Beats Screen

] |

R

10520 o] [sms] N VS B P By By

51 Holter ECG - Artfcial Patient (Sunday, June 13, 2010, 837:13 AM) i ( 5 =
=
%[«m oo Summary fKTmls é}j Report H Save @ Help
Ae Beats |44 Eckocks | Page |3 stes |
Naw Viz| S Bo Pio Po By 2 Fu\lS(vn:n
92182 ‘ ‘ ‘
A Bins

X | o o e Fumet (Zsdet Bscon [Hhview & Measwe [lloris| §Prr
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A e A Rhythm Edit Screen MAJ[J\JJMJ

LJ\/\M\.«WM M—L\MM

- | E— L s
& HolerProcedure

Beats are automatically classified according to the QRS-Card™ Cardiology Suite
software algorithm and are defined as follows:

o N = Normal

. V = Ventricular Ectopic Beats

J S = Supreventricular Ectopic Beats

. B = Aberrant

B Atrial Paced

o Pw.r = Ventricular Paced

. R’u‘ = Atrio-Ventricular Paced

. = Beats that are in segments too noisy to process (artifact)

Bins are displayed below which allows the user to view all similar beats within a single
template as a group and the beats from the selected Bin are displayed in the Rhythm Edit

Screen.
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To reclassify beats

1. Select the beat(s) from the Bins that you want to reclassify in the Rhythm Edit
Screen.

To select a single beat click on the R-wave. To select multiple beats drag the R-
waves that you want to include.

2. Click the desired reclassify button that you want the beat to be reclassified to.
3 The Selected beat(s) will be reclassified (or deleted if you clicked on A or X)

: Click to Toggle between
View single / Multiple Beat view

S mIN VSBPERRBRBAX| o oA Dpne Hyrnt (Ssoe Flow

| mz2 [ 3 | ma [ na | ma [ s | s | 115 | w6 [ 6 [ 6 [ 16 | 2 | 16 If‘

e ey e s T

0 T e, v Y e T A e
m| 1

[B84]
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Reclassify Multiple Beats

The beats can be viewed in multiple view mode also.

To reclassify multiple beats

1.
2.
3.

Select the template class (VE, Normal, SVE, etc.).

Select the desired bin.

Click view button to Toggle view single/multiple template beats in the Rhythm Edit
Screen.

Select the template beats you want the edit by clicking on multiple beats or clicking
Mark Row, Mark Page, Mark All.

Click N, V, P, A, S, B, or X to reclassify the beats.

The selected beats will be reclassified and the Rhythm Edit Screen will be updated
with the remaining template beats in the selected Template pane.

X Click to Toggle between
View single / Multiple Beat view

ixed iom] f5sd] NV S BERRRAX| -~ o Bk Bl Gwn (oo |
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I N[N N 2000 2 20 21 200 1) 2 8
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[B85]
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Episodes Screen

Ml Holter ECG - Mrs, Tahira (3/29/2004, 7:49:00 PM) § =18 x|
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The Episodes Screen enables the user to review ECG data through the R-R interval
window and the trend window. Data in both windows is synchronized with the Rhythm
Edit Screen as the user highlights the data.

As the ECG data is analyzed the Episodes are evaluated against predefined criteria and
are stored in the following categories:

= Fastest Rates

= Slowest Rates

= Bradycardia

= Pause

= JIsolated VEB
= VEB Pair

= VEB Run

= Bigemny

= SVEB Pair

= SVEB Run

= Recorder Episode
= STe Abnormalities
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To reclassify Episodes

1. Select the Episode(s) from the Episodes list that you want to reclassify in Rhythm
Edit Screen

To select a single Episode click on the R-wave. To select multiple Episodes drag the
R-waves that you want to include.

2. Click the desired reclassify button that you want the Episode to be reclassified to.

The Episode(s) will be reclassified (or deleted if you clicked on A or X)
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Reclassify Multiple Episodes using R-R Interval Histogram

To edit multiple Episodes using the Episode R-R Interval Histogram

1. Inthe

Episode List box select the Episode type that you want to edit.

2. Drag the Episodes in the Episode R-R Interval Histogram to select the range of R-R
intervals to edit.

3. Click Toggle to view multiple Episodes in the Rhythm Edit Screen if it isn't already.

4. Select the Episodes you want the edit by clicking on multiple Episodes or click
Mark Row, Mark Page, or Mark All

5. ClickN,V, P, A, S, B, or X reclassify button to edit the Episodes

The selected Episodes will be reclassified and the ECG Edit window will be updated

M *** Holter ECG - , (3/17/2004, 11:18:00 PM)
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Lessons — Reclassify Multiple Episodes using Trend Screen

To edit multiple Episodes using the Event Trend

1.

2.
3.
4

In the Episode List box select the Episode type that you want to edit.

Drag the episodes in the Episode Trend to select the time period that you want edit.
Click Toggle to view episodes in the Rhythm Edit Screen if it isn't already.

Select the template beats you want the edit by clicking on multiple episodes or click
Mark Row, Mark Page, or Mark All

Click N, V, P, A, S, B, or X reclassify button to edit the episodes.
The selected episodes will be reclassified and the ECG Edit window will be updated

[ Holter ECG - AMANULLAH, (6/16/2004, 2:48:00 PM) - =18] %]
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| ‘*m B view ilsumma'v g'{Tods &Rmt @
| bk o <

933 ms, 12 Events

:er:\;w fi :E
it
| .m.ﬂ_llijm|”““ihh”l]lilmllslm.ﬂll\Il1ll|l|.h|ll“|lhl‘1i11!_
:m o ;~m R-R Interval ( ms ) _'J
— ) J PP [ 2:15AM[2)-5:09 AM [2). 78 Events | |
g: MJM.L......L“. " ..M..\laluh Lol k L, 1 ESERRENET .ml...i IL mu..lh.\ Hl\ll‘.uh‘hﬂmhL’H‘Lul..
Pause 16 ;J : 2:48 PM (1) 0:48 PM (1) 10:48 PM (1) 2:48 AM (2) 6:48 AM (2) 10:48 AM (2) z:48 Pllu).
Eeu e fime s N VS BB R By A X| 2 o Ao Gone S (50 fef e
- | 35 | 64 | 73 74 74 75 il
g
A\
fA
o o
| HokerProcedure

[86]

CS406-10 Rev F Pub: 2013-07-16



QRS-Card™
A PBI 4.06 Cardiology Suite Operating Instructions

Lessons — To Delete all Episodes of one Event Type

To delete all Episodes of one Episode type

1. In the Episode List box select the Episode type that you want to delete.

2. Drag all of the Episodes in the Episodes R-R Interval Histogram or Episode Trend.
3. Click Toggle to view multiple Episodes in the Rhythm Edit Screen if it isn't already.

4. Click Mark All.
5. Click X to delete beats and the template
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Lessons — Strips Screen Functions

The Strips window contains the following controls:

Strip category List Box
Boemny 10 The Strips list box is located above the ECG Data View
é:;;;""-v ,3;3 E window. The list box displays ECG strips from the
B following categories:
VPB, VPB Pair, VTAC, SVPB, SVPB Pair, SVT,
Pause/Asystole, Patient event, Selected strips, STe
fo - deviation, Tachy/Brady, Fast rate, Slow rate.
Teony T

Maximum HR 95 1
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Display Strips

These control which ECG strips are displayed in the Strips mode.

- All - Use to display all strips for a category.

- Marked -Used to display all marked strips from a category.

- Unmarked - Used to display all unmarked strips from a category.

e nd k. = m . | "t )
Emr«amﬂ Hﬁcbarﬂl %Tme 2 show Al %Shwmkﬂ igﬁsrmwunmarmd ke dd Strip ?L-Lu;-datesmp %.t.c:\alesnu

. e s [ . Il "zt @
Emr«amﬂ Hﬁcbarﬂl %Tme 2 show Al %Shwmkﬂ igﬁsrmwunmarmd ke dd Strip ?L-Lu;-datesmp %.t.c:\alesnu

Mark / Unmark Strips

These control which ECG strips are marked or unmarked. Marked strips are included the

Holter report. When a strip is selected (marked) it's start time is highlighted in yellow.

- Mark All - Used to mark all strips in a category.

- Unmark All - Used to unmark all strips in a category.

- Toggle - Used to Mark or Unmark the current highlighted strip. Click on a strip to
highlight it.

Strip sorting criteria
These controls are located above the top-most ECG strip. These are used to control the

order that strips are displayed in the window.

- Time - Used to sort the strips in chronological order.

- Prematurity (%) - Used to sort the strips according to the degree of prematurity.
- Duration (seconds) - Used to sort the strips according to the strip duration.
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Page Screen
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The page screen shows another view of the Holter data.

To edit multiple beats on Page screen
1. Drag the beats on the page window that you want to edit.
2. Click N, V,P, A, S, B, or X to reclassify the beats.

The selected beats will be reclassified and the Rhythm window will be updated.
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Strips Screen

M Holter ECG - Mrs, Tahira (3/29/2004, 7:49:00 PM) =18 x|
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The Strips screen allows the user to review and select which Episodes should be printed

in the selected report. Strips are displayed in the following categories:
e VPB

VPB Pairs

Bigeminy

SVPB

SVPB Pair

SVT

Pause/Asystole

Patient Episodes

Selected Strips

ST Episodes

Tachy/Brady

Fast rate

Slow rate
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8.2.3 Summary Tab

General Screen

B’ Holter ECG - Artificial Patient (Tuesday, April 13, 2004, 8:37:13 AM) ‘ -
- - -
ook \7“I
%Ed'ﬂ R View Summary %apen é:?a Report H Save @ Help
el Ak L !
General 1 Supraventricular I wentricular ] Supraventricular Runs ] Ventricular Runs 1 Bigerniny 1 Tachy / Bracly 1 Atrial Fibrillation 1 Paced ] ST ] Interpretation I
General Interval Table
Start Time | Min.HR ‘ Avg.HR ‘ MaxHR ‘ Total Beats | Total SVPB ‘ Total VPB | Pauses | Time Analyzed |
@ 837 AM (1) 64 69 74 1561 0 0 0 22:46
@ 8:50 AM (1) 64 70 109 4201 0 1] 0 58:58
@ 9:59 AM (1) ] 73 a7 2683 0 1] 0 37:36
.
Supraventricular Screen
Holter ECG - Artificial Patient day, April 13, 2004, 8:37:13 Al ‘ -
B | Holter ificial Patient (Tues =y e - I\ﬂ
A ) -
Gmgmt R View Summary %hpen ﬁﬁ Report IH Save @ Help
Py a— il T
General Supraventricular \ wentricular ] Supraventricular Runs ] Wentricular Runs 1 Bigerniry 1 Tachy / Bracly 1 Atrial Fibrillation 1 Paced ] ST ] Interpretation I
Supraventricular Interval Table
Start Time | Total Beat | Total SVPB I Single SVPB | Paired SVPB | SVT Runs | SVT Beats | Aberrant | Time Analyzed |
® 837 AM (1) 1561 0 0 0 0 0 0 22:46
@ 8:59 AM (1) 4201 1] 1] 0 0 0 0 59:58
@ 9:59 AM (1) 2683 1] Q 0 0 0 0 37:36
.
Ventricular Screen
Holter ECG -  Artificial Patient day, April 13, 2004, 8:37:13 Al ‘ -
B ' Holter ificial Patient (Tues: ayl-pr\ e hﬂ
st -
Edit S5 View Summary (RS ER é i Report H Save @ Help
ool b 4 A
General 1 Supraventricular wentricular 1 Supraventricular Runs ] Wentricular Runs 1 EBigernirry 1 Tachy / Brady 1 Atrial Fibrillation ] Paced ] ST ] Interpretation I

Ventricular Interval Table

Start Time | Total Beat | Total VPB | Paired V... | VT Beats | BiBeats | Tri Beats | Qua Beats | Time Analyz... |

@ 8:37 AM... 1561 0 0 0 0 0 0 22:46
@ 8:58 AM... 4201 0 0 0 0 0 0 59:58
® 9:50 AM... 2683 0 0 0 0 0 Q 3736
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Supraventricular Runs Screen

B | Holter ECG - Artificial Patient (Tuesday, April 13, 20M£:37:13 Alﬂ ‘ -
-

by -
%Edﬁ W View Summary f’//{&(perﬁ éj Report H Save @ Help
b =
ettt

General] Supraventricular ] Wentricular

Supraventricular Runs I Wentricular Runs ] Bigeminy } Tachy [ Brady } Atrial Fibrilation ]Pa[edl ST }Interpretatiun]

Supraventricular Runs Interval Table

Start Time  [3<120  [4<120  [5<120 | 69<120 |10+<120 [3>=120 [4>=120 | 5>=120 | 6-9>=120 | 10+>=120 | Time Analy... |

@ 837AM .. 0 0 0 0 0 0 0 0 0 0 22:46
® 859 AM .. 0 ] ] i} ] i} 0 0 0 0 59:58
® 959 AM .. 0 ] 1] ] ] ] 0 0 0 0 37:36
Ventricular Runs Screen
B ' Holter ECG - Artificial Patient (Tuesday,-ﬁpnl 13, 2004,‘8:37:13 Mﬂ ‘ -

adedaledeunke \_"I
Edit i View Summary [T ‘iﬁ Report H Save @ Help
prvtharem N

General I Supraventricular I “entricular ] Supraventricular Runs Wentricular Runs l Bigeriry I Tachy / Bracly 1 Atrial Fibrillation 1 Paced ] ST ] Interpretation I

V¥entricular Runs Interval Table

StartTime  [3<120  [4<120  [5<120  [6-0<120 [10+<120 [3-=120 [4>=120 [5»=120 | 6-9>=120 | 10+>=120 | Time Analy... |

@ 837AM.. 0 1] (1] 1] 1] 1] (1] (1] 0 0 22:46
@ 88AM.. 0 Q Q Q 1] Q Q Q 0 0 59:58
@ 258 AM.. 0 0 0 0 0 0 0 0 0 0 336
Bigeminy Screen
B " Holter ECG - Artificial Patient (Tuasday,..Apnl 13, 20M£:37:13 Ahﬂ ‘ -

Aok ‘_-"I

Qm.m R View S &%&paﬁ éia Report H Save @ Help
prrsthare N
el

General] Supraventricular ] Wentricular } Supraventricular Runs } wentricular Runs Bigerniny 1 Tachy | Brady I Atrial Fibrillation }Paced} ST WInterpretatiDn]

Bigeminy Interval Table

Start Time | Total Beat | Bigeminy Beats |3 |4-9 10-24 | 25+ | Time Analyzed |
e gAML 1561 0 0 0 0 0 2246
e gsgAM{) 4201 0 0 0 0 0 50:58
@ 050AM{) 2683 0 0 0 0 0 736
Tachy / Brady Screen
8 Holter ECG - Artificial Patient (Tuesday, April 13, 2004, 8:37:13 AM) ‘ -
- - -

bbbk -
Gﬂgdit ek View Summary %’E}(pert éja Report H Save @ Help
Py N
piruirirnd

Generaw Supraventricular } wentricular I Supraventricular Runs ] Wentricular Runs ] Bigernirry Tachy [ Brady I Atrial Fibrilation ]Paced] ST IInterpretat\Dn}

Tachycardia | Bradycardia Interval Table

Start Time | Total Beat ‘ Brady Beats | Time in Brady ‘ Tachy Beats | Time in Tachy ‘ Time Analyzed |
® 837 AM (1) 1561 0 0:00 0 0:00 22:46

° 8:59 AM (1) 4201 0 0:00 0 0:00

 9:53 AM (1) 2683 0 0:00 0 0:00 37:36
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Atrial Fibrillation Screen

B | Holter ECG - Artificial Patient (Tuesday,-nlhpril i3 200443.-37:13 Alﬂ ‘ -

heeldecble g 0y

Gmmn R iew Sy f/{{upen é‘j Erpoet H Save @ Help
Al ke e
ik

Generall Supraventricular I Wentricular ] Supraventricular Runs ] wentricular Runs ] Bigerniry } Tachy f Brady Atrial Fibrilation IPacedl 5T IInterpretatiDn}

Atrial Fibrillation Interval Table

Start Time ] Total Beat I AFIB Beats ] Time in AFIB I Time Analyzed ]
° 8:37 AM (1) 1561 0 0:00 22:46
e 8:59 AM (1) 4201 0 0:00 59:58
° 9:59 AM (1) 2683 0 0:00 37:36

Paced Screen

% Hoher ECG - Artifcal Patient (Tuesdlay, April 13, 2004 83713 Ah) ' -

. 5
Gﬁ[dﬂ R View Summary %’E{peﬂ é Report H Save @ Help

ickhck N

pviriannd

General} Supraventricular 1 Wentricular ] Supraventricular Runs ] Wentricular Runs ] EBigerniry 1 Tachy f Brady ] Atrial Fibrilation Paced I ST ]Interpretat\un}

Paced Beats Interval Table

Start Time | Total Beat | Total Pa... | APaced | VPaced | AV Paced | Sense Fail | Capture... | Inhib. Fail | % 4 [%v | %Av | %Paced |
@ 3:37 AM... 1561 0 [1] 0 0 0 0 0 0.00 0.00 0.00 0.00
@ 3:59 AM... 4201 0 Q 0 0 0 0 0 0.00 0.00 0.00 0.00
@ 0:59 AM... 2683 0 0 0 0 0 0 0 0,00 0,00 0.00 0.00
ST Screen
% Holter ECG - Artifical Patient (Tuesday, April 13, 2004, 83713 AM) ' -
e ek
Qm'm R ey i Repor H Save @ Help
ook -~
puining
General ] Supraventricular ] Wentricular 1 Supraventricular Runs I “entricular Runs I EBigeminy ] Tachwy J Brady I Atrial Fibrillation Paced ST ]Interuretaticln ]
ST Table

Start Time | Total Beat | Avg.HR | ST Episo... | ST Durat... | MaxSTe | MaxSTd | Analyze... |

@ §:37 AM... 1561 69 0 0:00 0.0 mm 0.0 mm 22:46
B 550 AM... 4201 70 0 0:00 0.0 mm 0.0 mm 58:58
@ 0:50 AM... 2683 73 0 C:00 0.0 mm 0.0 mm 3736
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Interpretation Screen

- provides computer generated Automatic ECG Interpretation. [B88]Interpretation
can also be edited by typing free text or accepting statements from the Statement
Library. For the Automatic Computer Interpretation to work in the Resting test,
this option has to be selected in the Resting Setup.

- To add statements from the statement library, select the statement desired and
click on the arrow to transfer it over to the Physician's Interpretation box.

- In a view-only box at the bottom of the screen, the date and time of the computer-
generated interpretation is displayed. The name of the analyst who overread the
interpretation and the physician that confirmed it, along with the date and time,
can be entered in the applicable boxes.

B Holter ECG - Artificial Patient (Tuesday, April 13, 2004, 8:37:13 AM) ‘ .
- - -
Lhehy : b
%Ed\t et View Summary T’Kapm {ﬁ Report H Save @ Help
kb y N
pouininng
General ] Supraventricular Ventricular 1 Supraventricular Runs 1 wentricular Runs I Bigarminy ] Tachy J Brady I Atrial Fib Interpretation I
Physician Interpretation Statement Library
Atificial Patient was manitored for 2:00 hours; 2:00 hours were analyzed. During this time the - 4= Mormal/Abnomal

average heart rate was 71, with a minimum heart rate of 64 at @ 5:41:26 AM (1) and a
maximum heart rate of 109 at @ %4503 4M (1) The patient had 0 pauses greater than 2.0
secands.

-4 Wentricular Hpperrophy

{4 Myocardial Infarction

H-4 Conduction distulbances

-4 Other ORS morphology or general descr
14 Statements related to impulse formation |
H-4= Sinus node dysfunction, atrial and &Y-cc
14 Statements related o ectopic thythm abi
{4 Statements related o (predominant] con
H 4 Pacemaker pes and pacemaker functi
4 other thythm related statements

H4p Descriptive axis statemerits

t-4 5T-T descriptive statements

t-4p ischemic ST-T changes compatible with
H-4m 5T-T changes compatible with subepice
-4 norespecific ST-T changes altemative
-4 other ST-T descriptive statements

4 Atrial statements

H-4 Gtatements related to pediatic ECG ana

Computer Interpretation H-4 Statements related to the ECG calibratio
- t 4= Technical problems

I
5 ﬁ - T »

The patient Artificial Patient's test showed 0 (0.0 %) ventricular ectopic beats. The patient had

O isolated ventricular ectopic beats, 0 paired ventricular ectopic beats and O ventricular ectopic

beat runs. 0 beats were in ventricular ectopic beat runs. The longest iun had 0 beats at @

5:37.13 40 (1] and the Fastest run had a rate of 0 at @ &:37.13 4 (1)

The patient Artificial Patient’s test showed 0 supraventricular ectopic beats (25 % prematurity). <b
0 beats were in supraventicular ectopic beat iuns. The langest run had O beats at & 83713

&M [1] and the: fastest run had a rate of O at & 8:37:13 AM [1]

[E
[E
[E
[E
[E
[E
[E
[E
[E
[E
[
[
[
[
[
[
[
[
[
[E

Original Report [not overread) Overread Report (not confimed) Confirmed Report
[PEI Hater [ Analyst - I~ Physician -
| [ 41372004 = BIT13AM = e I T [tresraory ~| | simseaM =
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8.2.4 Expert
This tab contains additional functionality only available in our Extended and Elite
Software versions.

Pace Screen

0 - A i 37 =
Holter ECG - Artifcal Patient (Tuesday, April 13, 2004, 8:37:13 AM) ‘ -
bk o =
mhﬂ Fidekid view Summary | <2, Bpert é_:?a Report H Save @ Help
kb fa T
Lk pace M..J 4FB | e 5T |pe QT |46 RV | A Respration | Superimposition |
* | 444-1135 ms, 8062 Events
=
S8
s
FE
- B I\’ ‘ m
2. | b
0 300 200 1200 1500
Spike-R Interval (ms )
8:40 AM 1], 184 Events o
— 5" ([
E
©g
2%
.
o
H
la
= 837 AM (1) 8:37 PM (1) 1237 AM @ 237 AM @) 8T AM @) T

BZsm® L] fmme] N VS BP BBy A X|» o ¥ |mespike 1), Delspike 7S Measure (22 print #) \nsert (] select %V\m
|

Mmgltm:ﬁ 50 64 [135] 53 67 65 | 67 67 68 68 67 69 -

& HolterProcedure
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B Holter ECG - Artiﬁda”’aﬁentﬂuestﬁyﬂpnl]j‘ zumg:s?:umﬂ. F]

T
ik view
e
sy

e

Onset Duration

_[I Delete |_]|

L} pace Ll aFB |.]! ST |we T |9 Hey | Resoration |Be Supermpostion |

Summary |§/<apm % Report H Save ‘ @ Help |

ovz

g
&

ozk
Cuwz ) 4y

°
4:37 PM (1) 8:37 PM (1) 12:37 AM (2) 4:37 AM (2) 8:37 AM (2)

°
8:37 AM (1) 12:37 PM (1)

T dnsert
|

ESE‘ER |

VSBPRPRBAX - « ‘\»[Asmm [#seiomset 7 messure Fypant

70 &7

< [l

T
83703 AM (1) ‘mm
_ —
[ 70 |

N
|

Mark Complex a5 ventricular paced.J5

1] 12 B9

| & HolterProcedure

ST Screen

B Holter ECG - Artiﬁda”’aﬁentﬂuestﬁyﬂpnl]j‘ zmagp:uium. F]

T
ik view
e
sy

e

L pace |l o & ST ||4Lv» QT %6 ey | A Respration |- Superimposition |

Summary |§/<apm % Report H Save ‘ @ Help |

# | Onset

| Dur(m... | Max STe (mm) | — STeHC1 — STeHC2 — STeHC3 5
* ]
~
- H
E a3
E——ry LS
g Il
H &
& M
Add Delete
<
' 8:37 AM (1) 12:37 PM (1) 4:37 PM (1) 8:37 PM (1) 12:37 AM (2) 4:37 AM (2) 8:37 AM (2) i

T
83713 AM (1) ‘m [25mi-]
_ =

NVSBPPEA X‘ - ‘(ﬂpmt #) \nsert (] select 75 Measure ,@Gnd"m}

&7

70

< [l

69 68 71 72 | 73 | 89 96 62 69 72 69 74 69 | 69 | 7a 69 n

70

| & HolterProcedure
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9. Ambulatory Blood Pressure Monitoring

ALeLH[*] T US Customers will receive ONLY the software supplied by the device
manufacturer (and not the Cardiology Suite ABPM software module).

9.1 ABPM Setup and Download

Use the Configure Ambulatory Blood Pressure Download setup box to transfer the
ABPM data from the device to the QRS-Card™ program. This dialog box can be
accessed by the following methods:

From the QRS-Card™ Cardiology Suite Master Screen select Setup >

Ambulatory BP Downlo

ad

From the toolbar, click on the ABPM icon

Use the hot key F6.

OR

OR

The Configure Ambulatory Blood Pressure Download dialog box primarily
allows the user to specify the device used and the data file location.

Configure Ambulatory Blood Pressure Download

Device
Fart

Record

Drefault Repd

AMND TH-2430

COM1 h

W Show this windaw

After Download
(+ Exit " Edit

I¥ Enter patient demograhics

" Print

D |Name

1200 Standard AEFM Report

™ Log Communications

X
Lancel

Upload
Patignt
Diata

Beset

Device

Specify the ABPM device used.

Port

Defines which empty com port the device will be using or if a file is being downloaded.

Record

CS406-10 Rev F
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Specifies the location of the data file to be downloaded, including the drive.
Show this Window

If this box is checked the Setup dialog box will appear before each ABPM download. If
the box is unchecked the Setup dialog box will not appear before each download. The
download will proceed in the predesignated fashion.

Enter Patient Demographics

Checking this box will allow for the entering of patient demographics while the ABPM
data is being downloaded. Click on the Finish button when data entry is completed.

After Download

Exit If the Exit option is selected, the program will wait in standby in the Acquisition
Screen after the ABPM file is downloaded.

Edit If Edit is selected, the ABPM file will be downloaded and then the Dataview
screen will appear to allow review and editing of the data.

Print  The Print option will download the ABPM file and proceed with printing the
report selected.

Default Report

Allows for selection of a default report at the time of download. The type of report can
be changed after the download by opening the ABPM test and selecting File > Print
Report in the ABPM Dataview screen.

Upload Patient Data
The Upload Patient Data button allows the upload of ABPM data from the QRS system
to the ABPM Device.

B ABPM Download

Press 'Finish® when data entry complete.
Patient] Test | Medication |

Identification

ld| Browse

Last | First ‘

Date of Bith NG
b Ay
Address

Street

City State ’7 Zip

Telephone

Finish
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9.2 Viewing an ABPM Test

To view (or edit) a ABPM test, highlight from Main Screen the ABPM Test desired then click on the
button @0"*“ on the toolbar. OR

Double click on the Test to be reviewed.

1242502004 | burdick, | 3453 (1)
6f252003 | mahdawvi, mahdavi [ 200(1)
S/7IZ001 | ABRM, | 4646 (1)

- SIFIZ001 | Jlameson, Milda [ 1212 (1)
o™ ABPM 5{7/2001, &:45 AM

When a ABPM test record is opened, the ABPM Dataview screen is displayed. Information about the
patient can be viewed and/or edited, data from the test viewed and reports printed. An outline of the
features and options displayed on the ABPM Dataview screen is given below, along with any available
links to other relevant topics.

=
—si: [~ s o [0 oy | @t
S Systolic (All)  Systolic (Day)  Systolic (Night)
¥ -
N
o1
S
o
Dlastolic (A1) st (o) Diestale (Ngvt)
=T
D -
—
A
b (\ o mati: 10 % .as.mng 20% WS mmHg: 11% M|
- \ 5 Mg 29 % 09 mmkg: 0% 79 mmkg: 63 %
o A / \ o mivig: 53 50 _[Mso mrrig: 12 56 _[BDo mvig: 26 o0 I
N \;/,/ \/, M 55 [0 || Ehoer | @ngt
5 g \ | Blood Pressure Distribution
1 iastolic
3 \/ s w Stetoic Nghtw Dlestalic Mgt g
=)
8- P — .
J 28 P 8
i g 2
o go o
F %N 8
7 LE] 8 5
1 o 24 17798
o 0
S — gxg&&g&&xs»@
8: 00 12:30 17:00 21:30 2:00 6:30 11:00 Blood Pressure Range (mmHg)

Bvgmprecebre
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9.2.1 Edit

Use the Edit option to view or edit information about the patient and trace recalled from the database. The
Edit option can be executed by the following methods:

9.2.1.1 Patient and Test Property Sheets

Information about the patient is present in these two property sheets. If necessary, the information
can be edited.

9.2.1.2 Medication

Information about Patient medication is contained is contained in this property sheet.

9.2.1.3 Signal
Parameters on how the ECG was obtained, such as the sampling rate and use of filters, are
contained on this property sheet.

9.2.2 View

Use View option to see ABPM data in four different ways:
ALL views seen simultaneously
Trend data only
Pie data only
Bar data only

9.2.3 Summary

Pressing summary button provides summarized data for ABPM measurements (Summary, Hourly, Actual
Measurements) and location to type physician Interpretation.

[100]
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9.2.4 Report

Checked Off reports can be printed (automatically or manually) to printer attached to the computer.

Select Report

o] | M ame | Show D etailz

12001 Standard AEPM Fepaort

LCancel

Output
* Samzung ML-1740 Series
" PCLS Frirter
" POF Eile Viewer
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10. Spirometry

Coming Soon!
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11. Remote Server/Cloud Database

N
il
)

I}Fﬂlli

fr
"'?clln
l <

I
J
e

I
L

il
X

7
— |

/

Remote Server Database Toggle

1id remote

Press Button to toggk

database.

Cardiology Suite software provide e local

computer (or mobile phone)and also at the same time inthe cloud (remote server).
Cloud ECG data is available for review/editing remotely using Cardiology Suite
Software or a standard Internet browser.

Following procedureunder "Utility/ Configuration/Login"isneededfor
customer to save,reviewandeditdataremotelyusingcloud/remote

operation:
1. Generate their own User Name and Password
2. RequestaConfirmation Codefrom PBI
3. Enter Confirmation code (which customerreceived from PBI)
4. Setupoffrequency for data synchronization between local computer

and remote server.
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12. Utilities

12.1 Topics

12.1.1 Configuration

Configuration Section is used to setup various default parameters of using QRS-
Card™ Cardiology Suite Software. These options include:

Reporting

Database

Measurements

Options

GDT Interface

Real-Time Print

Email

Login

[104]
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REPORTING
Use the Reporting Configuration Property Sheet to set the default values for
reporting ECG results. Access the property sheet by the following method:

Select Utility > Configuration and click on the Reporting tab in the Configuration
Setup property box.

Complex

Gain- Defines the Gain for ECG complexes to be printed on the Stress
ECG reports. Options are 5, 10, 20 or 40 mm/mV.

Speed- Defines the Speed for ECG complexes to be printed on the Stress
ECG reports. Options are 25, 50 or 100 mm/sec.

Lead 1- Defines the 1st complex lead to be printed on the Stress ECG
reports.
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Lead 2- Defines the 2nd complex lead to be printed on the Stress or Hi-
Res ECG reports.

Lead 3- Defines the 3rd complex lead to be printed on the Stress or Hi-
Res ECG reports.

Rhythm

Gain- Defines the Gain for the ECG to be printed on the ECG reports.
Options are 5, 10 or 20 mm/mV.

Speed- Defines the Speed for the ECG to be printed on the ECG reports.
Options are 5, 10, 25 or 50 mm/sec.

Lead 1- Defines the 1st ECG Lead for the three lead ECG reports.
Lead 2- Defines the 2nd ECG Lead for the three lead ECG reports.
Lead 3- Defines the 3rd ECG Lead for the three lead ECG reports.
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DATABASE

The Database property sheet allows the user to select the location that the ECG data files
will be stored. This property sheet can be accessed by the following method:

Select Utility > Configuration and select the Database tab in the Configuration
Setup property
box.

Root: Defines the default root directory for all ECG data files. To change the
directory, click the “Browse* button and select the directory.

Reset- use the Reset button to bring all parameters back to their factory defaults.

Logging- Customer support may ask for this to be selected in order to pinpoint a
problem.

WX W £CG database is in published “SCP” format. Each test is a
separate file. These files are stored in “qrsdb4/files” folder. It is important the
user backup these individual SCP file for data security purposes.

[107]
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OPTIONS:
Select Utility > Configuration and select the “Option” tab.

This option selects ST Value’s parameters, Multitask message display, PDF File Viewer
Setup and Word program setup.

[ ok | cancel Apply Hep |
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EMR:

Select Utility > Configuration and select the “EMR” tab.

This option is for EMR interfacing setups. For more help with setup, please contact
Pulse Biomedical Technical support team.

= - 5
E His =i
= =i
= — S = —— — =i
= 55 iempDisie i Hecord Hie Name - =i
= = — =
= =i
= =i
= = = - — =i
i — Report Format ~FiF i
= =i
1 — — — 33 fenn 100 1 4 =
= I pumo I nrnmM I bpnc 1 Cnaoie 1iJc.1oo.u. 1 =
i =42 3 rnAs I o 0]
= — mice — inceo r =
[ == i Local le:\i#p |
[ . |
[ Fil= |c:\r'|uﬂ!\4 wrenarte\mt fil r =l
= = > — Remote [c:\rem =
| Template |Pm~d File Directons -l r |
I - | It T oEmE User tmoﬂ)‘l'ﬂous I
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REALTIME PRINT
Select Utility > Configuration and select the “Real Time Print” tab.

This option is used to Enable or Disable Real Time Printer and to Setup Real Time Report Parameters.

[ ok | Ccancel Apply Hep |

ALIIY B Real Time Print requires a PCL5 compatible printer “pclSus.rtt”
is the default report but, in case of printing errors select “genrtp.rtt” report.
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EMAIL
Select Utility > Configuration and select the “EMAIL” tab.

This option is used to Setup Server Parameter for Sending and Receiving ECG’s via
Email.

Reporting | Database | Options | EMR | Real Time Pant Emai | Medication | Login |

* Disable E-mail " Interet E-mail " MAPI E-mail Reset |

— Server Information-
Incoming Mail (POP3) |
Outgoing Mail (SMTP) |

- Incoming Mail Server

Account Namel
Password I

1 Dutgoing Mail Information-
E-Mail addressl

domain |

m My outgoing server [SMTP] requires authentication
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LOGIN
Select Utility > Configuration and select the “LOGIN” tab.

This utility is designed for increased security: a) Software Access; b) Remote
Server/Cloud Access. See Page “101” for detail on Remote/Cloud Server

Reporting | Database | Options | EMR | Real Time Print | E:mail | Medication Login |

 System Access- ] Reset |
User |@

Password I

I~ Enable
~ Cloud Access-

Confirmation I 0 Request Confirmation

I~ Enable

— Synchronization - 1

Update (s) ISSUU N I

I~ Enable

Systems Access: Allows user to set unique user name and password to prevent
unauthorized access to the Cardiology Suite & Remote/Cloud Database Server

User : Remote/Cloud Server & System Access account username,
chosen by the user.

Password : Remote/Cloud Server & System Access password, chosen by the
user.

Enable : Enable or disable Remote/Cloud Server account options.
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Cloud Access : User will set up his Remote/Cloud Server Account which will be
activated through a verification email to the email address provided by the user

Confirmation : Remote/Cloud Server account confirmation code, used to verify
Request the account.

Confirmation : E-mails the user a Remote/Cloud Server account confirmation
code.

: Enable or disable the use of the Remote/Cloud Server account
confirmation code.

Enable

Synchronization: After receiving confirmation of cloud access login credentials,
user can synchronize the local database on remote/cloud server.

: Sets the rate of the Remote/Cloud Server synchronization utility

Update

in seconds.
Now : Forces Remote/Cloud Server synchronization utility to run.
Enable : Enable or disable Remote/Cloud Server synchronization.
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12.1.2 Physicians

Select Utility > Physician then property box will appear

Names of attending and referring Physicians database are stored using this option.

B ' Physician Database u “- M

Name ].-“-‘«tt. ] Ref. | Rist. J Shr. J HIt. I Specialty J

Update

EE [flel bR

Help

&dd

Delete

E #port

|rnpart

b

Add: Select to enter new Physician or Referring Physician name
Update: Select to update on an existing entry in Physician database

Delete: Select to delete an entry in Physician database

Export: Select to Export a listing of an existing Physician database in text format

Import: Select to Import an existing text format Physician list into Physician database
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12.1.3 Clinics
Select Utility > “Clinics” then property box will appear

This option is use to Enter Clinics Names for a multi-practice medical office.

Mame | Cloze I

Help

Update

Delete

Export

A [ffek s

Impart

Add: Select to Add a new Clinic name in the Clinic database
Update: Select to update an existing Clinic name and address
Delete: Select to Delete an existing Clinic name in the database
Export: Select to Export an existing Clinic database to text format

Import: Select to Import a text format Clinics names into Clinics database
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12.1.4 Technicians
Select “Utility > Technician” then property box will appear

This option is used to input Technician’s name acquiring the ECG data

M ame | Rst. I Str. I HIr. | Cloze

Help

ud

Add
Update

Delete

Ewport

| Imnpart

i [ifE

Add: Select to Add a new Technician Name in the database

Update: Select to Update an existing Technician name in the technician database
Delete: Select to Delete an existing technician name from the database

Export: Select to Export an existing technician database to text format

Import: Select to Import a text format technician names into technician database
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12.1.5 Import Records

Select Utility > Import Records then property box will appear

m Import Data Record
> Computer » COMPAQ(C) » QRSDBY » backup 2 Fr
NS s ——— .
Organize » New folder | @
L MData(pbiwin2l *  Name . Date modified Type Size
4 QuickBooks Data 2
Amanda-Shortc B || STRO000S.DAT 3/4/2011 9:17 AM DAT File 2KB
J Amanda - Shortc
I' o || STROO009.DAT 8/26/2011 9:53 AM  DATFile KB
De; Tpd ] STROC10.DAT 8/16/011 1139 AM  DATFile 1k8
ownloads
:; 2 5 || STROO011.DAT 8/26/201111:47 AM  DAT File 9KB
- Recent Places
s - || STROO012.DAT 8/26/201111:52 AM  DAT File 9KB
A g| ] STROO0I3DAT 8/26/2011 1153 AM  DAT File 1KB
= 2 || STROO014.DAT 8/26/201111:59 AM  DAT File 9KB
i Libraries
@ Documents |
Ji Music
=] Pictures
iﬂ Programs
B Videos
& Homegroup
File name: v ’SICP ']
’ Help ] | Open |v| ’ Cancel l

Cardiology Suite™ will access the ‘backup’ database. Select the file you would like to
import and click ‘Open’. Cardiology Suite will import the selected file into your test
database.
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12.1.6 Import Reports

Select Utility > Import Reports

The Import Report option is used to import any new ECG report formats supplied by
Pulse Biomedical or to import any changes made to already existing report formats.

To import a report format, highlight the desired report and click Open. The new report
will be imported into your report database.

To make changes to the format of an existing report go to Windows Explorer. In the
directory containing the QRS-Card™ software, click on the report to be modified with
the right mouse button. Select Open. The existing report format will open on the
Notepad. Make the desired changes and save them. Return to the QRS-Card™ software
and the Import Report option. Highlight the modified report and click on Open. The
modified report is now ready for use.

:m Import QRS Report ﬁ
Y s - ——
@@v . v Computer » COMPAQ (C:] » ProgramFiles » Pulse Biomedical » V400 »
e e — e
Organize = New folder = 0 @
B Desktop *  Name : Date modified Type Size b
Downleads
;& R B ftdi 8/26/2011 9:40 AM  File folder
1=, Recent Places po. 6 3 - E
wa ftdipbi 8/26/2011 940 AM  File folder =
Sl 3 abpm 0 322N92AM  ReportFile 3KE
= b = abpm 1 3/22/2011 21 AM Report File 9KB =
4 ibraries
ﬁj . |5 abpm 2 3/22/2011 921 AM  Report File 9KB
I 2] te
2 Mmmn : 3 abpm 3 32211921 AM  ReportFile 18K8
> @ Music
: - =] abpm 4 3/22/2011 21 AM Report File 5KB
» = Pictures c
j 5 E D abpms 3/22/2011 921 AM  Report File 5KB
[+3
% V';g'm 3 holter 0 322/211921AM  ReportFile 8K
D ideos
=] holter 1 3/22/2011 %21 AM  ReportFile 11 KB
@H 2] holter 2 3222011921 AM  Report File 17 KB
>
SREJIRLR 3 holter 3 322/211921AM  ReportFile 13K8
5 C — 3 holter 4 3/22/2011 9:21 AM  ReportFile 6 KB
4 18 Computer
- .-E-’ COi‘IPAQ = 2] holter 3/22/2011 %21 AM  ReportFile 4 KB
& )
- T =] holter 6 3/22/2011 9:21 AM  Report File T1KB
H
- & T 1 holter 7 3/27/2011 871 AM  Rennrt File 15 KR M |
i
File name: JT v iQRS Reports (*.rpt) v]
Help l [ Open ]v] [ Cancel ]
ke =3 =
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12.1.7 Queue System

Select “Utility > Queue System”

The Queue System places the ECG traces from the patient Tests database in the queue
system. At a later time, the user can dump the queue to a printer, E-mail the traces, or
export the traces to an external file (one not connected to the QRS databases). Using the
Queue system, the user can also receive ECG traces via E-mail or import a trace from an
external file.

5
|| RS ¥ .
Q Qu eue System - @

Lyvailable Queues

Dump Queue

Delete Queue

EMailIn
H Expart

= Import Beset Emars

Printer
Pricrity | (ueue Time | Report | Detail Add

Update

Delete

Resst Emor

LR

The system will display the QRS Queue System dialog box.

Dump Queue- Clicking on Dump Queue will dump the entire selected queue to
the appropriate output device and the Queue Dump dialog box appears. The
Queue Dump dialog box shows the status of the queue dump. Any errors that
occurred will be listed.

Delete Queue- Clicking on Delete Queue will delete all items in the type of queue
selected.

Reset Errors- Clicking on Reset Errors will reset any errors that occurred when
dumping a queue.

Add- Clicking on Add will cause the system to display the appropriate Add
dialog box for the selected output device. See the Available Queues below for
more information.
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Update Clicking on Update will bring up the Update QRS Queue Entry dialog
box. Details of the selected item can be edited in this dialog box. In particular,
the type of report selected for a particular queue item can be edited using this
option.

Delete Clicking on Delete in the bottom section of the dialog box allows the user
to delete individual items from a particular queue.

14272005, 957 PM
st1 1/27/2006, 10:00
121 1/27/2008,10:27 ...
20 6/25/2003, 1011
121z 1/27/2009,11:44 ..
1212 1/27/2005. 11:45
122 1/27/2005, 11:50
n21 1/28/2005, 8:04 AM
1212 1/28/20085, 808 AM v

Destination [CADOCUME~1CARDIO-T\LOCALS T\ Temp
Format|5CP = Add Close Help

Available Queue Options

Print Queue

To add to the Print Queue, double-click on Printer under Available Queues in the Queue
Detail Dialog Box or highlight Printer and click on the Add button. The Add Entries to
QRS Print Queue Dialog Box will be displayed.

Select the test and the type of report desired, add any comments necessary and click on
Add. Click on the Close button to exit this dialog box. The selected traces will be copied
to the Print Queue. Select Dump and the traces will be printed.

To aid in finding an encounter, the user may sort the database by name, ID or date/time
the encounter was obtained by clicking on the appropriate heading name.

Mail Out
The Mail Out option allows the user to E-mail ECG traces.
Note: For best results, connect to the Internet before entering the Queue System.

To add to the Mail Out Queue, double-click on the Mail Out option under Available
Queues or highlight Mail Out and click on the Add button. The Add Entries to QRS Mail
Out Box Queue Dialog Box will appear.

Highlight the encounter to be E-mailed and using the directory option, enter the recipient
E-mail address. Click on Add to the queue. Click on Close to exit the dialog box. Click
on Dump Queue to start the E-mail process.
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Mail In
The Mail In option allows the user to receive ECG traces via E-mail.
Note: For best results, connect to the Internet before entering the Queue System.

As the Queue System is accessed, a message "Retrieving message X or X" will appear if
E-mail has been sent to you since you last logged onto the Internet. The Mail In option in
the Available Queue box will show the number of messages.

Highlight Mail In and click on Dump Queue. The messages will be dumped directly into
your database.

Note: Be aware that the time on the encounter is when the test was taken not when it was
e-mailed or dumped into the database.

Queue Export

Selecting the Export Queue option will allow the user to export ECG traces to an external
file.

To export a file(S) double click on Export under Available Queues or highlight Export
and click on the Add button. The Add Entries to QRS Export Queue Dialog Box will be
displayed.

Select the file(S) to be exported and click on Add Encounter. Click on the Close button
to exit this dialog box. The files will be copied to the Export Queue. Select Dump. The
selected files will be exported into the Windows Temporary (TAMP) Directory.

Queue Import

Selecting the Import Queue option will allow the user to import ECG trances from an
external file.

To add to the Import Queue, double-click on Import under Available Queues or highlight
Import and click on the Add button. The Add Entries to QRS Import Queue Dialog Box
will be displayed.

Select the file to be imported and the format to be used and click Apply.
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12.1.8 Rebuild

Select Utility > Rebuild
This selection is used to rebuild (Re-Index) a corrupted or bad database.

This selection can also be used if two or more databases needs to be combined
together into one database (e.g copy both database *.SCP files into “qrsdb4\files”
folder then select Rebuild command)

NOTICE “Rebuild Database” may take longer with large data files like Holter ECG. Wait
times would be comparatively less in case of Resting and Stress ECG files.
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1 PBI

13. Logs

Log files are created each time the STWIN program is run. This file keep track of all
operation performed by the user. More importantly this files keep logs of any errors occur
during the usage of the program.

Viewing the file can very helpful in troubleshooting problems with the program.

Status
Use the Status command to display the status log. The Status command can be executed
by the following method:

® From the “Logs” Menu select “Status”.

When the Status command is executed the system displays the Log View Dialog Box.
This log file shows the most recent events the system executed.

| Date, Time | ~
20130712, 3:3259 PM
20130712, 3:3259 PM

D ezcription

CEM > Windows B Unknown at Releaze [build 9200), 64-bit
QEM > IntelR] Core[Th) i8-331 70 CPU & 1.70GHz

CEM > Language S=[Englizh [Canada]] U=[Englizh [Canada]]. metric = 1 20130712, 33259 PM
CEM -->> Memory = 8.44 GB [4.42 GB available - 47% load) 20130712, 23253 PM
QEM -3 Windows8_05 (C:%) 64253 GE free of £99.33 GB LENOVO (04 23.18 GB free of 26.84 GB WINRE_DRV... 2013-07-12, 3:32:59 PM
@ QRS5-Card Cardiclogy Suite Activated. 20130712, 23253 PM
QEM Start CardiologySuite [4.06 / Enu 4.06 / 130703) 20130712, 23253 PM
EM Configuration R estored! 20130712, 33259 PM
CEM Start Phil atabase (40006 - Jul 32013 13:04:21) 20130712, 23253 PM
EM Start CTREE D atabaze Interface (40006 - Jul 92013 13:02:53) 20130712, 33259 PM

° The system cannot find the file specified.

EmM OEM Eror [db_open.cpp:290, CAORSDE4WRPTDAT A dat)
@ CHARSDEMRPTDATA dat data file created.

@ CHARSDEMRPTDATA idx host index file created.

EM Stop CTREE D atabaze Interface (40006 - Jul 92013 13:02:53)
CEM Stop Phil atabase (40006 - Jul 32013 13:04:21)

EM Start Load Reports

20130712, 3:3259 PM
20130712, 3:3259 PM
20130712, 3:3259 PM
20130712, 3:3259 PM
20130712, 3:3259 PM
20130712, 3:3259 PM
20130712, 3:3259 PM

W

Dloeuoen @D s | e | e |

Error
Use the Error command to display the error log. The Error command can be executed by
the following method:

0EM ‘OEM

| Cloze I

Options | Delete

® From the Logs Menu select Error.

Executing the Error command causes the system displays the Error Log View Dialog
Box. This log file shows the most recent errors that the system encountered.
Pressing MAIL tab in the Log View will send the log file directly to PBI technical
support.

ALXIY W £rror Log file is the MOST IMPORTANT file for trouble shooting the QRS-
Card™ Hardware and software. During technical support call to PBI the information contains
in this file will assist PBI the most information to solve or diagnose the problem over telephone.
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14. Help

14.1 Contents

The Help - Contents screen allows users to explore the Cardiology Suite user guide,
Quick Reference Guides and Brochures

il E
% Cardiology Suite Help Files L= | B

-

Table of Contents
Users Guide
Pesting Quick Reference Guide Front
Stress Quick Beference Guide Front
Holter Quick Beference Guide Front
(JB.5-Card Festing Brochure
QBS5-Card Stress Brochore
(JF.5-Card Holter Brochure
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14.2 About

The Help = About screen displays various information about licensing and software
versions.

.
About Cardiology Suite ‘h ﬁ

QRS Card Cardiology Suite Version: Enu 4.06 (110812)
J’& Copyright © 2011, Pulse Biomedical, Inc. Al rights reserved.

This product is licensed to:

Jblhuﬁ-lﬂlﬁ Mame: 5\]
LLJ,,L_[JM Company:
PID: T2RA0-EA3D-T413-0E92MMG

I Sh: 1211 AEQO1EQOFFD J1T1411
' ' | i Product Details:
9 License Registered

Installed Products:

Cardiology Suite - Email Info
Resting Test i 3 | _

Stress Test i | View Log
Holter Download :
AEPM Download Service

Warning: This computer program is protected by copyright law and international treaties.
Unauthorized reproduction or distribution of this program, or any portion of it,

may result in severe dvil and criminal penalties, and will be prosecuted to the maximum
extent possible under the law,

l.m

1

i

WA TS G SO

License/Unlock Code:

¢ C(lick 'g to enter the PID available on the “USB Dongle” received with the
device

=)

e 11411 Numbers below the “Lock” represent your licensed products and
features in the software
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Appendix 1: Accessories, Warranty and Repairs

Accessories
The Pulse Biomedical, Inc. warranty can only be honored if you use Pulse Biomedical, Inc.
approved accessories and replacement parts.

ACAU"ON Use of accessories other than those recommended by
Pulse Biomedical, Inc. may compromise product performance.

Warranty, Service, and Spare Parts

Warranty

All repairs on products under warranty must be performed or approved by Pulse Biomedical, Inc.
Unauthorized repairs will void the warranty. In addition, whether or not covered under warranty,
any product repair shall exclusively be performed by Pulse Biomedical, Inc certified service
personnel.

Assistance and Parts
If the product fails to function properly or if assistance, service, or spare parts are required,
contact the nearest Pulse Biomedical, Inc Technical Support Center.

USA + 610-666-5510 Europe + 49-7434-316038

Before contacting Pulse Biomedical, Inc it is helpful to attempt to duplicate the problem and to
check all accessories to ensure that they are not the cause of the problem.

When calling, please be prepared to provide:
¢ The serial number of the device
Complete description of the problem
The serial number of your product (if applicable)
The complete name, address and phone number of your facility
For out-of-warranty repairs or spare parts orders, a purchase order (or credit card) number
For parts order, the required spare or replacement part number(s)

Repairs

If your product requires warranty, extended warranty, or non-warranty repair service, please call
first the nearest Pulse Biomedical, Inc Technical Support Center. A representative will assist you
troubleshooting the problem and will make every effort to solve it over the phone, avoiding
potential unnecessary return.

In case the return cannot be avoided, the representative will record all necessary information and
will provide a Return Authorization (RA) number, as well as the appropriate return address. A
Return Authorization (RA) number must be obtained prior to any return.

N OT' CE Pulse Biomedical, Inc does not accept returned products without an RA.
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Packing Instructions
If you have to return goods for service, follow these recommended packing instructions:
e Remove all cables before packing, unless you suspect they are associated with the
problem.
e Pack the device safely and include a packing list and the Pulse Biomedical, Inc Return
Authorization (RA) number.

It is recommended that all returned goods be insured. Claims for loss or damage to the product
must be initiated by the sender.

Limited Warranty Statement

Pulse Biomedical, Inc, Inc. warrants that the Pulse Biomedical, Inc Cardiology Suite computer
based product you have purchased meets the labeled specifications of the Product and will be free
from defects in materials and workmanship that occur within 1 year after the date of purchase.

Accessories used with the Product are warranted for 90 days after the date of purchase.

The date of purchase is: 1) the date specified in our records, if you purchased the Product directly
from us, 2) the date specified in the warranty registration card that we ask you to send to us, or 3)
if you don’t return the warranty registration card, 120 days after the date on which the Product
was sold to the dealer from whom you bought the Product, as documented in our records.

This warranty does not cover damage caused by: 1) handling during shipping, 2) use or
maintenance contrary to labeled instructions, 3) alteration or repair by anyone not authorized by
Pulse Biomedical, Inc, and 4) accidents.

If a Product or accessory covered by this warranty is determined to be defective because of
defective materials, components, or workmanship, and the warranty claim is made within the
warranty period described above, Pulse Biomedical, Inc will, at its discretion, repair or replace
the defective Product or accessory free of charge.

You must obtain a return authorization from Pulse Biomedical, Inc to return your Product before
you send it to Pulse Biomedical, Inc’s designated service center for repair.

Pulse Biomedical Inc. makes no warranties, either expressed or implied, regarding the QRS-
Card™ Cardiology Suite 4.06, its merchantability or its fitness for any particular purpose, with
the exception of any limited warranties which are disclosed in this manual. The exclusion of
implied warranties is not permitted by some states. The above exclusion may not apply to you.
This warranty provides you with specific legal rights. There may be other rights that you may
have which vary from state to state.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. PULSE
BIOMEDICAL, INC'S OBLIGATION UNDER THIS WARRANTY IS LIMITED TO REPAIR
OR REPLACEMENT OF PRODUCTS CONTAINING A DEFECT. Pulse Biomedical IS NOT
RESPONSIBLE FOR ANY INDIRECT OR CONSEQUENTIAL DAMAGES RESULTING
FROM A PRODUCT DEFECT COVERED BY THE WARRANTY.
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Appendix 2: Patient Preparationgss,

Acquiring a Good Quality Resting ECG

Acquiring a good quality ECG depends upon:
1. ECG technician (operator experience)

2. Patient (patient electrode preparation)

3. Environment (low electrical interference)

PBI has provided you with a high quality QRS-Card™ Cardiology Suite device. When
the QRS-Card™ Cardiology Suite is used in conjunction with a computer to acquire ECG
data from a patient:

- It is important that the computer you are using with the QRS-Card™ Cardiology
Suite be of high quality with low electrical noise generation. If you have not
purchased your computer system from PBI or do not have the list of approved
low-noise computers in the marketplace, please call us for assistance.

- It is important that the Electrical Ground to the AC mains be properly grounded
and in good working order.

- It is important that no electrical noise be generated by any equipment in the
vicinity of the QRS-Card™ Cardiology Suite ECG machine.

PBI has tested your QRS-Card™ Cardiology Suite for the best ECG performance.
If you find electrical noise in the signal during a patient ECG, please check the following
before calling PBI’s technical support line:
- Check that the patient is properly prepared and the lead connections are tightly
installed.
- Check the ECG environment to see if there is other electrical equipment present
that may be creating the electrical noise.
- Check your computer brand and model to make sure they are from an approved
manufacturer.
Electrical noise can be controlled if the above noise detection steps are investigated and
corrected.

For any further help, please call Pulse Biomedical Inc. at 610-666-5510.
Before calling PBI please note the serial number of your QRS-Card™ Device.
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Prepping Patient & Electrode Placement

Important: Because QRS-Card™ Cardiology Suite is a 12 lead electrocardiograph all
electrodes must be correctly connected. Proper skin preparation (abrasion if necessary)
and proper electrodes are very important for a good signal quality.

Important: When you connect the electrodes to the patient, make sure that the electrodes
and their connectors (also the RL/N electrode) do not contact other conducting parts
(including earth).

Extremity electrodes The electrodes may be placed on any part of the arms (as long as
they are below the shoulders) or the legs (as long as they are below the inguinal fold
anteriorly and the gluteal fold posteriorly). Any other placement necessary by deformed
or missing extremities must be noted on the record.

Limb Leads/Extremitiy Electrodes (RA, LA, RL, LL) B90]

The electrodes may be placed on any part of the arms (as long as they are below the shoulders) or
the legs (as long as they are below the inguinal fold anteriorly and the gluteal fold posteriorly).
Any other placement necessary by deformed or missing extremities must be noted on the record.
Electrode Placement: attach electrodes to the patient in the following positions:

AHA Position IEC
V1 4™ intercostal space at the right border of the sternum C1
V2 4™ intercostal space at the left border of the sternum C2
V3 Midway between locations V2 and V4 C3
V4 At the mid-clavicular line in the 5™ intercostal space. C4
\E At the anterior axillary line on the same horizontal level as V4. C5
Vo At the midaxillary line on the same horizontal level as V4 and Ceé
V5.
RA Right arm. R
LA Left arm. L
RL Right leg. N
LL Left leg. F
[BI1]

Reusable Electrodes

Each electrode must be attached securely. The electrode paste, gel, or cream must cover
an area the size of the electrode, but must not extend beyond it, especially on the chest.
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Disposable Tab Electrodes

Disposable electrodes have conductive material on the adhesive side only.

The electrode tab must be placed between (clip) or on (banana or pushbutton) the
electrode adapter, and remain flat. Do not attempt to place the electrode adapter so close
to the circular part of the electrode that the tab of the electrode is bent, or contact is made
with the conductive gel. Gently tug on the electrode adapter to ensure that the electrode
adapter is properly placed on the electrode. Good and accurate placement of each
electrode on the first attempt is important. Each time an electrode is lifted off the skin and
reattached, the adhesive gel becomes less effective.

ACAUTION Never mix reusable and disposable electrodes on the same patient.

N OT' CE Because QRS-Card™ Cardiology suite is a diagnostic 12 lead system, all

electodes must be connected. Proper patient prep is necessary for a good quality signal.

N OT' CE When you connect the electrodes to the patient, make sure that the electrodes

and their connectors do not contact other conducting parts (including earth).
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Appendix 3: Sample Resting Reports

1200 Standard 12 Lead

Pationt: Actificial Pationt P DENO Test Date: 1026309, 2:31 AN Location: Ry Offien
A 1y See WA Sigrative oete
Heit NG Vo MG ;, s
foeden e Fosteanest Ry HR 71 BP ... CN&MWuM
Bue Nh 50 assuants interprsiation S Caetin
Aot N TR tha e Haut taic obnows
@ yo A BE W
Y ™

@ PE QRS aed Digted FCFCG Maghine wewgrscondcom + 18106668310

[131]
CS406-10 Rev F Pub: 2013-07-16



QRS-Card™

4\, PBI 4.06 Cardiology Suite Operating Instructions

1203 Standard 3 Lead

Wy Sa BA Datn
Wil & HR 71 BP .., Do ——
Dot dones Snsarsnet ‘
ave: WA [memprstation Dannatilon
auotk  NA PR tbeme Heart ruds phorern
Fade M4 QO B Afae gl t giay i iRl
SmoReg NA OTIOTE R e B Bordarline S0
Pasisshar NA Bl 15E Biners oyn.
Madieaton GRS R 44 Barty rpoleriratios.
T Ak 710
Sokuiew Ly 2952
el T3
Eatenr 1

@ PBE QRSCord Digitet PO ECG Mackine mmﬁm SR EHE60-3510 Bar ¥ ) Boxd
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1206 6 x 2 12 Lead Standard

Putiont: Artifizisl Patleat Pily: DERG ot Dote: WIEH2RI0 931 AN Lotatiun: Sy Olfee
Agw Ty BewsA PR 1G4 WG9 e [erglepiete SEUNE =Y
HR 71 BP ..

Q) P GRS Cond Digial FCECG Mo wio g com 16106665510 For 1 T4
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1208 6 x 2 2 Page 12 Lead Standard

oot Actin Pt conry OO0 Test Date: WIS, 831 AN . s Loeaton: sy oce
a3y x < 15410 842 me 8 o
HR 77 8P .o

LU e e

@ PREORS-Clard Digfad PCECG Mockine wwe cerdoom -+ 1-SI0-GE0-53180 Hex § B
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Patient: Artificial Patient PID: DEMO Test Date: 10/26/2010, 8:31 AM Location: My Office
Age: 13y Sex: A HR 71 BP PR: 154 ms ORS: 82 ms OT 1 QTC; 363 ms/ 364
+:8pood 28 mmia + | @ain 18 10| Flter: 80 Ha, Basaing | BEEH B BEIRE B B

V1

- Copyriaht ©3007, Pulse Biomedizsl Inc, Al Tights reseried. |- - R S e e e e S 1200,6%2 2 Page 12 Lead Standard

@ PBI ORS-Card Digital PC ECG Machine  www.grscard.com  +1-610-666-5510 Box | Box 4
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1210 Standard 12 Lead (12 x 1) Report

Patlent: Adifichl Pationt BT DENG Tast Dater WISIN0, 831 AN Location: My Oifics
g i3y Sen A e 15t oRE: R we T T 8 ) 28
HR 71 BP...

g PBE QRSCard Digied PCECG Mashine wwwgrsoard.con + 1-510-666-3310 Bax § B 4
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1212 Standard Complex Report

Patiant: Artificial Patie PHY: DERSD Tout Bate: HURRIGH, 131 AW Location: My Ofien
Agar Kay Ser NA gt Date
g s we HR 71 BP oo o koson tonest A
S Refostest
- it Schoot Pl
At NE PR AbAm > st vaka atommal
Paisdy NA L P
Smsting: WA TR e 4 Besering £C5,
Bacomaier MR ?m e Bins R
i T 710
Tebwhon Lo, TN
Samelt TS
Eew 1

PRI ORE-Card Dighted PUFCG Mazkive wwwgrseaed.oons + A5 06663310 Box Bee o
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Appendix 4: Stress Sample Reports

1000 Stress ECG Segment (3 lead)

Pariont: Aritlicial Patient Yast Detaiis: Srip Detaiis:
AR DIER “Tos Site: My Offon Tacheicion: P Saose T
g HEE gl NG Paoeroiier NA  Famiy: NA o Uster, WHEPEOIQ, B2 481 Ropan! Uale: HAG00, §36 40 Hage: HETS:
Saw ki Weght: HG Sroieg N Aohot NA Giodhurara GRS Tard Cassisiony ulte (Evw 4,58 Deuioe L
Faterred By R pefidl e (81 e “fegt Hesalta:
Stadicaion: Bratorst e Cacion Trosrd (ondain
Baimn PE 98 1535 of THE (160 |
Sredation: HR 7T B8P 13387 aisinsiann B mﬁ? b 6 B3Q
N Sl §10 24 nun £ 248 1
Besele Messuranents Curreot Measevemenid gy Gl ,f?}_; Gag Q’m 1INty
PR 180 me PR; 18 Test Tioe: 251 Ensraize Time: G414
G 92 e RS B Soamanation X
T T B w8 T N s 1 258

el §¥0 Tras
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1001 Stress ECG Segment (12 lead)

Patient: Atifiuial Patival Test Detaiis: Stp Setais:
PiD: DEMG Tt it My Qlhon Teskician: P Flysues T
g0 Hol G Piomekor B Fanitn A Tt Dter 1GTTICHE, 921 MR Rpost Date: FURIONY, 5843 e S
Sac R e NG g e Aloshol N& Shalanves: G Gt Oy St 1B 08 Dz Lapae
Rofpreed ﬁy: Fegeordes: gredicl ady BN WRIAZSEO00NDHT0 ry WS Test Resalis:
tafsice: Protoest: Srane i Trsasdnit {Simented
fre e AT ——
s BR: 86 50 % of THR {1508
P HR 71 BP 13387 o mia [re—r
v 57: 2.6 s 63 V31
Baseling Mosswromenls  Current IOIRUTNIONIS gttt L g e 4D B ponde 1102 HETRY
PR 150 e PR: 15w Tt Tisser 261 Eiza Tiv: 341
Tasnatis Roasiy
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1002 Stress ECG Result Table

1002, Stress ECG Result Table Aetficiol Patiort
| Hy Ofifca
652 Mady Stront Nowisfown PA 19803
SIDEEA 8610 8Y0 808 SX08 Pritad Thusdar b 28 2010, 2508 4K
Pathent: Artificlal Patient
Age Mo Heght N8 Paenten MA Famdly Wb Medication:
S WA Waight: B0 Sk NA Ajgokod NA
Ifications: Tost Results: Bruus

Teionr Teoodsill {Girmsinted Trondmilh
s R B (58 % of TR (1300
Wodowan 8P SRR 47

Feat Betalis: R Soimn B 18 i B ORHR
Yoot Sher My Ofles Fahninise thovmanlond. 340, 148 % grade 108 METY
Seftwsn DRS Cand Oandology Gulte T 405 Evercing Thoor 541
Reconder: e s (54 1000RERONGT00RER rov Ve Tesvination Reasoe
Sage  Toldl Phave S Elevaion  peed  Wak MR B fi g $Te e SfmaVis 378 ws
Time Time Time S itk WETE PPN teelgl PIB 1 B I AW AW A VI W W W W W
#FreTest
Figes TR R0 el % Et §R ]
4% ¥ s
PreTout
U e RERRTTER 6% F A A
Wonelp I i0e EE W
Expraise
: ERE 7R E11Y ¥ %

o BRI g 55

Evpgedi 5 BT, Fudne Blovsschenl, don. A8 g resetvedd SO0 Stensx EOH Newut Rapx
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1003 Stress ECG Summary Report

1803, Stress ECG Summary Report frtiicias Patient

&
1052 Maier Strowt  Nosistovwn PA 19403

BIHE06 GEI0  §90 080 $508 e, Thoresiy, Ol 3 20 A9

atient: Arthcial Patient i DEVO
: G Adirags:
Hetga B3
Pasmabar 38
Skl NA
Beribating: Tolophins
Referring Physician: 119
Fuiiaen:
Telphat
Test Detalis:
Tt Date: WRANEGHS, B A e
Freport fate: TS0, JES AN Seaewnd:
Seiters: GRE Cowd Capdiolons Suita B 4060
Resoeden gralid od (00 HIGAESOO0CUGNEN) rev W
C°“°§§§,§ Q&( Axiiiioisl Fatturd evrciesd on & Teadnil (Snudabod Troadmilly, The tisl exerise Hme was 81 sdmsden dorieg vhink the
RN 5 Gt TR, vt v B3 U o B e prslibed haigat fgd SF TR0 RN
S patinnt Patient’s resting howrt rate was F1. The resting thood proscons ves 133
o gt Postlsnd sumcermun saelon offor was 24wl he, 300 T grun [0 METal The saie o vy 333787, Tho s o
Prdastivamn MR « Bludaun B = S0,
£ &é@@'& ?&:ﬁiﬁ’s FO0G ahvorend & Keaets vty BT sdovaiion vadiation grovh o { mot. THooe o B, 30, aVF, W2, W3 V4 WS VR Th mssinia ST elovetion warkdion wee 2.5
rete ) 5048 U
% t 0 shosved 1 jowls with §7 ion weralion foes faen <1 s, T T S fadin vias 1.9 mm @ §
Physician's 8 Date
Somyaiphe B 30FY, Mt Bumniial it AFAORG reReres g ¢ w,&WMSWM
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1004 Stress ECG Summary Report (Classic)

L4, Seress FOCC Summary Report
L~ TING Cadish Lone  Murvistowm, FA 108
Thl: STOGEE-5610 Fax: GT0-GEG-GOF0
Patient:
dgwe M H “ipks o HA Ferily Ha
S Ha HZ Sk HA Alinead., Ha
Feeferred By:
Indicalions: Tesl Resulls: Brwe
= ToeadnllE e Tl n il
Mael =1 B 7LD o THR 7B |
Mxirwmr DF £ 20
1022014, 11:39 AM Fzorwm S0

EELEI T N ]

Moz mum L

Bilica Toal Phica Sloh  Elwallan  Spead Wtk HR Bl RPP iang:
Tine Tine Tine =l mithe  ETE) EPN  ImmHg) MOl Ganclusians:

ZAErs med on o Treadmill

ProTest This el e Ll s 2200 nalnin s chirlig

1 arbesiaed 4o Timnnl vt el 7 FPR, whiichrmas 50

I
& {fvE f{E ' oTtheage prdicted target beart re of 100 OFY

2B rnulated Trcadilll) “er 5201 minLces

Supire 0:F B5 D0 s an (K]

The patient s ECG i # Ll
rsaler than | These g I, |
i i ST ebevsbive waialivn was 28 o 80115 [V
The pateem 5 EGG shawed 1leads weh ST depression
Pz=that -1 mm. Thesears aWE. The maximum ET d=pressicn
walation was <1 mm g 1:00 [a¥3].

rakan

Fliyskelan's Slgimiture Dt
Drlgginial Report (not overread) - <0R3 Sard Cardiology
Suile (Enu 4,05k

Comments:

ST S I Pules BImede e AYeaiTe s, P ? 05, Fress O Fanakan Rapsr
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1005 Stress Stage ECG Complex Summary

ECG Stage Complex Summary
e i
Aoger 8 St HG  Paowne: Facuity: Studiustion:
Ratered By: et Tinde: SRGIC, 338 B g Dats: HHI4E010, 54 P
Pro-Tast Speod: 3 minls Qe 10 e el B8N e

T gt Fe o T

Papr @ A A o SOG Sasvpdne Bvomay
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1006 Stress Stage ECG Rhythm Summary

Stress Stage ECG Rbythm Summary

S B
Age G sl NG Facomaten 1 Famlly BA haadieion
Rsturved By T Do, FRR0I0, ALTPM st Dt 39182040, BRE T

PraTeal Gpmect 26 mania  Gaky Y0 me eV RY 80 me ATesml ovn ETex il oW s

Eaereivg Spesdi 2% s is Qa6 awmi o 874 o T e ATl oW (s

e E T, e e e VR RGO

[144]
CS406-10 Rev F Pub: 2013-07-16



QRS-Card™
4.06 Cardiology Suite Operating Instructions

1 PBI

1007 Stress Phase ECG Complex Summary

Stress Phase ECG Complex Summary

iy
Pamroken M& Senie N2 Haegeion:
Soeaxdog NA Mostab R&
st ot 20090, 43080 Bt ok AL, DB BN
Dnviae Troarinil Ekuidund Troptod

s

Frigued Broon
Hgadamn P D 1O % 0 THR (0002 §
577 o DR WA

85717
S ST 6.6 s g 100 J)
A faad 42 ine, WA % g G
Test Ve et Sampcane Tone WY
e

Totuivien:
eapost Dot SATH1G, 55¢ P1¢
% L

Tend Dot FRACHG, 420 PRt
| sotvor ;

e st e 6

Sl 08 swnle Gt 0 e S ey

{ Conclusions;  aveninsd un 4 Toeden (St Tosdeil The s 9043 S psh et af 59
HPM, b s B of ths dges prerbiisd el bivast rate of 120 8RN
R soont %y i wes 43 W% t T = s R
Movicraars B 2 B 89 o 13870,
f i gotient ot BT adoration sabalk s § e, Thaaware . T snarboons 37 el sistion o 08 ro 8 181 WL
i ot 6 HOT g o -1 e, Friose o | The minan ST digresnion voratie wss .7 sm 8 €17 Uk,
Physician's Sanature Srate
s e Fage 16 507, $ys Pt SUG Compr Siomey
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1008 Stress Phase ECG Rhythm Summary

Sitress Phase ECG Rhythm Summa

B
e 1 Ftgte R Bgonraker A Py HA axsion:
Bow B Welphts NG Swakiogy MR Mookl NA
e Tt Date: GURRI, 433 A Shepen Do BAGIRIG, B4 P
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Do Traariall ankoted Tomuaiel)

%

143 eairrs 0 1980
JR—— TL08 men @ 108 AN

Vet tetaisd Lo 4.2 i b, W80 % s A5 METE)
e S Wy oo Saviuidhn el Yoo BB Brssioa oo, 3043
§ Tenst Tt i, 430 Pt Rgpeat Db SIS0, S8 W Fproninsioe: Reate Paobios Qomsphitgy

|, Siftmer o83 o SRR (S

i ‘i:mgg w&% kil iw} ig}

Speed 26 mavie S 10 e S ol BY 6% ¥ urik: ram Bl uoie il i n

i YongEly. Yhe # S HOAE it i fit SR it vt ol

gt preteeli el et sty of 150 BN
aflcet v A2, 180 % grade {IRSRETNG, Tie 143177, S s DR
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il v, e, Page $7 0, Eroan Russ SO6 Ry Soway
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1 PBI

1009 Stress ECG Full Disclosure

losure

isc)

Stress ECG Full D

Foppoit Uit GG, 504 PR

Tewt Oute: RN, 4230

B
Mot
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1010 Stress Test Trends
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1011 Stress Stage ECG Rhythm Summary (3 lead)]

Stress Stage ECG Rhythm Summary
3 B
P 46 Wheight; H5 Bowdwgr NA Aochol HA
By: Towt Luer WHAD, L33 P Fapnt Dt IAENH0, Bla B0
Gpand: 12 ool e el B s ad AV A0 Bt ol vee R L

Fags 2 . S Siope BUE Siyoten Bueany {2 el
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1012 Stress Phase ECG Rhythm Summary (3 lead)

Stress Stage ECG Rhythm Summary

Age NG Fhsigv: M Pasemalen: & Fandy MR bstie: 3
i 1A Wisight NIy ook MR Moskek NA
Ruterrasd By Tust Date: FU2D40, 43T Fmpoet Dot FIAZ0I0, B84 Pt
Hawed 12 wuote Qe d mmiaV 60w Sroedimm  STaEeYis

fags 38 A2, Savesn Pive SN Sigehe Siovmy 0 e
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1013 Stress ECG Selected Segments

Stress ECG Selected Segments

Patient: PID:
Age: NG Height: NG Pacemker: NA Family: NA Mediation
Sox NA Waight: NG Smoking: NA  Aloohol; NA
Referred By: Test Dala: 9992010, 4:33 PM Regort Data: 9/1412010, 5:54 PW1
000
n V ¥ | ¥ i ]
e e fr- A Ak -
vy
S T L T v L L i - il L L L i v i - L
vs Pl I |
Rl S NI PRI NN PN PN (PP PPN PARPN FAIPY. ARSY NI PN IPNIDY P PN PN NN AN SN 7 S PN
Min. HR
oo, i
- i § | § | i H h ! | b ] i ] 1
U R VRN U WY VA U U U U U DU S U W U S VN0 T VA D0 Tt
AL
S0 S - . SR
Vs | | i i 1 } y i i ( § | ) [l | i
B[R PN U RS PRI PR PN Jn B PN L - H.’,,\ .F,,M B DR R D P N I N PR P N
Pre-Test: Supine ( 0:50)
A ! 1 ! ) 3 ) 1 1 f ) I 4 i | !
B e I L P |
vz
B B e B At (s et e S e At S A A At S St SR B S A
vE| R R T R R o
b [N § DR P PN B R R DA N P N P
Pre-Test: Supine ( 1:01) - stage advance
[ T o Voo
L S B N N N NN
vz
e ey e - e e —r—
J i i i | i | | i i i i b | i ] ] ] 1
vy | PR P, PR PN AR PN PN P .‘,,\ A e e PR PN PRI PR N
Pris-Tesst: Hypervant { D:15) - stage advancs
Wit A )
Vo ) Lo b T :
vz
e | SO — S S S S
P o P " \ | Lo
b 1R R R N N R R PO R Y U RN RO N VRO TR R Y T
| R NN AR NN PR AR PR D PN PN PN PN, PR NS P DA NN P

Pre-Test: Warm-Up ( 0:19) - stage advance
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1014 Review Screen

Patient: ID: Date: 9/9/2010, 4:33 PM

[ S U SN DU U DU DU DU S
SR U SR U U U DU W S

/IS Y WS U SO N SN S S
S W IS U U DU SO SU U S
IS VS U N U SU U DU S
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5 U IO U SO SV U W WU S |
SN WSO W IS DAY U W SO BN B

o b b

IEHEUEEERRnE. |EHEaeaR R CRERE S EEEae. Al rluain Tenlunr IRl I
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1015 Stress ECG Summary Report (Europe)

Pationt
Fhame
Sox: A Wit NG
Raow KA Age N
Referred By:
Indications Medication “Fast Inforsiatios
Catiection (e WRENG, 430 90

o Thia, 3451
Fxorclon Tre: 19488
Regoery Thns:

Aot $asd

mmwmmw[se%awmﬂ&m
Wb BTs: 0.6 e 38 $94 MY

Rasting 8.
b B9 M3 7Y
e MPTS 1UBED

PO
PRACIES 4
PROTHE
Conclogions:
svarsisad o0 % Trapdmil W?@ka} Thes totel anrciun s wan 1A g e honrt fate of S0 B, wihiel vuos 50 %
s’mw*mw‘ﬁtmu%d
4.2 b, 160 % grode BB METSL The , scan 193/ 77, Th oo v 10880
i MR « Sarieore BR w 12870),
mm&ﬂﬁmﬂ&fmmg?mmnmmnm&fm%nm Thesu e . Th

L3
4 o, These e . The madmen 57 WWW-&?M@1 47 43,

fagn 98

D1 Ssans B00 By Rt Barops
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3 PBI

1016 Stress Stage ECG Rhythm Summary (Classic 3)

Patient: Arificiel Patient “Yest Dutaits: Srip Detalis:
Pit DERO Fees o iy Gl Taatmivise: Phusias 3 Errsioi Phase Taow 038
e NG ol MO Pantraion MY iy b Yeut Dt b 221 A Do HYEENG, B0 AW f METR 00
SecHR OB Stk R AdnGo MA < GRS s R, S o

” - Yreadmif) Tt
Bapdon FI 96§51 % of THRE
Iatirss HR 160 BP .. ok T —
R T 2.6 i U4
Eeasuremerts Curent MeaswromentS  paiicecs s 3‘",,&',@&5,*%,%
bl it v ot Tuos: 154 Seonisn s B4t

Bexd

Boe §

@ P ORECard Digitad PCEOG Muchine wwergrscardoom 3 16106683518
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1017 Stress Stage ECG Rhythm Summary (Classic 12)

Pationt: Arficlal Pationt Tast Datails: =3
PEY 0RO Pirona § o Tast Fhaos Time BUT

Yoot Sa: 34y Dffe Tockalpton:
Agn NG HegHENG  PatemelonNA  Samie A st Uit OETDIE, 2100 Fovon Dt H0QMI0T, £5094 Siage: 87 S HETS 08
B A Waight: NG Semokog A AoR B ot GRE Dord Cordk e 4.0 i [0 e, B0 % e
Ruferred By: otk I Ve Yest Resulls:
Meicatier: St T Lo Foradnodt irdond
Yroeadit)
v FIE 9553 % of THIL (1603 |
Tty HR 77 Kiimaran B2, 137 87 .y
P Sdasiosm 87 2.9 pon 8 0:48 (v
v . R, 140 3
P 10m #R: % T Time: 157 Exarcive Tene: G41
ORE: 82 e : Terminatys Resan:

S I B e 35
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1018 Stress ECG Real-Time Report

PH: 48 ma
YOG s 588

A e R T T

i e

@ PBE QRSCord Digiiad PUECG Mochine wewgrweardcom + Lalg-660-3319 Hox 7 e d
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Appendix 5: Holter Sample Reports

13000. Holter ECG Summary Report

13606, Holter ECG Summary Report Artificial Pationt
i‘,"‘ I W-ﬁ&‘&’? MM@W A EPET

BOGKE NG G0 B ARG

fient  Artificial Patient 1D: DEMO
gy G o MA A
Hsigat Fowght: 1
Pacamaban w Faeily: N4
Semokies B Aioohol: Mk
sdiation: Telsphon
Referring Physician: DR OMED [ e
pro—.
Teleghana:
Test Dotails:
Fast Duter 412BKN, K37 A Hoskip: $00
Hepor Date: SVIRING, £56 404 :
Sttording Playvician:
Sotronere: P Holier
Frgaciag: S8 OEN0 (SN BAADEMD) ey vOL.OD

QCO 1 itoagd for 200 bows, 200 houes word snyaed, Duieg s gt s 71, with
Qﬁﬂiﬁﬁﬁmxsgwwmmswmaswsmmm MWMQWWWM;’%WR -

The pasien 3 prad G
vﬁﬁwﬂmwﬁ . comirico % R, A SR EITI0 AN (D sl He fislent s bl 3 asie of Gl @ B3T3 M

Pt boal shuaed Q smpmoventicater estopin bovis (256 et antopis hewt rse, The bogost v fad § boats ]
g&n snmct;wmfwewmshmmswwsgmtf 540 (.

Date

T
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13010: Holter ECG Result Summary Report

Antificlsd Patient

130140, Holter ECG Result Summary Repert
iy

e
EE R Swae Meetenen P MREE
SOSOOG OO M9 85

atient:  Artificial Patient 1D DERO
Sgw: WG Sddra:
Hisght NG
Pacaeakos N&
Savoking. NA
Tdupiunng:
Referring Physician: DR OMED 2
Sdshess:
Telephummn ¥
Test Details:
Tt Dude: ATEWE004, H37 Al Haskag: EOO
npar Dt THOEI0I0, 538 Ak Sorm:
Sedssre P bollar Durion: 296
ooy PHI DB (58 WRINDER o VOO
Heart Rate Ventricular Ectopy Supraventricular Ectopy
Ansags: ot B § Foteh G~ Tetak
S S$ITIAM D Tsodnted ssokuted O
[ - AT S [ e 5
Pause Runs Runs
Foeu Toteh & Brats & Yesd & [
o o & . Langaes & - Lnngows: N
Faghsat & * e 3 *

Conclusions:  Astificial Patient was monitorad for 200 howes, 2:00 hows werve analyzed. Dwing this time the average
ot rate was 71, with a miniuwn heert rate of 84 ot @ 814126 AM (1) and 2 masimum heset e of 109 at & 9:45:09 AY
13 The pationt hed D pauses graster than 2.0 seconds.
& patient Artificial Palient's tesd showed 0 (0.0 %) vantriculer ectopic beats. The patient had 0 isolated ventriculsr sclopia
beats, O paired ventriculr sttopio beats and § ventricular octopic beal runs. § beats wem s vendrouler sctopio beat runs.
iThe Jongost run hed © boats 8t @0 8:37:13 Al {1) and the fastost run had & rato of O ot @ 8:37:93 AM (1),

The patiant Artiticial Pationts test showed 0 supraventriculsr eotopic beals (25 % prematurily). § beats wers in
sugraventricular ectopic beat runs. The lingest run had § beats 88 @ 5:37:13 AM (1) and the fastest run had & rate of 0 8t

i 89713 AM (D),

Date
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13011: Holter ECG Result Summary Report B

13011, Helter ECG Result Summary Report B
Sly Sdtfen
G52 Main Strost Nowristown P8 13402
FI0806 5510 510466 8508

Gphie
Adidress

V-Run i SV-Run &

Paiv 0 SVEB @

VEB L Pause @

hoart vate of &4 i

| venivitular eutops 3
ophe beat mans. The longess run bad

Fhe pasient Artifichat
coropic bont vuns. Th

RS, Hoder HOS Meael Suesny Suson 8 P ¥
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13020: Holter ECG Hourly Summary Report

Pationt:  PATIENT NARE it DEMOPAY Do 4132004, B37 AM
Holter ECG G I Hourly ry Report
Bt ML HR Avg BR O Blax BF Tolpi Bewt VE Beatl VEPEY VERu SVE Bedl SVE Papr SVERun  Pause Charation  Regest
i §4 a6 1883 2 & -] 1 & aar foa]
s L L] - & 9 & R
#® & b 4 & 4 3 < L Ry
Fotat (23 % 1 43 P 16 ] & kS 1 3 &
Piveed BRI, 1S AR TR Moder BUS ey Sommry ey P d
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13030: Holter ECG Trend Report

Patient: PATIENT NAME i DEMOPAT Date: $/13/2004, 137 AN
Holter ECG Trend Report
i o b
i\wmginmnfme‘rrsnﬂ
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ia
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S ——— Ehao 1 87 Trang
=
-
-
fe
*
n:mmm Bash s ) SIS ARG SO AR T FECR T Free Tt
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Shorasel 331 Trend
- gnn
-
n
fo
s
abaREET SR E A : € fr
gt Vime D
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13040: Holter ECG Selected Segments Report

Patient:  PATIENT NAME 1D: DEMOPAT Date: 4/13/2004, 3:37 AW
MHolter ECG Selected Segments Roport
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13041: Holter ECG Selected Segments Report

Patient:  PATIENT NAME 2 DEMOPAT Date: 44132004, 8:37 AM
Holter ECG Selected Segments Report

[163]
CS406-10 Rev F Pub: 2013-07-16



QRS-Card™
NN PBI 4.06 Cardiology Suite Operating Instructions

13050: Holter ECG Full Disclosure Report

Patient:  PATIENT NAME ID: DEMOPAT Date: 4/13/2004, 8:37 AR
Heolter ECG Full Disclosure Report
Ll ; AT

IR

REF M

S

P RS, DS AN SIS, Haher DO Fu¥ Daskesss Repdt Fage st
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13060: Review Screen
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13070: Holter ECG Result Summary Report (pacemaker)

QRS-Card™

4.06 Cardiology Suite Operating Instructions

13070. Holter ECG Result Summary Report (pacemaker)

My Office

1062 Main Streer  Norrisiown PA 19403

G610 668 5510 610 646 5508

Anrtificial Patient

Patient: Artificial Patient |D: DEMO
NG Sex: NA Addrass
Height: NG Weight; NG
Pacemaker: HA Family: NA
Smoking: MA Aleohol: NA
Medication: Telephane:
Indications:
Test Details:
Tesl Dale: 41132004, 5:37 AM Hookup: EDO
Report Date: 10/28/2010, 8:56 AM Seanned
Software: PEI Holter
Recorder: PBI DEMO (SM: IAMADEMO) rev V1 .00
Pacemaker Details:
Total Pacad Beats: O { 0.-1%)
Adrial Paced Beals: 0 (0.-1%)
Veniricular Paced Beata: 0 (0.-1%)
Both (AV) Paced Beats: 0 { 0.-1%)
Captuie fallures: 0 Sense Fallures: 0 Inhibition: &
Heart Rate Ventricular Ectopy Supraventricular Ectopy
Average Total Beats: 0 Total: 0 (-) Total 0
Minimum: 8:37:13 AM (1) isolated: isolated:
Maimum: 83713 AM (1) i i
Pause Runs Runs
Total: 0 Total: 0 Beate 0 Total: 0 Beate 0
Maximum {ms): 0 . Longest: 0 - Longest: 0 .
Fastest: 0 - Fastest: 0 -

Copclusions:  Aificial Patient was monitored for 2:00 hours; 2:00 hours were analyzed. During his tima the average heart rate was T1, with 3 minimum heart rate
S2PREMHELAMT) and o madmun hear rate of 108 af @ :45:08 AM (1), The palient had b pauses gealer than 2.0 seconds.

he patient Artificzal Patient's test showed O (0.0 %) ventricular eclopic beats. The patient had 0 isolated ventricular ectopic beats, 0 paired ventricular ectopic beats and 0
bentricular ectopic beal rurs, O beats were in ventricular ectopic beal runs. The longest run ad 0 beats al @ &37:13 AM (1) and the faslest run had a rate of 0 al @ B:37:13 AM

CS406-10 Rev F

he palient Artificial Patient’s fest shovred O supravantricular ectopic beats (25 % p ity). D beats were in sup icular eciopic beat runs. The longast run had O beats af
B 5:37:13 AM (1) and the fastest run had @ rate of 0 al @ &:37:13 AM (1),
Physician's Signature Date
S——— S —
‘Printed: 10:28'2010, 8:56 AM 13070, Moller ECG Result Surmmary Repart (pacemaker) Page 13
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13080: Holter HRV Report

Fatient:  PATIENT NAME {0 DERQPRAT Diater $032004, 8:37 AW
HRY Time Domam Summary
SO Bl 5 SORD e 3F
SusNS ey T EE Couet 353
gveic SN0 Ay 320
TR bdox s 2%
88441 Total Beats gﬁi&t‘: Nornal Beats 116 VE Beats 78 SVE Beats
&l b § § :
® E 2 81 S8
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& @8 2 58
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13090: QT Report

Pulionl:  PATENT NAWE B DENGPAT Prgdec 11375004, 537 AW
Hotter ECG QT Report
Start Beals HRav QTwn QFay Gk Qs QTcb QTcs QTch QTOF <360 <330 <380 <420 <460 <800 <38 >&38
RETE TR w5 il a1 Ll & a3 Rl e AXF @ @ * s Ld @ & &
SO A0 ® 414 A4 A4 @ AR w34 431 A5 @ @ 2 A & @ 8 @
ARy AR 0y PR k2 A4 A4 Rl @ 87 w34 w3 -2 o L @ o i o B o

Totdd W45 83 41 4M 4 § 0 BT 1R 7 e @ e ® ww & @ &8
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g

83
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23
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207 P g Loy 337 Bh 41 ) 37 8t (1 27 A £
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13180 Holter HRV Spectral Report

Patient:  PATIENT NAME i DEMOPAT Date: 41312004, 3:37 AM
s o
Total (eay 1944
VAF gy 1487
LF ey 4
frig e
Circadian Plot
5 e e W - Tawe - e - Beee) .
g 8
oA
% ; ‘ ;: .
£ 1T 8,
1N | {
B, Il £
= §
g b
= & R
Mlﬁﬂz R R A B {1 &‘?&?&ﬁ} ﬁ@mﬁ A 08 &wh&ﬁ

Foisnd BILIG, FAE AR SRR, Hoder SRV Spestrat Ragort Page 28
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Appendix 6: ABPM Sample Reports

12001 Standard ABPM Report

Ambuiatory Blood Prossues Rezults

Db WI00Y, 843 80

Fhorsicians Hotps

v of Alt 5t g of Dy sy of Night
S0 Range Hess o Range Hoan S0 Hangs
Hysinlie 18 1w L Bystobe 1Y £ 20 Systole 0¥ 1 B 188
Dlastolis 89 % 8112 Glastolic 25 A 571402 Giastolis 78 it 85-v1d
Mas 94 1% R Hap E ;s 61182 Ay £ i Y
Polss Rate 71 w @ Puine Rate 72 Ril E LR Fuine Rate 8 13 2.1

B[00 1330 10 28130
Blevsd Presunre Distetation
$ B svestotts By
2 Sshely Wﬂ twatatic Nkt

40
or o

B sy P » 148 matg: 8 %
A3 VT me i TG LI~ LI g 4 T
330 g A 0% < 38 el B3 %o

pal

Diastotic {81} Diastolic (Day} Diastodic (Nm)

oL

Messaremety (%)
30

91

B BB P ,::Q ®_®

-
PP Z
@ ® LA R >wm » % Dyt 3
Biousd Prossurs Resge {mmbg) <mmmﬂq dvﬁ mﬁf&m.
ot LSRRI, 2L AN FHRY, Shmonard A gt Fageet

12002 ABPM Trend Report
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S
Arindatory Bioes Pressure Resulle
e Tod Paiondt
8%y

Age
Disgrensin;

Mediations Used:

v of Al 8 Sunwmnary of Day
Benn el Rawpe o 5 R
Bystolic 19 £ f4.am Byetolie 1 820
Diastolic A% i & 142 Plastolic 83 % A4
Hag W i R Map ® % [0
Pulve Rate T 17 £ 102 Pulue Rate 72 1 9.1

Systolic and Diastolic Blood Pressure for the Monitoring Period

HR o~ Sy e - MAY

[

i 1] ¥ B ¥ i i
17:00 21:30

ot PR S8 RN RO AN Tonns St

CS406-10 Rev F

Bystebe 107
Diagtodie 70
AP o
Pulee Raty 62

Pogad
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12003 ABPM Distribution Report

0

Ambadatory Blood Presaure Ressts
Mt Tast Pallead Dty YO0 BAS A8
Sge By ofored By
{Bagiranin Fhysivien Mutes

AR R

of &1 et y of Day satival S yof Night
Baan o] Rusge Wewn se Rangs Haus o) Range
Systeke 1 @ B3 Systolie 1 W 420 Sysielis WY 13 W
Dlewtolic 8 1% H e Duastolc 8 £ 512 Digstole 78 1 31
Map b i Bt AP 5 @ 80453 HAP & 11 Gt
Pulse Nate T @ 52182 Puisn Rate 72 L L e Pulse Rate 66 3 E-I
Blood Prsmsare Dstrilation
Systolic gt Dastasic Mgy
8 8
ag
g &
e
s &
; & 5
2 B
© ®

Blood Prosumre Range {nenbg)

Fiodt TOEE, 16 PY RIS ARER Do St P 3
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12004 ABPM Pie Report

b WINBNY, Ba8 A
s

y of Al s wvnary of Dy 8 : of dight & S

Eo e Range Hean S Hange Bdgun B Range

Bysalle W 0 B2 Systedle 1 18 B-25¢ Bystedie 0¥ 13 B 188
Dhastele © 6 FER L 3 fHawtole 38 % B8 Dlastdle 75 ¥t Gt
MaPR o W w1182 AR L @ ot 182 MaE o8 1 LS
Pudve Rete 71 E &1 Puise Rate 72 i PE- 1 Puise Rate 0% E Bew

Systalic (Night)

> 198 mmby: 7% > 39 mmH: 8% @ » S meBg ine @

220 - 130 mmbg: 32 % 120 - 139 meeky: D W Uk 10 - 135 perabiy 26 08 1

< 120 runHa: 61 % < 120 g 53 % & 110 mmbiyg: 63 Yu §
Diastolic (Al Diastolic (Day) Diastolic {Night)

S
S

> 89 mmitg: 18 % >89 mmig 20 % @ >79maHp 3% §
80 - B9 meHge 209 4 80 - B owebg: 38% 08 TO - 79 eyl 839% &
« 80 mndg B30 L) « 80 mmbg: 429 OY 70 by 26 %
Felenest W0, TR PR 200 AR N Rapowr Faged
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12005 ABPM Hourly Summary Report

0

Ambulatory Blood Pressure Results

Narne: Teet Pationt Date: 5/7/2001, B:45 AM
Ager BTy Referred By:
Diagnosis: Physician Notes

Madications Used

ABPM Hourly Summary Report

Start  Systolic Diastolic MAP Pulse Rate RPP Number Duration
COAM(T) 117 a2 93 62 7284 2 1500
BOAM(T) 118 80 91 59 8004 4 60,00
WOAM (1) 132 98 108 59 908 4 8000
0OAM (1) 118 a8 98 72 8588 3 60,00
COPM (1) 124 85 EH) 92 11408 4 8000
QO PM (1) 107 7 86 76 8132 4 6000
COPM (1) 142 7 E] 75 8400 5 60,00
COPM (1) 123 78 92 73 BI85 6000
COPM (1} 112 79 89 50 6720 4 60,00
COPM (1) 135 100 1z B4 8840 3 6000
COPM (1) 117 83 a7 62 7254 4 6000
WOPM(1) 132 83 106 70 9240 3 60,00
COPM(1) 131 93 105 80 10480 5 ED00
QOPM(1) 124 7 o0 73 o524 €000
TOPM(1) 122 85 o8 77 EECTR £000
MOPM(1) 102 7% EX] 61 6222 2 £0.00
WOAM(2) 108 73 84 63 sa04 2 60,00
TOAM(2) 105 7 a2 &1 6405 2 6000
WOAM (2} 102 69 79 61 6426 2 €000
TOAM(2) 101 68 79 53 5153 2 6000
TOAM(2Z) o6 7 a1 72 612 2 €000
00 AM (2} 94 62 72 82 5828 F €000
COAM(Z) 111 a2 o1 70 0 4 £0.00
COAM(Z) 123 a5 o7 74 sz 4 000
COAM(2) 128 a1 o8 &7 8175 3 5200

* - indicates night measurement

Printed: 12010, 52 PM 12005, ABPM Mourly Summary Repor Page 5
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12006 ABPM Measurement Report

0

Ambadatory Blood Pressure Resulls
Sk Tasd Patent outer BEROY, BAR AR
apu BTy Safuoreg By
Dagnosis: Shygicion Holes

Hudinstions Used

ABPM Measurement Re,
St SysioleBlastalic MAP Poler Rate RFP Siamis  Comment
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Appendix 7: Stress Protocols

PBI has designed its Stress Protocol for maximum flexibility. Users can select a
standard, predefined protocol like Bruce, Modified Bruce, etc or they can define their
own custom protocol.

Protocols supplied with QRS-Card™ Cardiology Suite consist of three Phases (Pre-Test,
Exercise, Recovery). Each Phase is subdivided into stages. Each stage can have a
number of events associated with it (Ex: take blood pressure, increase elevation, increase
load, print ECG segment).

Note: Within the Pre-phase user intervention is required to move on to the next stage.

i Protocol Update [
File Stage Help
T2 10wl /1 Min Phase Stage Durstion [s] | Speed [MPH) | Elevation (%] | METS | ~
T4 25Watt /1 Min. PreTest  Supine oo oo 1.0
; Hypervent == 00 00 10
L 2owran s 20 wamllp = 15 o 21 Display Oiptions
12 50 wiatt / 3 Min.
& Erercice 1 1:00 a3 0o 35 |z
Ealke 2 100 33 10 10 W) Take BP
-~ Bruce 3 1:00 a3 20 44 )
Fiint ECG segment
5 Bruce (Eche] 1 1:00 33 a0 13 & &
1%, Dobutanine z e 2 o gg I 5ave ECG segment
= Eleatad 7 100 33 60 63 1| Save reference ECB
= Kattus 8 1:00 a3 7.0 67
~ Modified Bruce L] 1:00 a3 a0 7.2
= Naughton 2.0 10 1:00 33 a0 w8 -
~ Naughton 3.0
= Maughtan 3.4 Balke Treadmill Protocol
I, Persantine e )
® -1
2 m
E° o
i ] H
- &
H H
i 3
_I_‘
) ,_l_'_'_ l ]
B i c
o 5 10 15 20 25 30
Protocol Time (min)

Phases and Stages
1. Pre-Test

o Supine-
= ECG monitored/acquired during supine stage.
= User must click the ‘Advance Stage’ button to move to next stage.

o Hyperventilation
= ECG monitored/acquired during hyperventilation stage.
= User must click ‘Advance Stage’ button to move to next stage.

[176]
CS406-10 Rev F Pub: 2013-07-16



QRS-Card™
A PBI 4.06 Cardiology Suite Operating Instructions

o Warm-up
= ECG monitored/acquired during warm-up stage to check the
quality of the ECG/ lead placement
= User must click ‘Advance Stage’ button to move to next stage.

2. Exercise
o ECG monitored/acquired during exercise phase.
o Usually this phase consists of multiple stages (ex: Bruce protocol has 8
stages).

3. Recovery
o ECG monitoring after completing of the exercise phase
o Usually this phase consists of one stage.

[177]
CS406-10 Rev F Pub: 2013-07-16



QRS-Card™
A PBI 4.06 Cardiology Suite Operating Instructions

Appendix 8: Corporate Summary

Pulse Biomedical Inc. (PBI) manufacturers PC-based electrocardiogram (ECG/EKG)
products. PBI is located outside Philadelphia, PA, USA and has a European office
located in Germany.

PBI designs, manufacturers and markets both the hardware and software components of a
diagnostic, twelve-lead ECG system for use with a Windows personal computer. PBI
QRS-Card™ Cardiology Suite was the first FDA approved PC-based ECG system,
receiving approval in 1991.

During the initial years, PBI invested in research and development while establishing a
corporate presence in the ECG marketplace through exhibiting at the American Heart
Association and American College of Cardiology conferences.

Through research and development Cardiology Suite has progressed from a separate,
DOS based insert able PC card to our newest FDA Bluetooth/USB system.

PBI owns all proprietary hardware design and has complete ownership to the source code
for Cardiology Suite software, including its own Automatic ECG interpretation
algorithm, Automatic ECG measurement algorithm, high-resolution signal averaging
algorithms and Holter ECG analysis algorithms.

PBI sells its products through independent dealers worldwide. QRS-Card™ Cardiology
Suite is used in over 50 countries worldwide and has sold its products on an OEM basis
to a number of companies.
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Appendix 9: Glossary

° ABPM Ambulatory Blood Pressure Measurement

° Bluetooth An open wireless protocol for transmitting data over short distances

° ECG (Electrocardiogram) Electrical signals generated by the heart muscles
o USB (Universal Serial Bus) Serial communication protocol for

exchanging data between a host controller and a peripheral device

° Hardware Describes the physical components of a device

. Software A general term describing computer programs: applications,

libraries, etc.

° Firmware Software specifically written for a device.

° PC Personal computer. Can be notebook, desktop, etc.

° MCU Micro Controller Unit
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Appendix 10: Guidance and Manufacturer’s

Declarations

QRS-Card™ Cardiology Suite system needs special precautions regarding EMC and
needs to be installed and put into service according to EMC information provided in

Appendix 10.(892]

Portable and mobile RF communications equipment can affect QRS-Card™
Cardiology Suite system.[Bo3]

Table 1:

Guidance and manufacturers declaration — electromagnetic emissions[B94]

The QRS-Card™ Cardiology Suite system is intended for use in the electromagnetic environment
specified below. The customer or the user of the QRS-Card™ Cardiology Suite System should assure

that it is used in such an environment.

Emissions Test Compliance Electromagnetic environment- guidance

RF emissions Group 1 The QRS-Card™ Cardiology Suite system uses RF

CISPR 11 energy only for its internal function. Therefore, its RF
emissions are very low and are not likely to cause any
interference in nearby electronic equipment.

RF emissions Class B The QRS-Card™ Cardiology Suite system is suitable for

CISPR 11 use in all establishments other than domestic and those

Harmonic emissions Not applicable directly connected to the public low-voltage power

IEC 61000-3-2 supply network that supplies buildings used for domestic

Voltage Not applicable purposes.

fluctuations/flicker

emissions

CS406-10 Rev F
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QRS-Card™

The QRS-Card™ Cardiology Suite should not be used adjacent to or stacked on other
equipment and that if adjacent or stacked use is necessary, the QRS-Card™ Cardiology
Suite system should be observed to verify normal operation in the configuration in which

it will be used.

Table 2:

Guidance and manufacturer’s declaration — electromagnetic immunity

The PBI QRS-Card™ Cardiology Suite system is intended for use in the electromagnetic environment
specified below. The customer or the user of the PBI QRS-Card™ Cardiology Suite system should assure
that it is used in such an environment.

Immunity Test

IEC 60601
Test level

Compliance level

Electromagnetic environment-
guidance

voltage variations on
power supply lines

IEC 61000-1-11

40 % U, (60 % dip
in U,) for 5 cycles

70 % U, (30 % dip
in U, ) for 25
cycles

<5 % U;(>95 %
dipin U,) for 5 s

Electrostatic + 6 kV contact + 6 kV contact Floors should be wood, concrete or
discharge (ESD) ceramic tile. If floors are covered
+ 8 kV air + 8 kV air with synthetic material, the relative
IEC 61000-4-2 humidity should be at least 30%.
Electrical fast + 2 kV for power | Not applicable No power supply lines
transient/burst supply lines
IEC 61000-4-4 +1 kV for Not applicable Input/output lines < 3M
input/output lines
Surge + 1 kV line(s) to Not applicable No line(s) to line(s)
line(s)
IEC 61000-4-5 Not applicable No line(s) to earth
+ 2 kV line(s) to
earth
Voltage dips, short <5 % U, (>95 % Not applicable No power supply lines
interruptions, and dip in U,)

Power frequency
(50/60Hz) magnetic
field

IEC 61000-4-8

3 A/m

Power frequency magnetic fields
should be at levels characteristic of a
typical location in a typical
commercial or hospital environment.

NOTE U, is the a.c. mains voltage prior to application of the test level

CS406-10 Rev F
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Table 3:

Guidance and manufacturers’s declaration- electromagnetic Immunity
The PBI QRS-Card™ Cardiology Suite system is intended for use in the electromagnetic environment specified
below. The customer or the user of the PBI QRS-Card™ Cardiology Suite system should assure that it is used in such
an environment.
Immunity IEC 60601 test Compliance level | Electromagnetic environment- guidance
Test level

Portable and mobile RF communications equipment
should be used no closer to any part of the PBI QRS-
Card™ Cardiology Suite system, including cables,
than the recommended separation distance calculated
from the equation applicable to the frequency of the

transmitter.
Conducted RF | 3 Vrms 3 Vrms Recommended separation distance
IEC 61000-4-6 | 150 kHz to 80 MHz d=12P
Radiated RF 3V/m 0.81V/m d = 4.3 P 80 MHz to 800 MHz
IEC 61000-4-3 | 80 MHz to 2.5 d = 2.3 P 800 MHz to 2,5 GHz

MHz where P is the maximum output power rating of

the transmitter in watts (W) according to the
transmitter manufacturer and d is the
recommended separation distance in meters (m).

Field strengths from fixed RF transmitters, as
determined by an electromagnetic site survey®
should be less than the compliance level in each
frequency range®

Interference may occur in the vicinity of
equipment
marked with the following symbol:

()

If you experience ECG signal distortion, please
contact Pulse Biomedical Inc technical support
team for guidance.

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by
absorption and reflection from structures, objects and people.

Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land

mobile radios, amateur radio, AM and FM broadcast and TV broadcast cannot be predicted theoretically with

accuracy. To access the electromagnetic environment due to fixed RF transmitters, an electromagnetic site

survey should be considered. If the measured field strength in the location in which the PBI QRS-Card™

ECG is used exceeds the applicable RF compliance level above, the PBI QRS-Card™ ECG should be

observed to verify normal operation. If abnormal performance is observed, additional measures may be

necessary, such as re-orienting or relocation the PBI QRS-Card™ ECG

Over the frequency range 150 kHz to 80MHz, field strengths should be less than 3V/m

a
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N OT’ CE A Note About Electromagnetic Immunity:

The PBI QRS-Card™ provides high quality ECG at the expense of RF susceptibility. This position is justified twofold:
1) The morphology of the ECG waveform is maintained at the highest possible quality level. 2) Users of the QRS-
Card™ are trained medical professionals that recognize ECG artifacts including RF interference, and thereby make the
ne ssary corrections.

All semiconductors and ICs, whether analog or digital, demodulate RF signals: a process sometimes called audio
rectification. Digital circuits exhibit more noise immunity than analog circuits. Highly sensitivity patient coupled
analog circuits, such as those used in ECG devices, exhibit the least noise immunity.

It is possible to design analog circuits to demodulate less RF signals, but the problem cannot be eliminated. Shielding
and filtering techniques reduce the levels of those RF signals that actually get through to the circuits. Shielding is
never 100% effective, which forces the design into analog filtering. Analog filtering of cardiac signals distorts the
morphology of the ECG waveform. Analog design requires a tradeoff between maximum signal quality and minimum
RF noise. The PBI QRS Card™ uses minimum analog filtering to produce the highest fidelity ECG morphology, the
tradeoff permits higher RF signal noise. The improved ECG signal quality justifies the increased RF susceptibility.

Users of the PBI QRS Card™ are trained medical professionals. These experts recognize interference from RF sources
and identify interference on the ECG waveform, both during acquisition and when reviewing collected data. In
addition, experts adjust electrodes and prepare the patient to minimize RF interference, motion artifact and other
external interference for each test. This fact lends credence to the idea that increased sensitivity can be maintained in
the device, while maintaining safety and effectiveness.

Hand-held mobile transmitters (such as walkie-talkies, ‘handyphones’, cellphones, radio-telephones, mobile phones,
etc.) use up to 4W of RF power and can be close enough to expose equipment to electric fields in excess of the 3V/m or
10V/m typically required by medical equipment EMC standards. Mobile transmitters used by the emergency services
can be up to 10W RF power, whilst (legal) vehicle transmitters can be up to 100W. These facts point out that there is
no safe level of EMC immunity, as transmitting device become more powerful and portable.

Due to the ubiquity of hand-portable and vehicle mobile radio transmitters, this is a common problem which very few
EMC or safety standards address.
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Table 4:

Recommended separation distance between portable and mobile RF communications equipment

and the PBI QRS-Card™ Cardiology Suite system

The PBI QRS-Card™ Cardiology Suite system is intended for use in an electromagnetic environment in
which radiated disturbances are controlled. The customer of the user of the PBI QRS-Card™ Cardiology
Suite system can help prevent electromagnetic interference by maintaining a minimum distance between
portable and mobile RF communications equipment (transmitters) and the PBI QRS-Card™ Cardiology
Suite system as recommended below, according to the maximum output power of the communications
equipment

Rated Separation distance according to frequency of transmitter
maximum m
output
power of 150 kHz to S0MHz 80 MHz to 800 MHz 800 MHz to 2,5 GHz
transmitter
d=12VP d=43\P d=23VP
w
0.01 0.12 0.43 0.23
0.1 0.37 1.4 0.74
1 1.2 4.3 2.3
10 37 14 7.4
100 12 43 23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters
(m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output
power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and
reflection from structures, objects and people.
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Appendix 11: QRS-Blue™ Specifications

Addendum 3- Specifications
Resting and Stress Digital ECG Machine:

Channels

Size

Weight

Sampling rate
Digital Resolution
Input dynamic range
Input Offset Range
Frequency Response
CMMR

Input Impedance
Defib protection
Operating Temp
Storage Temp
Relative Humidity

ECG Leads
Connection
Power: USB
Bluetooth

Output Port

ECG Measurements
ECG Interpretation
Data Storage
Printing

Reports

Email

Screen Format
ECG Speed

ECG Gain

ECG Filters

CS406-10 Rev F
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:4.07x2.5”x 1.07 (101.6mm x 63.5mm x 25.4mm)
: 4.5 ounces (127.6 grams)

: 240Hz, 500Hz 12 ch.

:5uv

: 10 mVy,

: £ 300 mV

:0.05 to 150 Hz (- 3dB)

: -60dB (minimum)

:> 100 MQ

: Integrated

:0t040°C

:-10to 50 °C

: 25 to 95 % noncondensing

Atmospheric Pressure :

70 to 106 KPa

: Detachable 10 Lead (Banana or Snaps)

: USB cable or Bluetooth

: Self (Internally) powered via USB port <100mA

: Internally powered from 2 AA Batteries <100mA, Range up to 10

feet (3 meters)
Minimum Operating Time with 2 AA Batteries = 20 continuous hr

: TTL or Analog

R wave or Non-diagnostic ECGLead selectable
Default Gain 1000

: Automatic

: Automatic

: PC Hard Drive, Flash Card or SD Card

: Laser / Inkjet; Color or Black & White

: Multi-format; user customizable; PDF

: Microsoft® Outlook or MAPI compliant

: 1,3, 60r 12 Leads

5, 10, 25 mm/sec

15,10, 20 mm/mV

: Digital — 50/60 Line frequency; Muscle tremors 40 Hz

Baseline drift
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Database : Faircom C-Tree
File Format : Industry Standard SCP (Standard Communication Protocol)
or DICOM, HL7, PDF, TIFF, BMP
EMR Interface : Multiple EMR Software Interfaces
Warranty : 1 year on QRS-Blue™™ Device, 90 days on accessories
Medical Class : Class IT

Type of Applied Parts : CF

Minimum System Requirements:

Computer : PC with Windows® XP or Vista (1GB or higher RAM)
Monitor : Color / TFT, Min. Res. 1024 x 768
Printer : Color or Black & White
Connection Type
Needed : USB Port or Bluetooth
[186]
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Appendix 12: Service Instructions / Technical

Description

Introduction

PBI QRS-Blue™ ECG device converts a computer (PC) or a handheld device (Mobile
Phone) into a 12 lead Resting and Stress Digital ECG machine. Connection between
QRS-Blue™ is done via computer USB port or done wirelessly via Bluetooth Interface.
ECG’s can be viewed in real-time on the computer screen or hand held device. ECG data
can be stored on the local memory or can be transmitted via Internet connection. ECG
reports are printed via computer attached standard printer.

Theory of Operation

During an ECG, the electrical signals generated by heart on the body are transferred from
the electrodes to the electronic circuit (ECG machine)

QRS-Blue™ is designed using sophisticated electronic surface mount component
technology. Low voltage heart body potentials (ECG) are amplified by QRS-card BT
circuitry and then digitized before sending it to the computer. A low power micro
controller digitized the amplified ECG analog signal, formats the ECG data and transfer
the data to the host computer via USB or wireless Bluetooth connection.
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QRS-Blue™ consists of following:

DB15 10 Lead Patient Connector
Defibrillator protection
Analog Bandwidth .05Hz -150 Hz
Input Buffer Amplifiers (x 1)
Amplifiers
a. Stage 1: Differential Instrumental Amplifiers ( x 5)
b. Stage 2: Operational Amplifiers (x 16.4)
c. Stage 3: Operation Amplifiers ( x 2)
Hardware R-wave Detection
Hardware Pacemaker Detection
Micro controller with Analog to Digital Converter
Sampling of 240 Hz (8 channels), 500 Hz (8 channeld) or 1000 Hz 4
Channels).
10. TTL R-wave Trigger signal out (Opto-Isolated)
11. One Channel Analog ECG Trigger Out (Pulse width modulation out)
12. Optical Isolation
13. Power Isolation
14. USB data connection
15. Bluetooth data connection
16. Battery Fuel Gauge
Patient Connector:

Nk

e e 2
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The QRS-Blue™ uses a DB15 Female connector for connecting a 10 lead patient
cable. Pin configuration for this connector is:

Pin # Signal
1 V2
2 V3
3 V4
4 V5
5 Vo6
6 Shield
7 N/A
8 N/A
9 RA
10 LA
11 LL
12 Vi
13 N/A
14 RL
15 N/A

Defibrillator Protection:

In order to protect the circuit from high voltage generated from Defibrillator total of 10
Metal Oxide Varistors (MOV) used at the input of each lead.

Buffers:

Unity gain Operational Amplifier are used for creating high impedance input before input
of the ECG signal to the differential instrumental amplifiers.

Amplifiers:

Stage 1
8 Channels of ECG (lead I, Lead II, V1-V6) are amplified 5 times using Instrument
amplifiers and

Stage 2
Operational Amplifiers are used to amplify ECG signal 16.4 times

Stage 3
Operational Amplifiers are used to amplify ECG signal 2 times
Total amplification stage 1 to stage 3 is 164

R-wave Detection Circuit:
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Hardware electronic circuit is used to detect R-wave pulses in the patient ECG signal.
Output of the R-wave is fed into the microcontroller, which in return provide an optically
isolated TTL Rwave signal output to pin 4 of RJ45 output connector.

NOTICE : Pin 4 is software programmable either of TTL — Rave signal or Analog
ECG signal

Hardware Pacemaker Detection Circuit:

Hardware electronic circuit is used to detect Pacemaker pulses in the patient ECG signal.
Output of the pacemaker circuit is fed into the microcontroller, which in return, provides
a marker in the communication data packets.

Microcontroller:

QRS-Blue™ provides a Microcontroller to digitize the ECG signal and control the inputs
and outputs of the circuit. Microcontroller supports the digital controlling logic for the
circuit. The Microcontroller also supplies the 8 channels of 12 bit analog to digital
conversion used for ECG acquisition. Several digital I/O ports are used as inputs and
outputs for controlling other logic features. Two UARTS are used to communicate with
the USB and Bluetooth connections. The Analog ECG output signal port output requires
the pulse width modulation feature of Microcontroller.

Data Format, Resolution and Sampling Rate:

QRS-Blue™ provides digitized data over USB port or Bluetooth wireless connection
using proprietary digital data format.

QRS-Blue™ data resolution is 12 bit (4.88uV/Bit).

QRS-Blue™ sampling rate can be adjustable between 240 Hz or 500 Hz via software
setup.
Analog ECG Trigger Output:

QRS-Blue™ has an optional signal output (R wave or Analog wave) to provide an
optically isolated one channel Analog ECG trigger signal on pin 4 of RJ45 connector.
The channel I, IT or V1-V6 can be selected via software setup.

NOTICE Pin 4 is software programmable either of TTL — Rave signal or Analog
ECG signal

Signal Isolation:
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All digital signal isolation between patient and the computer is providing by using low
leakage current and high isolation voltage Optocouplers

Power Isolation:

For USB operation of QRS-Blue™ draws power from the computer USB port. Isolation
between USB power and patient is provided by medical grade IEC60601-1 approved DC-
DC power supply.

Data Communication:

QRS-Blue™ data communication to the computer is done either computer USB port or
through wireless Bluetooth connection. When USB interface is used Bluetooth
communication is automatically disabled.

Power:

Bluetooth mode of QRS-Blue™ requires 2 AA batteries for its proper operation. During
USB mode operation power is drawn from the USB port of the compute. A battery fuel
gauge circuit continuously monitors battery voltage and warns the user if the battery is
getting low in voltage.
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System Maintenance & Service:

QRS-Blue™ is made with high quality electronic parts and has no moveable parts which
makes its virtually maintenance free ECG device. Care must be taken for the cables used
(Patient lead wires and USB data cable) with the QRS-Blue™ machine so that wires
should not be damaged and should always be clean.

QRS-Blue™ is a digital ECG machine with auto calibration built in. QRS-Blue™ ECG
does not require any annual calibration of the ECG signals.

Batteries should not be kept inside the QRS-Blue™ device for extended period of time
when the device is not in use. Batteries must be replaced when low battery sign is shown
on the device LED and on the computer software screen.

QRS-Blue™ does not have any serviceable parts. For repairs or technical support call
Pulse Biomedical Inc. for a Return Authorization Number before sending the device for
repair to Pulse Biomedical Inc.

Pulse Biomedical Inc.
Technical Support Department
+1-610-666-5510
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